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Introduction to Forecast Pro 
Forecasters and Collaborators 
Forecast Pro is available in two different types of licenses—Forecaster licenses and Collaborator 
licenses. The type of license you install will dictate the functionality you can access. A Forecaster has 
access to all the functionality described in this manual. A Collaborator can view and manipulate a 
forecast project created by a Forecaster (including viewing graphs and reports, adding overrides and 
comments, saving output, etc.) but cannot generate new statistical forecasts. 

Operationally, the two installations are very similar. However, a Collaborator does not have access to 
any of the functionality relating to reading historical data and generating statistical forecasts. Thus, 
there are sections of this manual which will not be relevant to Collaborators. 

What You Need to Run Forecast Pro 
A computer running a Windows operating system. 

A minimum of 512 MB of RAM (random access memory). Additional memory will greatly enhance 
program performance. We recommend 2 Gigs if you are running a 32-bit operating system and as much 
RAM as your budget can afford if you are running a 64-bit operating system. 

A hard disk drive with 50 MB of free space. 

Future Development of Forecast Pro 
BFS has made many changes to Forecast Pro to accommodate special needs and circumstances in the 
corporate environment. BFS will continue to improve Forecast Pro in the years to come. If you 
encounter problems or have any suggestions for improvements, please contact BFS product 
development (support@forecastpro.com or call 1-617-484-5050). 

Forecast Pro Resources 
Business Forecast Systems, Inc. provides the following resources to help you get the most out of 
Forecast Pro: 

The Forecast Pro Tutorials Manual provides a great way to introduce yourself to the product and its 
capabilities. The tutorials use sample input files and Forecast Pro projects that are installed with 
Forecast Pro. This manual is accessible via the Start page, the File page and the Help Ribbon menu. 

The Quick Start video provides a quick video overview of how to use Forecast Pro. This video is 
accessible via the Start page and the File page. 

mailto:support@forecastpro.com
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The Forecast Pro Reference Manual documents all functionality included in the software. This manual is 
accessible via the Start page, the File page and the Help Ribbon menu. 

The Forecast Pro Statistical Reference Manual describes the statistical techniques, statistics and 
strategies that are implemented in Forecast Pro. This manual is accessible via the Help Ribbon menu. 

The Resources Menu on www.forecastpro.com provides an array of Forecast Pro resources including 
free on-demand forecasting webinars, access to the Forecast Pro blog and a calendar of upcoming 
Forecast Pro events. 

Our Technical Support Team (support@forecastpro.com or call 1-617-484-5050) strives to provide 
timely responses to issues or questions you may encounter while using Forecast Pro.  

BFS provides on-site and web-based training services. Please contact our support team if you are 
interested in training. 

Installing Forecast Pro 
Forecast Pro can be installed as a native 64-bit or native 32-bit application. Most users will want to 
install the 64-bit version to optimize performance. We recommend installing the 32-bit version only if 
you are running a 32-bit operating system. 

Both the 64-bit and 32-bit installation downloads are compressed MSI files that can  
can be extracted using an unzipping application such as PkZip or WinZip. The screenshots below were 
created using Windows File Explorer. 

1. Download the ZIP file by clicking the appropriate link. Choose a location to Save the file by 
choosing the Save As option and/or making a note of the location where it is being saved. 

 

 

mailto:support@forecastpro.com


Installing Forecast Pro | 3 
 

 

2. After the download is complete, go to the folder that contains the downloaded file and extract 
the files from the zip archive by selecting the Extract All option. Please do not run the installation 
program until it has been unzipped. 

 

3. After selecting Extract All, you will be prompted for a password. Enter the password that was 
provided to you via email and click Next. Make a note of the name and location of the folder that 
is created. 

4. Extracting the files will create an unzipped folder. Navigate to the unzipped folder to view the 
extracted files. Please make sure that the folder you are in looks like the one in the screenshot 
below and not look like the one above, and then run the MSI installation program the unzipped 
folder. 
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5. Follow the on-screen instructions of the installation program. When prompted for a Serial 
Number or CD-Key, enter the numbers that were provided to you via email. 

6. You will be prompted to install SQLite drivers during installation. This is a required step to run 
Forecast Pro, so do not skip this step. 

7. If you have any questions or difficulties, please do not hesitate to reach out via email 
to support@forecastpro.com or by phone at +1 617 484 5050 (US) or +44 (0) 20 8132 6333 (UK). 

Running the installation program will create the program directory, data directories, copy the 
appropriate files, create a launch icon on the program menu and place a launch icon on the desktop. It 
will also install SQLite drivers. The driver installation launches a separate installation dialog which 
includes a separate click-through license agreement. 

The installation program will also install files to run the Forecast Pro Excel Add-in. The Forecast Pro Excel 
Add-in is activated the first time you start Forecast Pro. If you are planning to use the Forecast Pro Excel 
Add-in but are not planning on using the interactive version of Forecast Pro, you will still need to start 
the interactive version of Forecast Pro prior to using the Forecast Pro Add-in for the first time. 
Use the Add or Remove Programs utility in the Windows Control Panel to remove Forecast Pro from 
your computer. 

mailto:support@forecastpro.com
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A Quick Overview of Forecasting 
  

What is Statistical Forecasting? 
Everybody forecasts, whether they know it or not. Businesses need to forecast future events to plan 
production, schedule their work force, or prepare even the simplest business plan. 

Most business forecasting is still judgmental and intuitive. Sometimes this is appropriate. People must 
integrate information from a large variety of sources—qualitative and quantitative—and this is probably 
best done by using the extraordinary pattern recognition capabilities of the human brain. Unfortunately, 
many companies also use judgmental forecasting where they should not. 

Not everyone understands the concept of forecasting. It tends to get mixed up with goal setting. If a 
company asks its salespeople to forecast sales for their territories, these “forecasts” often become the 
yardsticks by which they are judged. 

The main advantage of statistical forecasting is that it separates the process of forecasting from that of 
goal setting and makes it systematic and objective. Statistical forecasting can help almost any business 
improve planning and performance. There is, in other words, value added for a business. 

The future is uncertain, and this uncertainty can be represented quantitatively. Statistical forecasting 
represents uncertainty via a probability distribution. A probability distribution associates each possible 
outcome with a likelihood of it occurring. Two kinds of information are needed to describe the 
distribution: the point forecasts, which is essentially the “best guess” estimate, and the confidence limit, 
which captures how much uncertainty there is around the point forecast. The upper and lower 
confidence limits represent reasonable bounds for the forecast. You can be reasonably confident that 
the actual outcome will fall within the confidence limits. 

Forecast Pro depicts this information graphically as well as numerically. In the graph below, the red line 
represents the point forecast, while the blue lines represent the upper and lower confidence limits. 
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The upper confidence limit is often calibrated to the ninety-fifth percentile. This means that the actual 
value should fall at or below the upper confidence limit about 95% of the time. You can set the 
percentiles of both the upper and lower confidence limits. Sometimes, the upper confidence limit will be 
more useful for planning than the point forecast. 

Let's illustrate this idea with an example. Suppose you were in charge of forecasting widget sales for 
your company. If you wanted to determine expected revenues for next month, you would be most 
interested in the point forecast, since it is the mean value of the distribution. The point forecast gives 
you the minimum expected forecast error. 

On the other hand, suppose you wanted to know how many widgets to produce. If you overproduce, 
warehousing costs will be excessive. But if you underproduce, you will probably lose sales. Since the cost 
of lost sales is usually greater than the cost of overstocking, you will be most interested in the upper 
confidence limit. The 95% upper confidence limit tells you how many widgets to produce to limit the 
chance of “stocking out” to less than 5%. 

Forecasting Methodologies 
A wide variety of statistical forecasting techniques are available, ranging from very simple to very 
sophisticated. All of them try to capture the statistical distribution that we have just discussed. 

Forecast Pro offers the forecasting methodologies that have been proven to be the most appropriate for 
business forecasting—simple moving averages, discrete data models (Poisson or negative binomial), 
curve fitting, Croston’s intermittent demand model, exponential smoothing, Box-Jenkins, Bass diffusion 
model, forecasting by analogy, dynamic regression, event models and multiple-level forecasting. The 
latest version of Forecast Pro also includes extreme gradient boosting, a machine learning methodology 
that has recently emerged as a very effective for demand forecasting. 

All these methodologies forecast the future by fitting quantitative models to statistical patterns from 
the past. Therefore, you must have historic records of your variables, preferably for several years. 
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Forecast accuracy depends upon the degree to which statistical data patterns exist and their stability 
over time. The more regular the series, the more accurate the forecasts are. 

Six of the methodologies are univariate techniques. They forecast the future entirely from statistical 
patterns in the past. 

The simple moving average is widely used in business, mostly because it is so easy to implement. 
However, it is only appropriate for very short or very irregular data sets, where statistical features like 
trend and seasonality cannot be meaningfully determined. 

Discrete data models are used for data consisting of small whole numbers. These models are 
characteristically used to model a slow-moving item for which most orders are for only one piece at a 
time. Forecasts are nontrended and nonseasonal. 

Croston’s intermittent demand model is not a widely known or used technique, but it can be extremely 
useful. It is usually used to model data in which a significant number of periods have zero demand but 
the non-zero orders may be substantial. This is characteristic of a slow-moving item which is ordered to 
restock a downstream inventory. Forecasts are nontrended and nonseasonal. 

Exponential smoothing models are widely applicable. They are also widely used because of their 
simplicity, accuracy and ease of use. Their robustness makes them ideal even when the data are short 
and/or volatile. Exponential smoothing models estimate trend and seasonality and extrapolate them 
forward. 

Box-Jenkins is a more elaborate statistical method than exponential smoothing. Box-Jenkins models 
estimate the historic correlations of the data and extrapolate them forward. It often outperforms 
exponential smoothing in cases when the data are fairly long and nonvolatile. However, it may not 
perform well when the data are unstable. 

Machine learning is available as a univariate model and may be included in the expert selection 
algorithm, if desired. Like exponential smoothing and Box-Jenkins, machine learning univariate models 
leverage information inherent in the historic data (seasonality, trend) to create features. Using XGBoost, 
an extreme gradient boosting algorithm, these features are used to create an ensemble of decision trees 
to generate forecasts. Forecast Pro’s automatic machine learning model leverages our AI-driven expert 
selection algorithm to select features and an extreme gradient boosting tree model specification 
appropriate for your data. 

Forecast Pro’s expert selection  automatically chooses the appropriate univariate forecasting technique 
for each item forecasted. By default, expert selection will determine which of the first five univariate 
models is most appropriate for the data, optimize the model and create the forecasts. If desired, you 
may include machine learning in expert selection as well. Alternatively, you can dictate that a specific 
method be used and customize your models. Forecast Pro provides extensive diagnostics and statistical 
tests to help you make informed decisions. 

Forecast Pro includes six additional forecasting techniques that are not considered in expert selection—
event models, custom component models, forecast by analogy, the Bass diffusion model, dynamic 
regression and custom machine learning models.  

Event models are extensions of exponential smoothing models that allow you to capture responses to 
promotions, business interruptions and other aperiodic events. These models allow you to assign each 
period into logical categories and incorporate an adjustment for each category. For example, if you 
establish a category for promoted periods then your model would include an adjustment for promoted 
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periods. If you ran three different types of promotions, you could establish three categories and have a 
different adjustment for each type of promotion. 

Custom component models are also extensions of exponential smoothing models. The method generates 
statistical forecasts for the different components found in an exponential smoothing model (sales level, 
trend, seasonal pattern and events) and then allows you to customize any of the estimated components. 
The model is very useful in circumstances where not all the components can be accurately estimated 
from the demand history. Examples include short data sets where the seasonal pattern cannot be 
reliably estimated and you wish to use a seasonal pattern from a similar product, forecasting the impact 
of future events that have not occurred historically, tempering the trend for longer-term forecasts, etc. 

Forecast by analogy is a new product forecasting technique that allows you to create a forecast that 
“looks like” a different product’s demand pattern or a launch profile that you create. 

The Bass diffusion model is a new product forecasting technique designed to forecast the spread of a 
new product based on the adoption rates of two types of users—innovators who are driven by their 
desire to try new products and imitators who are primarily influenced by the behavior of their peers. 

Dynamic regression produces a forecast based on the forecasted item’s history (like univariate methods) 
and that of the explanatory variables (e.g., product promotion, advertising, demographic variables, or 
macroeconomic indicators). You must provide historic values for the variable to be forecast and the 
explanatory variables.  

Forecast Pro can provide automated selection for the dynamic terms (e.g., lagged dependent variables 
and Cochrane-Orcutt terms), but the user needs to specify which explanatory variables to include in the 
model. Forecast Pro provides several test batteries and diagnostics for variable selection and gives you 
specific advice on how to improve the model. Building a dynamic regression model thus consists of 
deciding which variables to consider, and following the program’s advice, step-by-step, to identify your 
final model. 

Dynamic regression can outperform exponential smoothing and Box-Jenkins in cases where strong 
explanatory variables exist, and you have reasonably accurate forecasts for them. Unfortunately, this is 
not always the case, and in those instances the forecasts may not be as accurate as those from 
univariate methods.  

Custom Machine learning models may also include event schedules and explanatory variables as 
features in a boosted decision tree ensemble model. As with event models and dynamic regression, you 
must provide historic values for events and explanatory variables.  

Like Forecast Pro’s automatic machine learning models, our custom machine learning methodology uses 
XGBoost, an extreme gradient boosting algorithm, to create an ensemble of decision trees. Forecast 
Pro’s machine learning algorithm will automatically select the most relevant features from both the user 
provided ones and the Forecast Pro generated features. You can automatically train custom machine 
learning models using the same AI-driven logic that powers Forecast Pro’s automatic machine learning 
univariate models, or you can specify a specific boosted decision tree structure. 

If you are new to forecasting and these techniques seem a little intimidating, don't worry. We designed 
Forecast Pro to guide you completely through the forecasting process. Just follow the program's advice 
and you will soon be generating accurate forecasts and adding value to your business. 
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Some Forecasting Tips 
Forecast Pro uses your data history to forecast the future, so it is extremely important that your data be 
as accurate and complete as possible. Keep in mind the rule, “garbage in, garbage out!” 

You will also want to give some thought to what data you should forecast. If you want to forecast 
demand for your product, you should probably input and forecast incoming orders rather than 
shipments, which are subject to production delays, warehousing effects, labor scheduling, etc. Many 
corporations are making large investments to obtain data as close to true demand as possible. 

The more data you can supply the program, the better. The program can work with as few as five data 
points, but the forecasts from very short series are simplistic and less accurate. Although collecting 
additional data may require some effort, it is usually worth it. 

If your data are seasonal, it is particularly important that you have adequate data length. The automatic 
model selection algorithms in Forecast Pro will not consider seasonal models unless you have at least 
two years’ worth of data. This is because you need at least two samples for each month or quarter to 
distinguish seasonality from one-time irregular patterns. Ideally, you should use three or more years of 
data to build a seasonal model. 
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Setting Up Your Historic Data 
Forecast Pro requires historic data to be input in a specific format. This chapter explains the data 
formats supported by Forecast Pro, advises you how to select a format and describes how to create the 
files. If you read the material carefully and examine the sample data files that are shipped with Forecast 
Pro, you will be up and running quickly. 

The first two sections describe data requirements and the different data file formats. After you have 
selected your file format, consult the appropriate section for instructions on how to create the files. 

Overview 
Forecast Pro works with historic time series, i.e., sequences of values of a variable at some time interval. 
Business series are usually expressed in terms of the calendar, and can be daily, weekly, monthly or 
quarterly. Forecast Pro can work with any type of time series but is oriented towards weekly, monthly 
and quarterly calendar data. 

Collection and maintenance of reliable historic data is up to you and your IT department and can be 
implemented in many different ways, depending on information flow conditions in your organization. 

Data length 
Forecast Pro works by fitting a statistical model to your historic data and extrapolating it via the fitted 
model. Thus, your data must be long enough to provide reasonably stable estimates of the most 
important features of the data. Very short or very noisy historic records usually yield very simple models 
because the data are too short to support statistical estimates of important features like seasonality. 

If the data are very short, say four points or fewer, Forecast Pro can pick up neither seasonality nor trend 
and reverts to the Simple Moving Average model. 

For more than four points but less than two years’ worth of data, Forecast Pro can fit and forecast trends 
but not seasonality. If your data are in fact nonseasonal, your forecasts are likely to be adequate. If your 
data are in fact seasonal, the forecasts are likely to be poor—Forecast Pro cannot extract or forecast the 
seasonality. 

However, seasonal forecasts from short data sets are feasible using some of Forecast Pro’s customized 
approaches. For example, when the short data sets are nested within aggregate product groups with 
longer histories, top-down forecasting can be used. If there are other longer series which exhibit the 
same seasonal pattern then the pattern can be estimated from the longer data set and applied to the 
short data sets using the INDEXES modifier, a custom component model or the forecast by analogy 
model. Finally, you can map history from one or more items to your short data history item to create a 
longer history to use for forecasting. 

Seasonality can be estimated and forecasted from two to three years of data, but this amount of data is 
marginal, especially when your data are noisy or intermittent. Patterns in the noise may be mistaken for 
seasonality, yielding inappropriate “seasonal” forecasts. 
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Robust capture of seasonality requires three or more years of data. Four to seven years is even better 
since there is more information from which the program can separate seasonality and trend from the 
noise. 

There is little additional payoff in accuracy beyond about seven years of data, and the cost in computer 
time can be substantial. 

Missing values and zeros 
Each of the statistical forecasting methods requires an unbroken stream of historic values. 
Unfortunately, missing values are common in business data. You therefore need a well-formulated 
approach to missing data. There are two parts to the approach. You must first decide how to encode 
missing values in the input data file. Then you must decide how these missing values are to be treated 
by Forecast Pro. This is controlled by several settings on the Formats tab of the Options (see below). 

 
The encoding of missing values depends upon the data format. However, one problem is common to all 
the formats—the distinction between missing values and zeroes. Forecast Pro ordinarily considers 
zeroes to be actual data values and treats them as such. If they were really intended as missing values, 
then the forecasts can be badly biased. 

Forecast Pro treats a sequence of leading zeroes as missing values if you check “Ignore leading zeroes” 
on the Formats tab of the Options dialog box, and it treats trailing zeroes as missing if you check “Ignore 
trailing zeroes”. If you can avoid using this strategy, do so. Its dependence upon these flag settings 
makes it a little risky. 
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When historic data is read into Forecast Pro, the program establishes a global ending date for the 
history which corresponds to the most recent observation available for any item being read in. If a given 
item does not have a historic observation for the global ending date, the item is flagged as “dead.” Dead 
items are not forecasted but their demand history goes into the group totals. This can be an issue if your 
data source code’s zeroes as missing (e.g., blank cells in Excel, no transaction in a table or query, etc.). If 
you check “Set trailing blanks to zero” on the Formats tab of the Options dialog box, Forecast Pro will 
replace missing trailing observations with zeroes. If you can avoid using this strategy, do so. Its 
dependence upon these flag settings makes it a little risky. 

Zeroes in the middle of your data are always treated as numerical values. Therefore, embedded missing 
values must be explicitly coded as missing. Since the way you do this depends upon the data format, it 
will be addressed as we discuss each specific data format. 

Forecast Pro interprets your input data and missing values as the data are read. In order to change 
treatment of missing data, you must reread the data from scratch. The interpretation of zeros and 
missing values depends upon the “Ignore leading zeroes” and “Ignore trailing zeroes” flags and upon the 
“Missing values” setting on the Formats tab of the Options dialog box. There are three possible settings 
for missing values—Truncate, Impute or Zero. 

Truncate directs Forecast Pro to use only the most recent unbroken stream of data. All data up to and 
including the last missing value are discarded. 

Impute directs Forecast Pro to discard leading and trailing missing values but to impute embedded 
missing values via linear interpolation. 

Zero directs Forecast Pro to reset missing values to zeroes and to treat them as numerical values. This 
setting is appropriate when the data file is written from a database in which only the non-zero records 
are stored. In other cases, it might lead to badly biased forecasts. 

Header information 
Once you have collected your time series data, you will need to define the header information. The 
required header information includes the following. 

Variable name. The name by which the program refers to an individual item (often an SKU). An item 
name is limited to 256 of the following characters: 

0-9 A-Z a-z ! # $ % & ? @ _ + - / * . ~ < > 

However, you may also be limited by restrictions imposed by the software to which you export your 
data. SQL databases, for instance, sometimes require that the first character in a name is a letter and do 
not regard upper and lower cases as distinct. 

Variable description. A short description of the variable. Variable descriptions must not exceed 256 
characters in length. Variable descriptions are displayed within Forecast Pro and can be included in 
Numeric Output Files and Formatted Forecast Report Files.  

Starting year. The year and period corresponding to the first available data point. If the first available 
observation for a monthly series was April, 2016 then the starting year would be 2016 and the starting 
period would be 4. The starting year must be 100 or later. For data that are not calendar-oriented, enter 
100 for the starting year and 1 for the starting period. 
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Periods per year. 12 for monthly data, 4 for quarterly data, etc. For data that is not calendar oriented, 
use 1. Note that most weekly corporate calendars involve occasional years of 53 weeks—these 
occurrences will cause the forecast date tags to be off by a week. 

Periods per cycle. The number of periods per seasonal cycle, usually equal to the number of periods per 
year. An exception might be daily data, where periods per cycle could be set to 7 to capture weekly 
patterns and periods per year set to 365. Or, if weekend days are excluded, periods per cycle might be 5 
and periods per year 260. For nonseasonal data, periods per cycle should be 1. This is a critical entry 
because Forecast Pro uses it for seasonal adjustments. 

Selecting a Data Format 
The program accepts three different data formats—Excel (XLS, XLSX & CSV), Text (MLT, CSV) and Open 
Database Connectivity (ODBC). Examples of each file type are shipped with the program. 

Which data format you choose will depend on your application and database operations. Before making 
your choice, you should be aware of the following advantages and disadvantages of each file type. 

Excel (XLS, XLSX & CSV) files 
Excel or CSV (Comma Separated Values) files are frequently used for managing Forecast Pro Data input 
files. You can make and forecast multiple spreadsheet files in one project if you wish. 

PROS. If you are comfortable using a spreadsheet, then the spreadsheet format allows you to create, 
update and manipulate your data in a familiar environment. Processing time for xls files is faster than for 
ODBC. Creating forecast reports from Excel is straightforward. 

CONS. If someone has an xlsx file open in Excel, you cannot read it into Forecast Pro. Processing time for 
xlsx files can be slow (xls is faster and csv is faster still). 

Text (MLT, CSV) files 
Text files can also be used to hold your data inputs. You can make and forecast multiple text files in a 
single project if you wish. 

PROS. Processing time is faster than for ODBC and spreadsheets (excluding CSV which is text-based). 
Most databases can output text files. 

CONS. Editing, viewing and updating large MLT files can be clumsy. Not all editors accept very long files. 

ODBC  
Open database connectivity (ODBC) allows Forecast Pro to read and write data directly to databases for 
which an ODBC driver exists. Most popular databases support ODBC, including Access, Oracle and SQL 
server. 

PROS. ODBC can provide direct access to data stored in the corporate database obviating the need for 
intermediate files. 

CONS. Reading and writing directly to the corporate database can raise security issues. Data transfer can 
be slow for some configurations. Reading data from a view is slower than reading from a table. 
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The next three sections supply the details you need to set up your data in one of the Forecast Pro 
formats. If you have chosen a format, you need read only the pertinent section. 

Excel (XLS, XLSX, CSV) Formats 
Forecast Pro can read Excel (XLS, XLSX) files and CSV (Comma Separated Values) files saved from Excel. 

You must create your spreadsheet file from within your spreadsheet program. Forecast Pro checks data 
types as it reads the spreadsheet. If it sees text where it expects a number, or a floating point number 
where it expects an integer, an error message will be displayed when the data is read in. By default, a 
blank cell is interpreted as a missing value. This default can be adjusted for leading and trailing blanks on 
the Formats tab of the Options dialog box. Do not use zeros to represent missing valuesthey will be 
interpreted as numbers and will probably distort your forecasts badly.  

Entire spreadsheet vs. named range 
You may either devote an entire worksheet to the data (recommended) or specify a portion of a 
worksheet by giving it the range name BFSDATA. 

In a multi-worksheet workbook the data are assumed to reside in the first (topmost) worksheet unless 
an alternate sheet has been specified by naming it BFSDATA.  

The cell references in the examples below assume that the entire worksheet has been devoted to the 
Forecast Pro database. If you opt to specify a named range, cell A1 in the examples will correspond to 
the cell in the uppermost left corner of your named range. 

Row format 
If your data are already stored by rows, you will want to consider the row format first. You can probably 
alter your spreadsheet to the Forecast Pro row layout in just a few minutes. In row format each time 
series occupies a single row on the spreadsheet. 

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate 
sheet has been specified by naming it BFSDATA.  

Row 1 of the spreadsheet is devoted to column headings. The keyword “description” must be used as 
the column heading for the description column. The other cells in row 1 are ignored by Forecast Pro. You 
can use them for titles, calendar information, etc. 

Here is an example of a row format spreadsheet. The file is installed with the program and is named 
Sample Historic Data – Horizontal.xlsx. 

 
The above example does not use attribute fields to define product groupings. This is often desirable and 
is discussed in the Using Attribute Fields to Define a Hierarchy section. 
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In our example, each data record consists of six header items in columns A through F, followed by the 
historic data in the remainder of the row, beginning in column G. Each item is placed in a separate cell. 

Columns A through F contain the following six items required items. 

A Variable name. Up to 256 characters. 

B Variable description. Up to 256 characters. 

C Starting year. Must be an integer. 

D Starting period. Must be an integer. 

E Periods per year. Must be an integer. 

F Periods per seasonal cycle. Must be an integer. 

See the Overview section at the beginning of this chapter for more details on these items. 

The time series data begin in column G. The starting year (column C) and starting period (column D) 
refer to the year and period for column G, whether or not that cell actually contains data. Thus, in the 
example spreadsheet, the first value for PG1-204-2 is for January 2017 in column I, even though the 
column C defines the starting year as 2016, and column D defines the starting period as 11. 

Column format  
If your data are already stored by columns, you will want to consider the column format first. You can 
probably alter your spreadsheet to the Forecast Pro row layout in just a few minutes. In column format 
each time series occupies a single column on the spreadsheet. 

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate 
sheet has been specified by naming it BFSDATA.  

Column A of the spreadsheet is devoted to row headings. The keyword “description” must be used as 
the row heading for the description row. The other cells in column A are ignored by Forecast Pro. You 
can use them for titles, calendar information, etc. 

Here is an example of a column format spreadsheet. The file is installed with the program and is named 
Sample Historic Data – Vertical.xlsx. 

 
The above example does not use attribute fields to define product groupings. This is often desirable and 
is discussed in the Using Attribute Fields to Define a Hierarchy section. 
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In our example, each data record consists of six header items in rows 1 through 6, followed by the 
historic data in remainder of the rows, beginning in row 7. Each item is placed in a separate cell. 

Rows 1 through 6 contain the following six required items. 

1 Variable name. Up to 256 characters. 

2 Variable description. Up to 256 characters. 

3 Starting year. Must be an integer. 

4 Starting period. Must be an integer. 

5 Periods per year. Must be an integer. 

6 Periods per seasonal cycle. Must be an integer. 

See the Overview section at the beginning of this chapter for more details on these items. 

The time series data begin in row 7. The starting year (row 3) and starting period (row 4) refer to the 
year and period for row 7, whether or not that cell actually contains data. In the example spreadsheet, 
the first value for PG1-204-2 is for January 2017 in row 9, even though the header defines the starting 
period as 11 and the starting year as 2016. 

Transaction format 
When demand history is stored in a database, it often consists of individual records for each transaction 
(e.g., each order or shipment) that includes the quantity and the date. If your data are currently 
available in Excel in this format, you will want to consider the transaction format. The advantage is that 
it may require less manipulation than other formats to bring the data into Forecast Pro. The 
disadvantage is that it is harder for a person to view and manipulate the data in Excel. 

The data are assumed to reside in the topmost (first) spreadsheet in the workbook unless an alternate 
sheet has been specified by naming it BFSDATA.  

Row 1 of the spreadsheet is devoted to column headings. The keyword “description” must be used as 
the column heading for the description column. The other cells in row 1 are ignored by Forecast Pro. You 
can use them for titles, calendar information, etc. 

Here is an example of a transaction format spreadsheet. The file is installed with the program and is 
named Sample Historic Data – Transactions.xlsx. 
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The above example does not use attribute fields to define product groupings. This is often desirable and 
is discussed in the Using Attribute Fields to Define a Hierarchy section. 

In our example, each data record consists of six header items in columns A through F, followed by the 
historic data in column G. Each item is placed in a separate cell. 

Columns A through F contain the following six items required items. 

A Variable name. Up to 256 characters. 

B Variable description. Up to 256 characters. 

C Year. Must be an integer. 

D Period. Must be an integer. 

E Periods per year. Must be an integer. 

F Periods per seasonal cycle. Must be an integer. 

See the Overview section at the beginning of this chapter for more details on these items. 

Formatting rules 
Keep the following points in mind when you are creating your spreadsheet. 

If you are not using attribute fields each variable name must be unique.  

If you are using attribute fields to define product groupings within a hierarchy, each variable name 
within a given group must be unique. 

If you use zeroes to pad the data prior to an item's availability, make sure that “Ignore leading zeros” is 
selected on the Formats tab of the Settings Options dialog box. 

Text (MLT) Format 
A multivariate text file contains information for the data series you wish to forecast. 

This file is stored as an editable text file with the extension MLT. You must create this file outside of 
Forecast Pro, making sure that you format it appropriately. 

The MLT file format is straightforward. The file begins with record headings followed by a semicolon. 
The record headings are required for the attribute (e.g. Variable Name) and Description fields and are 
optional for all other records. You can use them for titles, calendar information, etc. if you wish. 

After the record headings comes header information for the first variable, followed by decimal numbers 
representing the historical data and then a semicolon. This is followed by the same format for 
subsequent time series. Two semicolons in a row mark the end of the MLT file. 

Since Forecast Pro recognizes spaces, tabs and returns as equivalent terminators, you have a great deal 
of flexibility in formatting your data. The most common format is to organize series by rows, as in the 
following example. 

Here is an example of an MLT file. The file is installed with the program and is named Sample Historic 
Data - Horizontal.mlt. 
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The above example does not use attribute fields to define product groupings. This is often desirable and 
is discussed in the Using Attribute Fields to Define a Hierarchy section below. 

The header consists of the first six items: 

 Variable name. Up to 256 characters enclosed in quotes. 

 Variable description. Up to 256 characters enclosed in quotes. 

 Starting year. Must be an integer. 

 Starting period. Must be an integer. 

 Periods per year. Must be an integer. 

 Periods per seasonal cycle. Must be an integer. 

See the Overview section at the beginning of this chapter for more details on these items. 

The remaining fields contain historic data. Each time series is terminated with a semicolon and the file is 
terminated with two semicolons. 

Notice that we have elected to use the same starting period and starting year for each time series and 
then used the keyword “MISSING” in lieu of values for data points that are unavailable. Thus, in the 
example, the first value for PG1-204-2 is for January 2017, even though the header defines the starting 
period as 11 and the starting year as 2016. Aligning the data file this way makes it easier for somebody 
to view and modify the file. Alternatively, we could have omitted the “MISSING” keywords and altered 
the starting period and starting year to correspond to each individual time series’ starting date. Forecast 
Pro will have no problem reading a file formatted in this fashion—but you might. 

The one-time-series-per-line format illustrated above is easy to read, however, keep in mind you can use 
any combination of rows and columns. 

Formatting rules 
Keep the following points in mind when you are creating your MLT files. 

The record headers, variable name field and variable description field must always appear in quotes. 

If you are not using attribute fields to define product groupings within a hierarchy, each variable name 
must be unique. If you are using attribute fields, each variable name within a given group must be 
unique. 

If you plan to use commas to separate items, or as place holders for large numbers, you will need to set 
a few options on the format tab of the Settings Options dialog box to ensure that they are interpreted 
correctly. 

Be careful not to use dollar signs, page breaks or other symbols that may confuse Forecast Pro. 

Use the word MISSING instead of a number to indicate a missing value. 

If you use zeroes to pad the data prior to an item's availability, make sure that “Ignore leading zeros” is 
selected on the Formats tab of the Settings Options dialog box. 
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Using ODBC 
ODBC provides direct data communications between Forecast Pro and a wide variety of databases. This 
is accomplished through intermediary ODBC drivers that lie between Forecast Pro and your database. 
You must obtain and install the driver from the database manufacturer or a third party. 

ODBC drivers are available for many database products including Access, Oracle and SQL Server. 

Database structure 
Forecast Pro reads data from structured tables or views defined in the database. Ordinarily, the tables 
created for the Forecast Pro interface are just a subset of the entire database. 

Here is an example of a of a data table formatted for Forecast Pro. The file is installed with the program 
and is named Sample Historic Data – ODBC.mdb. 

 
The above example does not use attribute fields to define product groupings. This is often desirable and 
is discussed in the Using Attribute Fields to Define a Hierarchy section. 

In our example, each data record consists of six header items in columns 1 through 6, followed by the 
corresponding historic data point. It is important to note that each data record must contain the 
aggregated value for the given period. 

The fields are defined as follows. 

ItemId0. This is a text field containing the variable name. It can be up to 256 characters. 

Description. This is a text field containing the variable description. It can be up to 256 characters. 

Hist_Year. This is a number field with field size double containing the year. 

Hist_Period. This is a number field with field size double containing the period. 

Ppy. This is a number field with field size double containing the periods per year. 

Ppc. This is a number field with field size double containing the periods per cycle. 

Hist_Value. This is a number field with field size double containing the aggregated historic data value for 
the record’s “date” as defined by the Hist_Year and Hist_Period. 

See the Overview section at the beginning of this chapter for more details on these items. 
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The Forecast Pro project needs to connect to an ODBC database before you can access the tables and 
queries therein. The first time you select Add ODBC in the Data Manager for a given project you will be 
prompted to establish the file data source (select an ODBC driver) and then to select a database. 

Once the project is connected to the database, the tables and queries are displayed, including those that 
have nothing to do with Forecast Pro. A table from the database is treated just like a file when you are 
using the Data Manager. Thus, you should arrange data into the tables or views that make logical sense 
as entries in the Data Manager. 

Formatting rules 
ODBC drivers vary a great deal. If you experience any difficulties connecting to the database, the first 
thing to check is that you are using the latest ODBC driver available for your database. 

With the exception of the last one (which only pertains to Oracle) all of the notes below have been 
verified using Microsoft Access. There is a chance that your ODBC driver might be more (or less) 
restrictive. 

Missing values are indicated by whatever rules are used by the native database. Every database 
recognizes the distinction between zeroes and missing values. If you want, you can encode leading and 
trailing missing values as zeroes. In that case you must make sure that “Ignore leading zeros” and/or 
“Ignore trailing zeroes” is selected on the Format tab of the Settings Options dialog box. 

Table names and variable names should begin with a letter and should not include blank spaces.  

If you are not using attribute fields each variable name must be unique.  

If you are using attribute fields to define product groupings within a hierarchy, each variable name 
within a given group must be unique. 

Oracle Users: Some Oracle drivers will only work if the Hist_Value field is defined as FLOAT (not 
NUMBER). All other numeric fields can be NUMBER with the decimal places set to zero. 

Using Attribute Fields to Define a Hierarchy 
If you do not include any attribute fields, when you read the data into Forecast Pro, it will create a one-
level hierarchy (i.e., there will be no group totals).  

If your data file, table or query includes attribute fields prior to the Variable Name field, Forecast Pro will 
automatically build a multiple-level hierarchy. The first level of the hierarchy will correspond to the first 
attribute field, the second level of the forecasting hierarchy will correspond to the second attribute field, 
etc.  

Let’s illustrate this with an example. The spreadsheet 123 Bakery – Historic Data.xlsx is a sample data 
file shipped with Forecast Pro. It is shown below. 
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In our example, our first attribute field is Total. Notice that the value for the field Total is “Total” for all 
items. Since all items have the same value for the first attribute field, when we read this spreadsheet 
into Forecast Pro the first level of our forecasting hierarchy will provide a grand total for all items in our 
spreadsheet. Notice that the next attribute field is Category, which contains both Cakes and Muffins. 
Thus, when we read this spreadsheet into Forecast Pro the second level of our forecasting hierarchy will 
breakdown total sales into Cakes and Muffins. The next attribute field is Customer. Thus, the third level 
of our forecasting hierarchy will breakdown the Cakes and Muffins into Customers. The next field is the 
Variable Name (labeled “SKU”) so the final level of our hierarchy will breakdown the Category-by-
Customer into SKUs.  

By default, the Automatically sort option on the Formats tab of the Options dialog box is selected, and 
Forecast Pro sorts the data alphabetically prior to reading it in. If Automatically sort is not selected, the 
order of appearance on the spreadsheet dictates the structure of the hierarchy and you’ll want to take 
care when constructing your spreadsheet. 

ODBC attribute fields 
The file 123 Bakery – ODBC.mdb is a sample data file shipped with Forecast Pro. It is shown below. 

 
If you are using ODBC the first attribute field must be named ItemId0, the second attribute field must be 
named ItemId1, etc. All attribute fields must be text fields. Other than that, the operation is identical to 
the spreadsheet format described above.
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Setting Up Your Optional Data 

 
In addition to the historic data (which is required) Forecast Pro’s Data Manager allows you to import 
other information to assist you in creating and working with the forecasts. Specifically, you can import: 

Conversions. Conversion factors allow you to display the history and forecasts in alternative units of 
measure (e.g., dollars, kilos, etc.). 

External Data. Forecast Pro allows you to import external data rows (such as alternative forecasts, open 
orders, etc.) into the forecast override grid. 

Explanatory Variables. Explanatory variables files contain variables that you wish to use in conjunction 
with dynamic regression models. 

Filters. Filter fields can be included in report views and filtered like any other fields. They can also be 
included in the numeric output file. Filters are also used to select items exported to Excel Collaboration 
worksheets. 

Definitions. Definition files contain values to use in conjunction with custom forecast allocations and 
item-level integer rounding quantities. 

Overrides. In addition to entering forecast overrides interactively using the Forecast Overrides view, 
Forecast Pro allows you to import them. 

Helpers. Helper variables are used in conjunction with event models, forecast by analogy models and 
weighting transformations. 

Modifiers. In addition to specifying forecast modifiers interactively on the Navigator, Forecast Pro allows 
you to import them. 
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Mapped History. Mapped History files are used to create Forecast Histories. Mapped History files are 
useful for item supersession and new/replacement products. 

The remainder of this chapter will detail each of these data types.  

Conversion Factors 
The unit of measure used in the historic data file is the default unit of measure. Forecast Pro allows you 
to define conversion factors (i.e., multipliers) which can be used to display the history and forecasts in 
alternative units (e.g., dollars, kilos, etc.).  

Forecast Pro allows for point conversions, where the same conversion factor is used across all time 
periods, or time series conversions, where the conversion factors may vary across time. Point 
conversions and time series conversions have different file layouts, as described below. You may not 
combine point and time series conversions in the same input file, but you may use both point and time 
series conversions in the same Forecast Pro project by reading in multiple files.  

If you use the same conversion unit (e.g. Dollars) in both the point conversions and time series 
conversions files, the point conversion will be read in first, providing a conversion factor for all historical 
and forecast periods. The time series conversions will be then be read in, replacing the point conversion 
values for any items and periods where a time series conversion value is provided.  

By default, a conversion unit must include a value for every end item and time period, but these values 
may be provided in either a point conversion or a time series conversion file. If Forecast Pro is missing 
values after reading in all conversion input files, you will receive an error message and the conversion 
factor will not be read into the project. If you want to allow conversion factors with a value of zero or 
missing conversion factors, you may do so by activating the Allow zero valued conversion factors option 
on the Formats tab of the Options dialog box. 

If the Allow zero valued conversion factors option is selected, Forecast Pro will allow missing or zero 
values in the conversions file(s) specified in the Data Manager. Forecast Pro will give warnings about the 
missing data and changing project units using the Units drop-down on the Operations tab will not be 
enabled. However, the converted rows may be added to the Overrides Report and Graph views. If a 
conversion factor is not provided for a given item in a given period, the converted value will be blank in 
the override report and on the graph, and the item will not be included in the totals for those 
conversion factors.  

Point conversion format 
Examine the file 123 Bakery - Conversions.xlsx.  
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Notice that the attribute fields are present. In our example, columns E through G contain the 
conversion factors. 

You can also read in point conversions using a table or query. Shown below is the Conversions table in 
the file 123 Bakery - ODBC.mdb. 

 
Notice that the attribute fields are present (ItemId0-ItemId3). Description is a text field containing the 
conversion factor’s name, and NumValue is a number field for the conversion factor value. 

Time series conversion format 
You may read in time series conversion using a row format or a transactional format.  

The file 123 Bakery – Conversions – Time series.xlsx shows the row format. 

 
Note that the attribute fields are present. Following the attributes columns is a required column, Units. 
The Units field is used to specify the name of the conversion unit factor you are defining in the row. In 
the example above, the units conversion factor is named “Dollars”. Following the required Units field is a 
column for each period for which you are reading in a conversion factor value. In the example above, 
the Dollars conversion factor value for Total>Cakes>Food-King>BU-20-02 in July 2019 is $11.62.  

Note that the 123 Bakery – Conversions – Time series.xlsx does not provide values for all historic periods. 
To view Dollars in the override grid and graph, you would need to activate the Allow zero valued 
conversion factors option on the Formats tab of the Options dialog box. To view the whole project in 
Dollars, you would need to also read in the point conversions file to provide values for the time periods 
not included in the time series file. 

You can also read in time series conversions using a transactional format. This transactional format may 
be used in Excel or as a table in a database. Below is the Time_Series_Conversions table from 123 
Bakery - ODBC.db. 
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Notice that the attribute fields (ItemId0-ItemId3) are in the first four columns. Following the attributes 
field are four additional required columns: Units, FPYear, FPPeriod and FPValue. The Units column 
contains the name of the conversion factor. FPYear, FPPeriod and FPValue are number fields identifying 
the year, period and conversion value, respectively.  

The Excel transactional format is the same as the database table format, except the attribute names 
defined in the historic data file should be used in the attribute columns, as shown below in 123 Bakery - 
Conversions - Time Series - Transactions.xlsx. 

 

External Data Files 
At times it is useful to have visibility to external information while working with the forecasts. Forecast 
Pro allows you to import external data rows (such as alternative forecasts, open orders, etc.) into the 
forecast override grid. The external data can be imported from Excel spreadsheets (both row and 
transaction-style) and from databases using ODBC. 

Importing external data rows requires that you set up the data in a specific format. The sample file 
shown below is installed into the Forecast Pro input directory and is named 123 Bakery - External Data - 
SKU-Level Forecast.xlsx. 
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The first columns (A through D in our example) define the attributes and name of the item (i.e., the 
hierarchy information). The next column (E in our example) is labeled Description and contains the name 
of the external row. The remaining columns are labeled with dates and contain the data values. 

If you plan to import your external data using a transaction style spreadsheet, examine the sample file 
123 Bakery – External Data – SKU-Level Forecasts – Transactions.xlsx located in the Forecast Pro input 
directory. Note that the file layout is the same as the ODBC file layout shown below. 

If you plan to import your external data using ODBC, examine the Alternate_Forecasts table in the 
sample Access database file 123-Bakery-ODBC.mdb located in the Forecast Pro input directory. 

 
The format is very similar to the format for the historic demand. Notice that the attribute fields are 
present. Hist_Year, Hist_Period and Hist_Value are number fields identifying the year, period and values 
respectively. 

Formatting rules 
In a spreadsheet, a header row is required. The Description and date fields must also be present and 
labeled accordingly. The dates in the header row need to be either in an Excel format or in a Year-Period 
format, e.g. 2019-July, or 2019-52.  

The external data rows are imported at one level of the hierarchy only.  

If an item has no entries for a given external data row, it does not need to be included in the 
spreadsheet, table or query.  
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Explanatory Variables 
Explanatory variable files are used to import explanatory variables (i.e., independent variables) that you 
wish to include in a dynamic regression model. 

Forecast Pro allows you to specify two types of explanatory variables—global and item-specific. A global 
explanatory variable consists of a single time series (set of values) which can be included in a dynamic 
regression model for any item on the Navigator. An item-specific explanatory variable consists of a set of 
time series each of which is associated to a specific item on the Navigator. 

To illustrate the difference, consider a variable like holidays which will likely be the same for all items 
within a hierarchy and therefore should be defined as a global variable. Contrast holidays with a variable 
like price, which will likely take on different values for different items and therefore should be defined as 
an item-specific variable. In this context “items” is being used to include both end items and aggregate 
levels in the hierarchy. 

Explanatory variables must include values for the historic period. Ideally, you would also include forecast 
values for your explanatory variable, but you are not required to do so. If an explanatory variable does 
not have values provided for the complete forecast period, you can use the “automatically extend” 
option to instruct Forecast Pro to forecast explanatory variables (using expert selection) where 
necessary. 

Global Explanatory Variables 
Setting up global variables is straightforward. The first column is labeled Variable and contains the name 
of the explanatory variable. The remaining columns are labeled with dates and contain the date values. 
These date values should match what is used in Forecast Pro (e.g. the dates shown in the Numeric 
Output view).  

The sample file shown below, “Electricity - Explanatory Variables.xlsx”, is provided with the software.  

 

Item-specific Explanatory Variables 
The item-specific explanatory variable setup is the same as the Global variable setup, except the file 
includes the attribute fields used in the historic data setup. The first few columns (columns A-D in the 
example below) list the attributes, the next column (column E below) is labeled Variable and contains 
the name of the explanatory variable and the remaining columns are labeled with dates and contain the 
date values (consistent with Forecast Pro, as described above).  

The sample file shown below, “Cereal- Item Level Explanatory Variables.xlsx”, is provided with the 
software.  
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The examples shown above use a row format spreadsheet. Explanatory variables may also be imported 
using all other formats supported for input files (e.g., transaction spreadsheet, ODBC, etc.). ODBC 
requires the same layout as a transaction spreadsheet. An example of item-specific transaction 
explanatory variables, “Cereal- Item Level Explanatory Variables - Transactions.xlsx”, is provided with the 
software and shown below. 

 
Notice that the attribute fields are in the first four columns. The attribute columns are followed by a 
column for the explanatory variable name. This column must be labeled Variable. The last 3 columns, 
Hist_Year, Hist_Period and Hist_Value, are number fields identifying the year, period and values 
respectively. 

Custom Filter Fields 
You can define custom filter fields which can be included in the report views and filtered like any other 
fields. They can also be included in the numeric output file. 

Examine the file 123 Bakery - Filters.xlsx.  
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Notice that the attribute fields are present (columns A, B, C and D). In our example, columns E and F 
contain the filter fields. 

If you will be using a table or query to hold the filter fields, you’ll want to examine the Filters table in the 
file 123 Bakery - ODBC.mdb. 

 
Notice that the attribute fields are present. Description is a text field containing the filter name. 
TextValue is a text field containing the filter’s value. 

Alternatively, you may include fields with your filter name(s) following the attribute fields, similar to the 
Excel format.  In this case, you should not include the Description and TextValue fields. 

Formatting rules 
In a spreadsheet, a header row that includes the names of the filter fields is required. 

The filters can be assigned at any level. 

If an item has no associated filters, it does not need to be included in the spreadsheet, table or query.  

Definitions: Custom Allocations 
A custom allocation approach allows you to dictate how a group-level forecast is allocated to its 
component series. This is appropriate when the breakdown between the two levels is known. 

To use a custom allocation, you must define the allocation proportions in a file, table or query and read 
them into Forecast Pro using the Definitions row in the Data Manager.  

Examine the file Running Shoes – Custom Allocation.xlsx.  



Item-specific Explanatory Variables | 30 
 

 

 
Notice that the attribute fields are present. In our example, column G contains the allocation 
proportions. 

If you will be using a table or query to hold the allocation proportions, you’ll want to examine the 
CustomAllocation table in the file Running Shoes.mdb. 

 
Notice that the attribute fields are present. Description is a text field containing the keyword CALL to 
identify the entry as an allocation proportion. NumValue is a number field with field size double 
containing the allocation proportion. 

Formatting rules 
In a spreadsheet, a header row that uses the keyword CALL to identify the allocation proportions column 
is required. 

The allocation proportions can be assigned at any level.  

The allocations do not need to sum to 100 (i.e., they do not need to be percentages), they are simply 
relative proportions. For example, if a group had two component series, A and B, and you assigned A a 
weight of 2 and B a weight of 1, then series A would get a two thirds allocation and series B would get 
one third. 

Definitions: Integer Rounding Quantities 
Forecast Pro allows you to display integer forecast rows for the statistical and/or final forecasts on the 
override grid, graph, and other reports. These rows allow you to define an integer quantity to round to 
(e.g., 1, 50, 1000, etc.) and then round the forecasts using an algorithm that keeps track of the 
“remainder” (rounded amount) and applies it to the next period’s forecast value. This is particularly 



Item-specific Explanatory Variables | 31 
 

 

useful for low-volume forecasts or when there are large minimum order quantities, where traditional 
rounding can result in biased forecasts.  

When using integer forecasts, the user defines the default rounding quantity in the Advanced Controls 
tab of the Options dialog box. If you wish to assign item-specific rounding quantities you can do so by 
defining them in a file, table or query and reading them into Forecast Pro using the Definitions row in 
the Data Manager. 

Examine the file 123 Bakery – Definitions – Integer Rounding Quantities.xlsx.  

 
Notice that the attribute fields are present. In our example, column E contains the rounding quantities. 

If you will be using a table or query to hold the rounding quantities, you’ll want to examine the IRQ table 
in the file 123 Bakery - ODBC.mdb  

 
Notice that the attribute fields are present. Description is a text field containing the keyword IRQ 
(Integer Rounding Quantity) to identify the entry as a rounding quantity. NumValue is a number field 
with field size double containing the rounding quantity. 

Formatting rules 
In a spreadsheet, a header row that uses the keyword IRQ to identify the rounding quantity column is 
required. 

The rounding quantities can only be assigned at the end-item level.  

If you wish to use the default rounding quantity defined in Forecast Pro for a given item, it does not 
need to be included in the spreadsheet, table or query. 
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Override Files 
In addition to entering forecast overrides interactively using the Forecast Overrides view, Forecast Pro 
allows you to import overrides from other Forecast Pro projects, from Excel spreadsheets (both row and 
transaction-style) and from databases using ODBC. 

The sample file shown below is installed into the Forecast Pro input directory and is named 123 Bakery – 
Overrides - Rows.xlsx  

 
The first columns (A through D in our example) define the attributes and name of the item (i.e., the 
hierarchy information). The next column defines the override row to which the changes should be 
applied, followed by a column for comments (which, naturally, populates the comment field). Finally, 
the overrides themselves appear from left to right, starting with the first forecast period. If a specific cell 
is blank, no override will be imported for that period. Please note that you may use formula overrides as 
well as number overrides. Formulas must begin with an equal sign (if using Excel, use an apostrophe 
before the equals sign to prevent Excel from executing the formula).  

If you plan to import your overrides using a transaction style spreadsheet, examine the sample file 123 
Bakery – Overrides - Transactions.xlsx located in the Forecast Pro input directory. 

If you plan to import your overrides using ODBC, examine the Overrides table in the sample Access 
database file 123-Bakery-ODBC.mdb located in the Forecast Pro input directory. 

 
Notice that the attribute fields are present.  

FC_Period and FC_Year are number fields identifying the forecast date for the override.  

Override_Row can either be a number field identifying the row number or a text field identifying the row 
name.  

Override_Formula is a text field containing either a numeric value for the override or a formula 
(formulas must begin with an = sign). 
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Override_Created is a date/time field identifying when the override was created. If the entry is blank the 
override report will list the date/time that the override was loaded into the project. 

Override_Comment is a text field containing the comment you wish to associate with the override. If the 
entry is blank, no comment will be associated with the override. 

Formatting rules 
In a spreadsheet, a header row is required. The Row and Comment fields must be present and labeled 
accordingly.  

In a spreadsheet, the dates in the header row need to be either in an Excel format, or in a Year-Period 
format, e.g. 2019-July, or 2019-52.  

Overrides can be assigned at any level.  

The override row can be specified by either the row number or the row name.  

Overrides can be entered as values or formulas.  

If an item has no overrides, it does not need to be included in the spreadsheet, table or query.  

Helper Files 
Helper variables are used in conjunction with event modeling, forecast by analogy and the weighting 
transformation. In addition to creating helper variables interactively for event models and forecasting by 
analogy, Forecast Pro allows you to import helper variables from other Forecast Pro projects and from 
Excel spreadsheets. 

You can create event schedules interactively using the Event Manager. However, if you wish, you can 
create helper variables containing the event schedules in Excel or in a database and import them into 
your project using the Data Manager. You may also import helper variables from other Forecast Pro 
projects using the Data Manager. 

Forecast by analogy requires a helper variable containing the analogy series. Using a weighting 
transformation requires a helper variable containing the weights. Depending on your needs, you can 
either create these helper variables using the Create Helper Variable dialog box (accessed via the Create 
Helper icon on the Forecasting tab) or you can create them in Excel or in a database and import them 
into your project using the Data Manager. You may also import helper variables from other Forecast Pro 
projects using the Data Manager. 

 

Helper variables are created in an identical fashion to your input data. Please note the following: 

1. Attribute fields are not used since helper variables are associated with items on the 
Navigator using modifiers. 

2. Description, Starting Year, Starting Period, Periods per Year and Periods per Seasonal Cycle 
are all required fields. 

a. The Description field defines the name of the helper variable.  

b. The fields Starting year, Starting period, Periods per Year and Periods per Cycle 
should all match the historic data. 
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Several sample helper files are shipped with Forecast Pro including, “Beer - Helpers.xls.” and the table 
“Helpers” in the sample Access database file Beer.mdb. 

Modifier Files 
In addition to entering forecast modifiers interactively on the Forecasting tab,, Forecast Pro allows you 
to import modifiers from other Forecast Pro projects and from Excel spreadsheets. 

Importing modifiers from Excel requires that you set up the spreadsheet in a specific format. The sample 
file shown below is installed into the Forecast Pro input directory and is named 123 Bakery - 
Modifiers.xlsx. 

 
The first columns (A through D in our example) define the attributes and name of the item (i.e., the 
hierarchy information). The next column defines the modifier(s) to import. 

If you will be using a table or query to hold the modifier fields, you’ll want to examine the Modifiers 
table in the file 123 Bakery - ODBC.mdb. 

 
Notice that the attribute fields are present. Modifier is a text field containing the modifier(s) you wish to 
apply. 

Formatting rules 
In a spreadsheet, a header row is required. The Modifier field must be present and labeled accordingly.  

The modifiers can be assigned at any level.  

Multiple modifiers can be assigned in a single cell or data field. 

If an item has no modifiers, it does not need to be included in the spreadsheet, table or query. 
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Mapping Files 

Product Mapping Files 
In addition to interactive product mapping, Forecast Pro supports file-based product mapping, allowing 
you to map the history from one item in your historic data (the Map from item) to another (the Map to 
item).  

When you map the history from one item to another, the history used to generate the Map to item’s 
forecast (the forecast history) is the actual history for the Map to item plus the actual history for the 
Map from item. In other words, the Map to item’s history is incremented by the Map from item’s history 
to generate a forecast history for the Map to item. Please see Working with Product Mapping and 
Mapped History for more details. 

Product Mapping Tutorial- Product Mapping.xlsx, shown below, is installed in the Forecast Pro input 
directory. 

 
In the example above, a 4-level hierarchy is used. The first columns (A through D in our example) define 
the attributes and name of the Map to item. The next columns (E through H in our example) show the 
attributes for the Map from item. For group levels, all attributes still need to be included in the row with 
“NULL” filled in for lower attribute levels (see the second example below). Assigning forecast histories at 
a group level requires being in All Levels Product mapping mode. 

Formatting rules 
The attributes for the Map to and Map from items are the only required columns in a product mapping 
file. The following optional columns may be included in the file as well: 

 
Begin 

 
Indicates the first Map from historic period to map. If 
missing, the first period with history for the Map from item 
is used. Use date formats as shown in the Override grid. 

End Indicates the last Map from historic period to map. If 
missing, the last period with history for the Map from item 
is used. Use date formats as shown in the Override grid. 
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Allocation Indicates the proportion of the Map from volume to map. 
The allocation should be greater than 0. If missing, it is 
assumed to be 1. 

Set_FH_to_zero  Indicates if a \SET_FH_TO_ZERO modifier should be applied 
to the Map from item. Applying this modifier effectively 
removes the item from group level Forecast Histories and 
sets the forecast (if any) to zero. 

Topdown Indicates if a \TOPDOWN modifier should be applied to the 
Map to item. This is only applicable when using the “All 
levels” product mapping mode. 

Below is an example of a group-level product mapping file which includes all optional columns. Note 
that the optional columns must be after the Map to and Map from attribute columns but may be 
included in any order. 

 

 

Mapped History Files 
At times, you may find that the item that you want to Map from is not in your historic data. If so, you 
may use a mapped history file to import values that you want to map to an item in your historic data. 
The forecast history for the Map to item will be the mapped values assigned to that item in the mapped 
history file plus the item’s history in the historic data file. 

The mapped history file is very similar to the external data file structure. The sample file shown below is 
installed into the Forecast Pro input directory and is named Product Mapping Tutorial Part 2- Mapped 
History.xlsx. 

 
The first columns (A through D in our example) define the attributes and name of the Map to  item (i.e., 
the hierarchy information). The next column (E in our example) is labeled Description and should read 
“Mapped History” for all rows in the file. The remaining columns are labeled with dates and contain the 
data values. 
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If you plan to import your mapped history using a transaction style spreadsheet, examine the sample file 
Product Mapping Tutorial Part 2- Mapped History – Transactions.xlsx located in the Forecast Pro input 
directory. You may also read in data through ODBC using the same transaction style layout shown 
below. 

 
The format is very similar to the format for historic demand. Notice that the attribute fields are present. 
Description must be present and read “Mapped History”. Hist_Year, Hist_Period and Hist_Value are 
number fields identifying the year, period and values, respectively. 

Formatting rules 
In a spreadsheet, a header row is required. The Description and date fields must also be present and 
labeled accordingly. The dates in the header row need to be either in an Excel format or in a Year-Period 
format (for example, 2019-July or 2019-52).  

A mapped history file may contain mapped history for end-items or group levels, if you are working in 
the All levels Product mapping mode. For group levels, all attributes still need to be included in the 
header row with “NULL” filled in for lower group and item levels.  
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The Forecast Pro Interface  
This chapter presents an operations overview and a description of the user interface. Details for the 
functionality of the views and dialog boxes available from the Ribbon menu are provided in subsequent 
chapters. 

Operations Overview 
Generating forecasts in Forecast Pro consists of executing the following steps: 

1. Prepare the input data. This is performed outside of the program and entails selecting the type 
of data format to use and preparing the files. Creating your data files is discussed in the Setting 
Up Your Historic Data and Setting Up Your Optional Data chapters. 

2. Specify the default options. This is accomplished using the Options dialog box, which may be 
opened with the Options icon on the Home tab. Options set by the user will apply to the current 
project file and can also be saved to the ForecastProTRAC.ini file and used as defaults for all 
future forecast documents using the Set as Default button. Thus, you need only set the options 
when you use Forecast Pro for the first time, or when you wish to change the current settings. 
An overview of all option tabs and settings is in Forecast Pro Options. 

3. Define the historic data and other inputs. This is accomplished by specifying the appropriate 
entries in the Data Manager. Consult Using the Data Manager for details. 

4. Read in the data and prepare the forecasts. This is accomplished by clicking the Read & Forecast 
button in the Data Manager. By default, Forecast Pro will automatically create forecasts using its 
Artificial Intelligence (AI) driven expert selection algorithm and reconcile the forecasts using a 
bottom-up approach. 

5. Save the results. This can vary depending upon your needs, but usually entails saving a numeric 
output file containing the forecasts and saving the project file so that you can update it the next 
forecast period rather than creating a new one from scratch. Consult Saving Your Work for 
details. 

In addition to the above required steps, there are many optional operations that you can perform. 
Including: 

1. View the forecasts and other information graphically 

2. View on screen reports. 

3. View forecasts and other information numerically in the override grid and enter any desired 
changes and comments. 

4. Customize how the forecasts are generated by specifying the forecasting models and 
reconciliation techniques to use. 
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Forecast Pro Interface Overview 

The Startup Page 
When you open Forecast Pro, the program will display a startup page like the one below. 

 
The startup page allows you to open an existing project, start a new project, view a Getting Started 
video, open the Tutorials manual or open the Program Reference manual. 

Once you start a new project or open an existing project, the main Forecast Pro interface appears. 
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(A) Quick Access Toolbar, (B) Ribbon Menu, (C) Navigator, (D) Hotlist, (E) View Window,  
(F) Status Bar 
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The Forecast Pro interface consists of a Quick Access Toolbar (A), a ribbon menu (B), a Navigator (C, 
currently unavailable), a Hot List area (D), a view window (E) and a status bar (F). 

Quick Access Toolbar 
Located in the upper left-hand corner of the display, the Quick Access Toolbar contains frequently used 
icons. The Quick Access Toolbar initially contains the Save and Auto Arrange icons as well as a Layout 
selection drop-down and a Customize drop-down. The Customize drop-down allows you to specify the 
icons you wish to display in the Quick Access Toolbar. 

Ribbon Menu 
The ribbon menu provides access to almost all Forecast Pro functionality. The functionality is organized 
into seven ribbon tabs: File, Home, Forecasting, Reports, Import, Export, Operations and Help. Clicking 
on one of these tabs will display the ribbon for the selected tab. Each ribbon is a collection of icons and 
drop-downs, often organized into groups. The most commonly used procedures are available on the 
Home tab (selected above). The seven tabs are described in Forecast Pro Ribbon Tabs chapter. 

The Navigator  
The Navigator is the primary way to select an item to view in the Forecast Report, Graph, Override, 
Forecast Value Add and Tracking Report windows. It is also how you select the item you want to 
customize using the Forecasting tab. After the data have been read, the Navigator displays the available 
time series in a tree structure. The tree structure is defined by the hierarchy in your historic data files. 
Selecting an item on the Navigator will automatically display all relevant information in the open views. 

The Navigator also features color-coded icons to allow you to spot items that contain overrides and/or 
comments. A red icon indicates that the item contains an override and/or comment. A green icon 



The Hot List | 41 
 

 

indicates that the item does not contain an override or comment. A yellow icon on a group indicates 
that at least one item further down that branch of the tree contains an override and/or comment. A 
light blue icon (applicable only if either Manual forecast or Manual override mode is selected on the 
Performance tab of the Options dialog box) indicates that an item’s forecast needs to be updated with 
the Recalculate icon on the Home tab. A dark blue icon (applicable only if Manual override or Manual 
override mode is selected on the Performance tab of the Options dialog box) indicates that an item’s 
override calculations need to be updated with the Recalculate icon on the Home tab.  

If you are using mapped history, your forecast history may be different than your actual history. See 
Working with Product Mapping and Mapped History for details. If mapped history exists for an item, the 
icon shape will be a plus (e.g.: ) instead of a square. The same color conventions discussed above still 
apply.  

The Navigator context menu provides extensive functionality for working with your data and the Hot 
List. Please see The Navigator Context Menu for details. 

The Hot List 
Placing items on the Hot List allows you to efficiently navigate, work with and report on a subset of the 
items listed on the Navigator. Items can be added to the current Hot List by dragging from the Navigator 
or by using the Add to Hot List option on the Navigator’s context menu. A Hot List can also be defined 
based on the items currently displayed in a report. You may use filters in a report to get the desired 
subset of items, then use the report’s context menu or hamburger menu to add all the items currently 
displayed in the report to the Hot list.  

When you select an item on the Hot List, Forecast Pro will immediately select the item on the Navigator 
and update the affected views.  

Right click in the Hot List area to open the Hot List’s context menu. The Hot List’s context menu allows 
you to sort the Hot List alphabetically, change how items are displayed and remove items from the 
current Hot List. The Open Hot List option allows you to open a Hot List which had been saved to Excel 
or import a Hot List from another project. The Save Hot List option allows you to export the current Hot 
List to Excel. The ability to import and export Hot Lists to Excel allows you to create multiple Hot Lists for 
a project and switch amongst them. 

Please consult the Advanced Navigation lesson in Forecast Pro TRAC Tutorials for more details. 

View Window 
Forecast Pro allows you to open multiple views in the View Window. These views may be resized, 
maximized or minimized and arranged as you wish using standard Windows functionality. Left click on 
the border of an open window and drag the mouse to resize and left click on a window’s title bar and 
drag the mouse to move the window.  

You may also tile the open views using Auto Arrange icon on the Home tab and Quick Access Toolbar. 
This can be helpful when you open a new view. The drop-down on the Auto-Arrange icon allows you to 
tile windows vertically instead.  

Each Forecast Pro view has a hamburger menu on the upper left-hand corner. This menu can be used to 
access key functionality, such as opening the settings dialog for the view or adding filters to the report.  

When you add filters to a report, Forecast Pro includes a filter drop-down on each column. If you click 
on the filter drop-down, you will bring up a dialog box that allows you to sort and filter values. 
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From this dialog box you may sort the report by the values (or absolute values) in the column, filter the 
report based on specific rules using the Numeric drop-down or apply a heat map using the Color drop-
down. 

On the drop-down currently selected Numeric, you may select Numeric, Top 10, Above Average or 
Below Average. The Above Average and Below Average selections are self-explanatory. Selecting 
Numeric brings up a dialog box that allows you to enter logic for how the report should be filtered. 

 
Selecting Top 10 brings up a dialog box that allows you to show the top or bottom items, based on 
number of items, percent or volume. While the default is to show the top 10 items, you can change the 
10 to whatever value you wish to see. 
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Finally, you may add heat maps to numeric columns by selecting from the Color drop-down. The heat 
map colors a cell based on where the cell value falls in the range of values for the column. The default 
selection, None, is to not use a heat map. The drop-down provides different color schemes to select 
from. If you choose a color scheme, a heat map with the selected color scheme will be applied to the 
column specified. 

Each Forecast Pro view also has a context menu. Right click anywhere on an open view to bring up the 
context menu. The context menu has the same selections as the hamburger menu which is accessible in 
the top left corner of each view. 

There are twenty view windows available in Forecast Pro. The following are context specific: 

Forecast Reports 

The Graph Views 

The Override Forecasts View 

The Diagnostics View 

The Tracking Report and Tracking Report Graph Views 

The Forecast Value Add (FVA) View 

Context specific views display information for the current Navigator selection and update automatically 
as you move about the Navigator.  

The remaining nine views are global and include: 

The Item Report View 

The Exception Report Views (6 reports) 

The Override Report View 

Outlier Report 

The Numeric Output View 

The Mapping Report View 

The Status Bar 
The Status Bar, on the bottom of the Forecast Pro window, displays key information about the status of 
the open project.  

On the right-hand side you will see the beginning and ending periods for your historic data, the current 
hierarchy and the current unit definition for your project. As described in The Navigator Context Menu, 
Forecast Pro allows you to group your data in different ways by “shuffling” the hierarchy. The current 
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hierarchy ordering is shown next to the Hierarchy icon on the status bar. Forecast Pro also allows you to 
convert your default units (how the historic data is defined) into alternative measurements, such as 
dollars, using a Conversions data file (see Conversion factors in Setting Up You Optional Data). You may 
change your unit measurement to one of the read-in conversion factors on the Operations tab. The 
status bar displays the unit measurement that is selected in the Units drop-down on the Operations tab. 

Changing the display units and/or altering the hierarchy will “lock” the statistical forecasts. When the 
statistical forecasts are locked, you are no longer able to change the statistical forecasting methods used 
to generate the statistical forecasts and the sections of the Forecast Report that pertain to the statistical 
modeling (i.e., Expert Analysis, Model Details, Within-Sample Statistics, Out-of-Sample Tests and 
Outliers) are omitted. If you subsequently return to the default state (i.e., default units and default 
hierarchy) the statistical forecasts will be “unlocked.” If you are in a locked state, Forecast Pro displays a 
lock icon with the text “Stat Forecast Locked” on the far right of the status bar.  

The left-hand side of the status bar displays dynamic information about the current project status. 
When using the override grid, the status bar will display the total and average for selected override grid 
cells. These are also displayed if you select numeric values in one of the report views. 

Forecast Pro Ribbon Tabs 

File Tab 
Selecting the File tab will take you to the following screen. 

 
When you are on the File tab, you do not have a view of your project or the rest of the Forecast Pro 
Interface. On the right side, there is an Information pane displaying key details about the current 
project. Along the top, you will see the project’s filename and the folder the project file is saved in. 
 
On the top left, common file operations, including New, Open, Save, Save As, Close and Exit, are listed. 
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In the middle section there are 4 large icons: New Project (opens a new project), Getting Started (links 
to a short video), Tutorials (opens the Tutorials) and User Guide (opens the User’s Guide). Beneath 
these icons you will see a pane that displays recent projects and a list of all projects in your default 
project directory (set in the Option settings). 

Home Tab 

 
Forecast Pro’s most frequently used commands are available on the Home tab.  

Layouts: On the left-hand side of the Home tab is the Layouts group. The Layouts drop-down is used to 
select a saved layout to display. Above the drop-down are four small icons for adding, managing, 
updating and removing layouts. Please see details in the “Working with Layouts” section of the 
Advanced Navigation lesson in Forecast Pro TRAC Tutorials or Working with Layouts in this reference. 

Data Manager: To the right of the Layouts group is the Data Manager icon. The Data Manager is used to 
read data into the project. Once data is read in, the Navigator displays all items to be forecast, and the 
Hot List becomes available for use. Graphs will also become available after data has been read in. 
Consult Using the Data Manager for details. 

Graphs: Click on the Graph icon to open a graph view for the item selected in the Navigator. Up to four 
additional graphs may be added to the view window by selecting Add Graph on the Graph icon’s drop-
down. Finally, you may select Diagnostics on the Graph drop-down to open the Diagnostics view. Details 
for how to work with the Graph and Diagnostic views are in The Graph Views and The Diagnostics View. 

Overrides: The Override icon opens the Override view which allows you to adjust forecasts for the 
selected item. Consult The Override Forecasts View for details. 

Forecast Report: The Forecast Report icon opens the Forecast Report. The Forecast Report view 
displays the forecasting model, within-sample statistics, historic data and forecasts for the selected 
item. If you are using a holdout sample, the Forecast report view will also include an out-of-sample 
evaluation section. Details for using the Forecast Report view are in The Forecast Report View. 

Forecast Tracking: Clicking on the Forecast Tracking icon) opens the Tracking Report view. Note that 
Forecast Tracking is only available if there are archived forecasts (forecasts generated in prior periods). 
The drop-down on the Forecasts Tracking icon allows you to open the Tracking Graph and access the 
Tracking Report settings. Consult The Tracking Report and Tracking Report Graph Views. 

Numeric Output: The Numeric Output icon provides a quick way to save your Numeric Output in a 
single click. Numeric Output Files can contain time series output such as history, forecasts, fitted values 
and confidence limits as well as statistical output such as the forecasting model specification and 
summary statistics. These files can be saved in text, spreadsheet, ODBC or XML formats. You can include 
output for either all items forecasted or just for the Hot List. If you will be importing the forecasts into 
another application, you will likely do so with the Numeric Output file. 

The drop-down on the Numeric Output icon allows you to open the Numeric Output view (select Show) 
and the settings associated with the Numeric Output file. The Numeric Output view displays the 
contents and format of the currently specified Numeric Output file, which can both be adjusted using 



Forecasting Tab | 46 
 

 

the Numeric Output settings. You do not need to display the view in Forecast Pro to adjust the settings. 
Consult The Numeric Output View and Numeric Output Files for more details. 

Excel Collaboration: The Excel Collaboration icon opens the Excel Collaboration Manager dialog box. 
From this dialog box, you can create, update and import Excel-based Forecast Pro collaboration sheets. 
Once created, the collaboration sheets may be distributed to users with a valid Forecaster or 
Collaborator license. Using the Forecast Pro Excel Add-in, users may review the forecasts and make 
overrides in Excel. The edited files can then be imported back into the Forecast Pro project, which will 
then contain the consolidated overrides from all imported files. Excel Collaboration is a fast and easy 
way to collaborate with multiple colleagues in parallel. Please consult the Collaborating with Colleagues 
lesson in Forecast Pro TRAC Tutorials or Excel Collaboration in this reference. 

Options: The Options icon opens the Options dialog box. This dialog box controls project-level settings. 
Typically, you will want to set your options when you are starting a project. Please consult Forecast Pro 
Options for details. 

Auto Arrange: Forecast Pro allows you to open multiple views in the View Window. These views may be 
resized and arranged as you wish. The Auto Arrange icon (with drop-down) tiles the open views 
horizontally. This can be helpful when you open a new view. Given that auto arrange is often used after 
opening a new view, the Auto Arrange icon is available on the Quick Access Toolbar by default. 

Recalculate: This option is only available when Manual override mode or Manual forecast mode is 
selected on the Performance tab of the Options dialog box (see The Performance Tab). Selecting 
recalculate will reconcile all forecasts and overrides in the project.  

Forecasting Tab 

 
By default, Forecast Pro will use expert selection, an Artificial Intelligence (AI) driven engine, to 
automatically select a forecasting model for each item on the Navigator. You may specify if you want 
expert selection to include machine learning models, Box-Jenkins (ARIMA) models, seasonal 
simplification and/or NA-CL models on The Performance Tab of the Option dialog box. Alternatively, you 
may select alternative models and/or forecasting options on the Forecasting tab. 

Available models, modeling options and Forecasting tab functionality are documented in detail in 
Customizing Your Forecasts. 

Data Tools Group 

Diagnostics 

Create Helper 

Outliers 

Start Dates 

Remove Modifier 
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Reports Tab 

 
The Reports tab provides access to all Forecast Pro Views. Details for each of these views are described 
in the Forecast Pro Views chapter. 

Graphs: Click on the Graphs icon to open and close a Graph view for the item selected in the Navigator. 
Up to four additional graphs may be added to the view window by selecting Add Graph on the Graph 
icon drop-down. Finally, you may select Diagnostics on the Graph icon drop-down to open the 
Diagnostics view.  

Overrides: The Override icon opens and closes the Override view, which allows you to adjust forecasts 
for the item selected in the Navigator. 

Forecast Report: The Forecast Report icon opens and closes the Forecast Report. The Forecast Report 
view displays the forecasting model, within-sample statistics, historic data and forecasts for the selected 
item.  

Forecast Tracking: Clicking on the Forecast Tracking icon opens the Tracking Report view for the 
selected item. Note that Forecast Tracking is only available if there are archived forecasts (forecasts 
generated in prior periods). The drop-down on the Forecast Tracking icon allows you to open the 
Tracking Graph and access the Tracking Report settings.  

FVA Report: The FVA Report icon opens the FVA (Forecast Value Add) Report view, an item level view 
that analyzes the accuracy and “value add” of each step in your forecasting process. The process steps 
are aligned with the override rows. This report will only display data for the item currently selected in 
the navigator. The FVA Global Exception Report view is available in the Reports Group. The FVA global 
view displays the accuracy and value add for multiple items and override rows in your project so that 
you can understand which overrides worked for which items. Please consult The Forecast Value Add 
(FVA) View or FVA Global for more details. 

Reports Group: The Reports group includes the following: 

Exception Reports: There is an icon for opening each of the six Exception Report Views (Forecast vs. 
History, Forecast vs. Archive, Forecast Accuracy, Waterfall, FVA Global and Custom). The Exception 
Reports enable you to quickly find cases where your forecast error or some other performance 
metric has fallen outside of an acceptable range. Exception reporting reduces the need for manual 
review of your forecasts and allows you to focus on the items where human attention is most 
needed.  

Item Report: The Item Report icon opens and closes the Item Report. Item Reports may contain 
time series output such as history, forecasts, fitted values and confidence limits as well as statistical 
output such as the forecasting model specification and summary statistics. The drop-down on the 
Item Report icon allows you to open the Settings dialog box associated with the Item Report. The 
functionality of the Item Report is essentially the same as the Numeric Output view, but the Item 
Report allows you to change the view without impacting the structure of the Numeric Output File.  

Outliers: The Outliers icon opens and closes the Outlier Report, a global report that list all outliers 
identified in the project.  
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Override Report: The Override Report icon opens and closes the Override Report view which shows 
all overrides in the project.  

Numeric Output: The Numeric Output icon opens your Numeric Output view. Numeric Output 
Reports can contain time series output such as history, forecasts, fitted values and confidence limits 
as well as statistical output such as the forecasting model specification and summary statistics. The 
drop-down on the Numeric Output icon allows you to open the Settings dialog box associated with 
the Numeric Output. Note that these setting are typically configured for exporting a file with a 
defined structure, so changing these settings may disrupt your forecasting process. Consult the 
Numeric Output View and Numeric Output Files for more details. 

Mapping Report: The Mapping Report icon opens the Product Mapping Report. This global report 
tracks all active mapped histories in your project. Please consult The Mapping Report for more 
details. 

Import Tab 

 
The Import Tab includes the functionality for reading in project data as well as several other types of 
information, possibly from other saved Forecast Pro projects, into your current project. 

Data Manager: Clicking the Data Manager icon opens the Data Manager dialog. The Data Manager is 
used to read data into the project. Once data is read in, the Navigator displays all items to be forecast, 
and the Hot List becomes available for use. Graphs will also become available after data has been read 
in. Consult Using the Data Manager for details. Note that the Data Manager icon is also available on the 
Home tab. 

Project Settings: The Project Settings icon is used to import project settings from a saved project into 
the current project. The settings include all selections on the Options dialog box as well as formatting for 
reports and output files. Because the settings control how data is read into Forecast Pro, you may only 
import project settings prior to reading in the data. 

Hot List: The Hot List icon is used to import a Hot List from a saved project or from an Excel file into the 
current project. Excel Hot List files are created using the Hot List icon on the Export tab or using the 
Save Hot List option on the Hot List’s context menu. If a Hot List currently exists, you will have the option 
of deleting it prior to importing the new Hot List. See The Hot List for more details. 

Layouts: The Layouts icon is used to import layouts from a saved project into the current project. Please 
see details in the Working with Layouts chapter of this reference. 

Calculated Rows: The Calculated Rows icon is used to import calculated rows from a saved project or 
Excel file into the current project.  

Archived Forecasts: The Archived Forecasts icon is used to import archived forecasts from a saved 
project into the current project. When you select this option a dialog box appears allowing you to 
specify the origin date for the archived forecast sets that you wish to import. 

Archived Overrides: The Archived Overrides icon opens the Import Archived Overrides dialog box which 
is used to load override sets from the current Forecast Pro database.  
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You can load individual override sets by highlighting them and clicking the Apply button. The “Filter by” 
options allow you to control which override sets to display. Selecting “Compatible series” will eliminate 
all override sets that do not match the current state (i.e., it will eliminate all override sets where the 
units of measure and/or the hierarchy structure does not match the current project’s display). 

The most common use for this facility is loading override sets made last period after updating the 
statistical forecasts. For an override from the selected override set to be loaded, the item’s hierarchy 
path must match an item in the current project.  

Export Tab 

 
Reports Group: The Reports Group includes functionality to export the Numeric Output or any of the 
other Forecast Pro reports for all or a subset of the items in your project.  

On the left-hand side of the group, you can select which items you want to export. You may select 
Current Display (includes the items shown if you opened the report view, including any active filters), 
Hot List (items currently displayed in the Hot List) or All. 

Clicking any of the Reports group icons (Numeric Output, Forecast Report, Item Report, Outliers, 
Override Report, Forecasts Tracking, Product Mapping Report, Forecast vs. History, Forecast vs. Archive, 
Forecast Accuracy Waterfall, FVA Global, Custom, Mapping Report, Product Mapping File and Mapped 
History File) will prompt you to save the report for the specified items.  

Note that the Forecast Report and Forecasts Tracking icons will both save a Formatted Forecast Report, 
including a tab for each exported item, in the saved Excel file.  

Other Group: The icons in the Other Group allow you to save the Hot List, Helpers, Calculated Rows or 
Modifiers in the saved current project. These files may then be read into another Forecast Pro project 
with the Import tab. 
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Operations Tab 

 
Date Range Group: The Date Range controls are used to set the span of data used when estimating 
forecast models, define a holdout sample and reset dates to the default of using all available data 
without a holdout sample.  

Year and Period: The Year and Period spinners are used to define the fit set. All time series methods 
begin by fitting a model to historic data. You can alter the beginning year and beginning period to 
specify the first point of the fitting sample and/or the ending year and ending period to specify the 
last point. By default, Forecast Pro selects the largest fit set for which data exists. Normally, you will 
want to accept the defaults. However, you may want to ignore earlier data if you distrust their 
relevance. 

Please note that the fit set selected is applied to all forecasted items, unless you have used the Start 
Dates icon on the Forecasting tab to specific alternative start dates for individual items.  

Holdout Periods: This spinner is used to specify the length of a holdout sample. When using a 
holdout sample, Forecast Pro withholds the specified number of periods at the end of the data from 
the model fitting. If you withhold 2 or more points, Forecast Pro automatically generates out-of-
sample evaluation statistics for any models that you build. These statistics are available in the 
Forecast Report. If you do not want to perform out-of-sample testing, set the holdout sample to 
zero (the default). 

Read Data: The Read Data icon reads in the Historic Data defined in the Data Manager from its primary 
source along with any other inputs where the on Read option is selected. 

Forecast: Clicking the Forecast icon generates statistical forecasts. This option is only available when 
historic data has been defined in the Data Manager and the data has been read in. Changes to the date 
range used may require you to re-forecast the data. 

Recalculate: This option is only available after changing the date range or when Manual override mode 
or Manual forecast mode is selected on the Performance tab of the Options dialog box (see The 
Performance Tab). Selecting the Recalculate icon will reconcile all forecasts and overrides.  

Simulate Archive: The Simulate Archive icon is used to generate statistical forecasts for previous 
forecast origins (last period used to generate a forecast) and to insert them into the Forecast Pro 
database. Essentially this is a form of simulation that allows you to initialize the forecast archive with 
statistical forecasts. Clicking the Simulate Archive icon opens the following dialog box. 
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The Simulate Archive dialog box allows you to specify how many periods you wish to initialize or 
simulate. Forecasts will be generated for the specified period and all subsequent periods up to the 
current origin. 

In the example above, the current origin (last period of historic data) is June 2020. The periods to 
initialize is set to 12, which corresponds with a forecast origin of June 2019 (12 periods prior to the 
current origin). Simulation would begin by generating forecasts using data up to and including June 2019 
and inserting them into the database. It would then generate forecasts using data up to and including 
July 2019 and insert them into the database. It would continue this process until all 12 forecasts sets had 
been generated and inserted into the database. 

Time Fence Group: Please consult Using a Time Fence for a detailed description of time fences. 

Enable: The Enable icon turns on a time fence for the current project. Once you turn a project’s time 
fence on, it cannot be turned off! 

Freeze Next Period: Clicking the Freeze Next Period icon will increase the length of all time fences in 
the current project by one period. If you subsequently update your data with the next observation 
and create a new forecast (thus changing the forecast origin), the time fence length will revert to 
their pre-Freeze-Next-Period settings. This option provides a way of insuring that after the forecasts 
are finalized, the user cannot inadvertently alter the frozen periods’ forecasts prior to the data being 
updated, new forecasts being generated and the frozen periods’ forecast becoming an officially 
fenced value. 

Control Panel: The Control Panel icon invokes the TRAC Control Panel dialog box which is used to view 
information about the current project’s database and to purge unwanted or obsolete forecasts and 
overrides. 

Important: To reduce the size of the Forecast Pro database file, you must use the Compact button after 
purging forecasts and overrides. Purging without compacting results in the records being deleted from 
the database but does not change the file size. 

 
The grid displays the contents of the database.  
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The Purge Forecasts button will delete all forecasts prior to the specified date. 

The Purge Overrides button will delete all overrides prior to the specified date. 

The Purge Mapped Hist. button will delete all mapped histories prior to the specified date. When there 
is no mapped history, Forecast Pro uses the actual history in the historic data file for forecasting. 

The Compact button consolidates the Forecast Pro database file. Use this button to reduce the size of 
the database file after purging forecasts and/or overrides.  

Password: This icon is used to password protect your project. When you attempt to open a password-
protected project, Forecast Pro will prompt you for the password and only open the project if the 
correct password is entered.  

Super Project: The Super Project icon invokes the Super Project Manager. The Super Project Manager is 
used to consolidate multiple projects into a “super project” or to update a super project. 

Setting up and maintaining a super project is reasonably complex. If you are planning on using super 
projects you should (1) refer to the Collaborating With Colleagues lesson in Forecast Pro TRAC Tutorials 
for a discussion of the pros and cons of super projects and an illustration of using the Super Project 
Manager to create a super project and (2) read the Working With Super Projects in this reference 
carefully. Business Forecast Systems and Forecast Pro distributors also offer consulting services to help 
you establish your forecasting process. 

 
When creating a new super project, you first use the Add button to select the component projects to 
consolidate. The Import options allow you to specify what you wish to import from the component 
projects. When first creating a super project, you will generally import everything. When updating a 
super project, you may want to pick and choose what to import.  

The “Erase first” options are only relevant if you are updating a super project. If selected, they will erase 
any data corresponding to the specified component prior to loading in the new data.  

After you have selected the component projects and the import selections, the Apply button is used to 
create or update the super project.  

Reorder Hierarchy: The Reorder Hierarchy icon used to “shuffle” (rearrange) the hierarchy displayed on 
the Navigator. Reading data into Forecast Pro establishes the default hierarchy. If the default hierarchy 
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contains 4 levels, the notation 1-2-3-4 is used to represent the default state. Selecting Reorder opens a 
dialog to redefine the hierarchy by moving the currently selected level “up” or “down” one level. For 
example, promoting level 3 of a 4-level default hierarchy, would change the displayed hierarchy from 1-
2-3-4 to 1-2-4-3. Hierarchy>Restore Default converts the currently displayed hierarchy back to the 
default hierarchy. You may also access the Reorder the Hierarchy dialog in the Navigator Context menu. 

Units:  The Units drop-down box is used to change the display units. This box will only be available if you 
have defined conversion factors for your current data set in the Data Manager. The Units icon on the 
status bar will display the Units drop-down selection. Consult Conversion Factors in Setting Up Your 
Optional Data for details. 

Changing the display units and/or altering the hierarchy will “lock” the statistical forecasts. When the 
statistical forecasts are locked, you are no longer able to change the statistical forecasting methods used 
to generate the statistical forecasts and the sections of the Forecast Report that pertain to the statistical 
modeling (i.e., Expert Analysis, Model Details, Within-Sample Statistics, Out-of-Sample Tests and 
Outliers) are omitted. If you subsequently return to the default state (i.e., default units and default 
hierarchy) the statistical forecasts will be “unlocked.” Consult Understanding How Forecast Overrides 
are Allocated for more details. 

Help Tab 

 
Forecast Pro includes extensive online help. 

Tutorials:  The Tutorials icon opens a pdf version of Forecast Pro TRAC Tutorials. The file includes links 
to online video tutorials as well as written tutorials. These tutorials are designed to give you an overview 
of Forecast Pro’s functionality. The tutorials are organized into two section: General Operations and 
Forecasting Operations. The General Operations tutorial is designed to teach you how to use the 
Forecast Pro interface, while the Forecasting Operations tutorial focuses on customizing your models 
and forecasts.  

Program Reference: The Program Reference icon opens a pdf version of the Forecast Pro TRAC 
Reference. 

Statistical Reference: The Statistical Reference icon opens a pdf version of the Forecast Pro Statistical 
Reference Manual. 

Check for Updates: This icon will check online to see if you are running the latest release of the 
program. If a product update is available, you’ll receive a message alerting you to this fact with 
instructions describing how to receive the update. If your support and maintenance contract is up to 
date, product updates are free. 

About Forecast Pro: This icon displays the Forecast Pro version number, copyright notice and your 
license information (Serial Number and CD Key). 
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The Navigator Context Menu 
The Navigator’s context menu provides a convenient way to build a Hot List, apply forecast modifiers, 
control the display of the Navigator tree and rearrange the hierarchy. Most of the options are self-
explanatory, however a few warrant some explanation. 

The options under Add to Hot List are used to copy items onto the current Hot List (the Hot List is 
described in the next section). Children, Parents and Siblings refer to one level down on the current 
Navigator branch, one level up on the current branch and the same level on the current branch, 
respectively. On the Analysis submenu, Overrides refers to items with direct overrides and Affected 
refers to items with indirect overrides (i.e., items where a direct override elsewhere in the hierarchy 
changed the item’s forecast). 

The options under Forecasting are all used to apply forecasting models and specify forecast modifiers. 
The most commonly used modifiers can be applied directly using the menu options. The less commonly 
used modifiers can be entered from the keyboard using the Custom Modifier option. All forecasting-
related functionality on the Navigator’s context menu is also available on the Forecasting tab. Please 
consult Customizing Your Forecasts for details on the available forecasting options and supported 
forecast modifiers. 

The Hierarchy>Reorder option is used to “shuffle” (rearrange) the hierarchy displayed on the Navigator. 
Reading data into Forecast Pro establishes the default hierarchy. If the default hierarchy contains 4 
levels, the notation 1-2-3-4 is used to represent the default state. Selecting Reorder opens a dialog to 
redefine the hierarchy by moving the currently selected level “up” or “down” one level. For example, 
promoting level 3 of a 4-level default hierarchy, would change the displayed hierarchy from 1-2-3-4 to 1-
2-4-3. Hierarchy>Restore Default converts the currently displayed hierarchy back to the default 
hierarchy. You may also access the Reorder the Hierarchy dialog by clicking the Reorder Hierarchy icon 
on the Operations tab. 

Hierarchy>Set Pareto Level is used to define the hierarchy level for Pareto analysis. If you select this, the 
hierarchy level for the selected item will be used as the “Hierarchy level” on The Pareto Tab in the 
Options dialog box. 

The Helper Variable>Create option is used to access the Create Helper Variable dialog box. This utility 
allows you to create helper variables based on your current Navigator selection. You may also access the 
Create Helper Variable dialog box from the Forecasting tab. Please consult Create Helper in Customizing 
Your Forecasts for details on creating helper variables. 

If you select a helper variable on the Navigator, you can use the Helper Variable>Delete option to delete 
it from your project.
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Working with Layouts 
Layouts are an excellent way to standardize your forecasting process. Layouts allow you to save and 
return to setting and window view configurations. If you set up your forecasting process with layouts, 
you can easily access the key information you need each time you update your project. Please consult 
the Working with Layouts section of the Advanced Navigation lesson and the Touring the Five Reports 
section of the Exception Reporting lesson in Forecast Pro TRAC Tutorials for more details on using 
layouts. 

To make a layout, you first create a project view that you find useful. For example, you may want to 
have a graph view and an item report filtered to products with less than 12 periods of history. If you are 
using monthly data, this view will show you all items with less than a year of history. You can view each 
item in the graph by double clicking on each item in the item report list. Next, you will want to save that 
view as a layout. 

Layouts are managed from the Home tab. 

 

Adding Layouts 
The  icon opens the Add Layout dialog.  

 
To add a layout, simply enter a layout name, a description (if desired) and click OK. If you click on the 
Layouts drop-down list on the Home tab or Quick Access Toolbar, you will now see your saved layout 
included. If you select your layout from the drop-down menu, Forecast Pro will display the view and 
setting configurations as saved in the selected layout.  
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Managing Layouts 
The Layout settings can be configured by clicking the Manage Layout icon ( ) to open the Layout 
Manager dialog box.  

 
Name: This drop-down shows four Layout commands, New, Rename, Save As and Delete, as well as the 
layouts that have been saved to the current project. The drop-down displays the currently selected 
layout. 

New: Opens the Add Layout dialog box described above. 

Rename:  Opens the Rename Layout dialog box where you can enter a new name. 

Save As: Opens a Save As dialog box that will take the settings for the selected layout, along with 
any changes you have made in the Layout Manager dialog and create a new layout with the 
specified name. 

Delete: Removes the selected layout from the current project. 

Update: The Update button updates the currently selected layout with specified changes. 

Delete: The Delete button removes the selected layout from the current project. 

Display: The Display column allows you to specify, for each Forecast Pro view, if you want the selected 
layout to save display and/or settings configurations for the selected view. Display settings include view 
window status (open, closed etc.) and view location, while settings include anything that is specified in 
the view’s Setting dialog box. Display is checked for all views that should be shown in the layout. If a 
view has Settings checked but not Display, Forecast Pro will load the settings as specified in the layout 
but not open the view window. This may be useful if you want to export reports with saved settings, but 
you do not want to view the Report in Forecast Pro. 

Include hot list: Check this if you want the layout to save hot list items, so that when the layout is 
selected the hot list displays those saved items. 
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Include selected item: Check this if you want the layout to associate the item selected on the Navigator 
with the layout. 

Include navigator layout: Check this if you want the layout to save the Navigator layout (e.g. which 
nodes are open) and update the Navigator when you select the layout. 

Layouts may be removed and refreshed directly from the Home tab using the remove layout icon ( ). 
Clicking on the Remove icon opens the Remove Layout dialog box. Simply select the layout you want to 
remove and click OK to remove a layout from the Layouts drop-down and the current project. 

Layouts may also be updated directly from the Home tab with the Update icon ( ). Click the Update 
icon to launch the Update Layout dialog box. Selecting a layout in the dialog box and clicking OK will 
replace the selected layout with the current Forecast Pro view and settings.
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Using the Data Manager 
The Data Manager provides a centralized place to define all input data for Forecast Pro and keep it up to date.  

Row Types 
You invoke the Data Manager by clicking the Data Manager icon on the Home tab.  

 
The Data Manger consists of ten rows, each of which allows you to read in a different type of data. 

In addition to the Historic Data (which is required), Forecast Pro’s Data Manager allows you to import other 
information to assist you in creating and working with the forecasts. Specifically, you can import: 

Conversions Factors. Conversion factors allow you to display the history and forecasts in alternative units of 
measure (e.g., dollars, kilos, etc.). Consult Conversion Factors for details. 

Explanatory Variables. Variables that you may wish to include in a dynamic regression model may be read in 
with an explanatory variable file. Explanatory Variables provides details. 

External Data. Forecast Pro allows you to import external data rows (such as alternative forecasts, open orders, 
etc.) into the forecast override grid. External Data Files provides setup details. 

Filters. Filter fields can be included in report views and filtered like any other fields. They can also be included in 
the numeric output file. Custom Filter Fields provides details. 

Definitions. Definition files contain values to use in conjunction with custom forecast allocations and item-level 
integer rounding quantities. Consult Definitions: Custom Allocations and Definitions: Integer Rounding 
Quantities for details. 

Overrides. In addition to entering forecast overrides interactively using the Forecast Overrides view, Forecast Pro 
allows you to import them. Consult Override Files for details. 
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Helpers. Helper variables are used in conjunction with event models, forecast by analogy models and weighting 
transformations. Helper Files provides details. 

Modifiers. In addition to specifying forecast modifiers interactively on the Navigator, Forecast Pro allows you to 
import them. Modifier Files provides details. 

Mapped History. Product Mapping and Mapped History files are used to create Forecast Histories, which equal 
the Mapped History, if it exists, plus the actual histories in the Historic Data files. Product Mapping and Mapped 
History files are useful for item supersession and new/replacement products. See Mapping Files for details. 

Row Controls 
Each row has controls associated with it that allow you to specify data sources, remove data sources and read 
the data. 

Add drop-down. The Add drop-down is used to select data sources. You first specify the type of data source you 
will be adding (Excel, MLT or ODBC) and then the program will prompt you to specify the file, table or query. The 
Overrides, Helpers and Modifiers rows also allow you to specify a Forecast Pro project as the data source. If you 
wish to specify multiple data sources for a given row, you may. The first time you add an ODBC data source you 
will be prompted to choose an ODBC driver and connect to the database. Note that you can only read from one 
ODBC connection at a time. 

 
Selected data sources drop-down. After you add one or more data sources to a given row, the filenames, table 
names, query names, or project names will appear on the selected data sources drop-down display. If you open 
this drop-down, you will see a list of the selected data sources along with a checkbox to the left of each one. This 
check box is used to mark the source as active or inactive. When you read the data, only the active data sources 
will be read. 
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Remove drop-down. The remove drop-down is used to remove data sources from the row. You have the option 
of either removing all specified data sources or only the inactive (unchecked) ones. After you use the Remove 
drop-down you will need to refresh the row to delete the data from the current project. 

Status box. The status box displays the current status for the data sources specified on the row. “Refresh 
pending” means that the current row specifications do not match the project’s current state and you need to 
refresh the row to sync them with the project. 

Read & Forecast button. The Historic Data row includes a button labeled Read & Forecast. Clicking the button 
will read in the historic data and generate the forecasts. It will also refresh (i.e., read or re-read) any data rows 
where the “on read” option is selected. 

Refresh button. The Refresh button is used to read (or re-read) the data for the specified row.  

On Read checkbox. Five of the rows include an on Read checkbox. If this option is selected Forecast Pro will 
automatically refresh the row whenever you read in the historic data. The on Read option is useful when the 
associated data will be changing each forecast period.  

Notice that the Overrides, Helpers, Modifiers and Mapped History rows do not have on Read options and 
therefore can only be refreshed by clicking their Refresh buttons (or clicking Refresh All). This is because 
overrides, modifiers, helper variables and mapped histories can all be modified interactively using Forecast Pro, 
and therefore refreshing them automatically from the data source may have unintended consequences (e.g., 
overriding your manual changes, etc.) 

Refresh All button. The Refresh All button will refresh all data rows except the Historic Data. Note that it will 
refresh all rows that have defined data sources even if their status is up to date.
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Forecast Pro Options 
The Options icon on the Home tab opens the Options dialog box which is used to change various 
Forecast Pro settings.  

The Options dialog box contains both a Set as Default button and an OK button. Clicking the OK button 
will apply the defined settings to the current project. Clicking the Set as Default button will save your 
current settings as the default settings for all new projects. 

The Options dialog box contains eight pages or tabs. We will discuss each in turn. 

The Basics Tab 

 
The Basic tab contains frequently accessed settings that every user should understand. 

File Settings: 

Input Data. Specify the complete path name of the directory where the program should read data. 

Projects. Specify the complete path name of the directory where the program should write the project 
files. 

Output. Specify the complete path name of the directory where the program should write all output files 
(e.g., Numeric Output files, Forecast Reports, etc.). 

Forecast Options: 

Allow negative forecasts. Most business data are inherently positive, although there are exceptions like 
telephone connection gain or sales data that include returns as negatives. Users with positive data are 
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understandably disturbed when their forecasts turn negative. This can occur when Forecast Pro captures 
a downward trend at the end of your historic data. If Allow negative forecasts is turned off, Forecast Pro 
will replace negative forecasts with zeros. If Allow negative forecasts is turned on, then Forecast Pro 
takes no special actions to avoid negative forecasts. 

Forecast horizon. Specify how many periods ahead you want Forecast Pro to forecast. 

Upper confidence limit. Specify the percentile for the upper confidence limits. The upper confidence 
limit for a specific item can also be specified using the \Upper= modifier. 

Lower confidence limit. Specify the percentile for lower confidence limits. The lower confidence limit for 
a specific item can also be specified using the \Lower= modifier. 

Safety stock lead time. Specify the lead time for the safety stocks. The specified lead time appears 
highlighted in the Safety Stock section of the Forecast Report and determines the values written to the 
Numeric Output file. Fractional entries (e.g., 1.5) are permitted. 

The Formats Tab 

 
The Formats tab controls the formatting of the input and output. 

Input Data: 

Decimal separator. Specify whether a period or a comma is used for the decimal point. The program’s 
default is the convention appropriate for the United States, which is the period. 

Column delimiter. Specify whether items in an MLT file are separated by spaces, commas or tabs (i.e., 
are the files space delimited, comma delimited or tab delimited). 
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Thousands separator. Specify the thousands separator used for input MLT files. The choices are none, 
comma and period. Forecast Pro does not use thousand separators in output. 

Automatically sort. By default, the Automatically sort option is selected, and Forecast Pro will merge and 
sort all historic data sources prior to reading them in. This can be useful when the order of the items in 
your data sources does not match the desired hierarchy. If the Automatically sort option is not selected, 
Forecast Pro reads in your historic data sources sequentially and bases the structure of the Navigator’s 
hierarchy on the order of appearance of the items in the data sources. 

Include group totals for data files. If this switch is on, Forecast Pro will automatically include a group 
total for each data file, table or query listed on the Historic Data row of the Data Manager. Including or 
not including a group total for the data files will yield different hierarchies on the Navigator. 

Allow zero valued conversion factors. If this switch is on, Forecast Pro will allow blanks, zeros or missing 
rows in a conversions file specified in the Data Manager. Forecast Pro will give warnings about the 
missing data and changing project units using the Units drop-down on the dialog bar is not enabled. 
However, the converted rows are available in the Overrides Report and Graph views. Blanks are 
considered zeros, and items with either zero or blank conversion factors will consequently not be 
included in the totals for those conversion factors. If this switch is not on, Forecast Pro will give an error 
and not read in a conversions file with blanks, zeros or missing rows. 

Zero demand threshold. If you set the zero demand threshold to “N” and the Discontinue option is not 
selected, Forecast Pro’s expert selection mode will generate a forecast of zero for any item where the 
last N historic observations are equal to zero. If you set the zero demand threshold to “N” and the 
Discontinue option is selected, Forecast Pro’s expert selection mode will discontinue and therefore not 
forecast any item where the last N historic observations are equal to zero. 

Ignore leading zeros. If this option is selected, leading zeros prior to the first nonzero data point will be 
ignored (i.e., the data has not started yet, and the zeros are interpreted as placeholders). For a more 
complete discussion on the handling of missing data and the distinction between a zero value and a 
missing value, please refer to the Missing Values and Zeros section in the Setting Up Your Historic Data 
chapter. 

Ignore trailing zeros. If this option is selected, trailing zeros after the last nonzero data point will be 
ignored (i.e., the data has ended, and the zeros are interpreted as placeholders). This means that the 
time series would be considered “dead” and not forecasted. For a more complete discussion on the 
handling of missing data and the distinction between a zero value and a missing value, please refer to 
the Missing Values and Zeros section in the Setting Up Your Historic Data chapter. 

Missing Values. The Missing Values drop-down allows you to specify how you wish the program to treat 
missing values. Options include: truncate the data set (i.e. discard all data that precedes the missing 
value), impute the missing data via a linear interpolation or set missing data points to zero. Regardless of 
how this option is set, missing values that appear prior to the first data point are ignored. For a more 
complete discussion on the handling of missing data and the distinction between a zero value and a 
missing value, please refer to the Missing Values and Zeros section in the Setting Up Your Historic Data 
chapter. 

Allow no history. If this switch is on, Forecast Pro will create a forecast of zero per period for items that 
have no historic data. If the switch is off, items with no historic demand will be omitted and not appear 
on the Navigator. 

Set trailing blanks to zero. When historic data is read into Forecast Pro, the program establishes a global 
ending date for the history which corresponds to the most recent observation available for any item 
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being read in. If a given item does not have a historic observation for the global ending date, the item is 
flagged as “dead.” Dead items are not forecasted but their demand history goes into the group totals. 
This can be an issue if your data source codes zeros as missing (e.g., blank cells in Excel, no transaction in 
a table or query, etc.). The Set trailing blanks to zero option will replace missing trailing observations 
with zeroes. For a more complete discussion on the handling of missing data and the distinction 
between a zero value and a missing value, please refer to the Missing Values and Zeros section in the 
chapter entitled Setting Up Your Historic Data. 

Text Files: 

Text file encoding. Specify the format to use when writing two-byte characters to text files. This option is 
only relevant if your data uses non-ASCII characters. (Non-Latin based languages such as Japanese, 
Chinese, Russian, Arabic, etc. use non-ASCII characters.) 

Code page. Specify the Windows code page to use when text file encoding is set to multi-byte. The code 
page specifies the character set to use when writing a multi-byte text file. (Most code pages are 
designed to support a specific language.) 

The Outliers Tab 

 
The Outliers tab is used to specify if and how Forecast Pro should detect and/or correct outliers. It also 
allows you to set the sensitivity settings for outlier detection and to dictate the amount of detail in the 
outlier report. 

Detection and Correction Logic: 

None turns outlier detection off. The forecasts will be generated using the uncorrected history. 
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Detection only will detect outliers and display the suggested corrected values, but the forecasts will be 
generated using the uncorrected history. 

Detection and correction will detect outliers and will automatically use the corrected values when 
generating forecasts. 

Sensitivity (std. deviations) allows you to set the sensitivity of the outlier detection algorithm. If a given 
fitted error exceeds this threshold and it is the largest error detected during the current iteration, it will 
be flagged as an outlier. Consult the Forecast Pro Statistical Reference Manual for more details on 
outlier detection and correction. 

Maximum iterations allows you to set the maximum number of iterations permitted during outlier 
detection for a given item. Since only one outlier is identified per iteration, this setting also defines the 
maximum number of outliers that can be detected for a given item. Consult the Forecast Pro Statistical 
Reference Manual for more details on how outlier detection and correction. 

Rules: 

Disable correction for initial X and/or final Y data points allows you to disable correction for data points 
at the beginning and/or end of an item. The outlier detection algorithm is sometimes less robust for the 
beginning and ending historic periods. Disabling correction for the initial and/or ending periods can 
avoid possible misidentification of outliers in these cases. Consult the Forecast Pro Statistical Reference 
Manual for details. 

Set history to zero if number of non-zero data point is <= X and total number of data points >= Y allows 
you to set the entire history to zero for an item if the number of zeros meets a specified threshold and 
the total number of historic data periods exceeds a specified threshold. This setting only has an impact if 
Outlier Detection and correction is enabled. 

Layout: 

Include iteration statistics in reports allows you to include detailed statistics describing the outlier 
detection process in the outlier report. Consult the Forecast Pro Statistical Reference Manual for details. 

The other options in the Layout section allow you to include columns for the Pareto output and to 
include columns for custom filters (if there are any defined). 
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The Overrides Tab 

 
The Overrides tab controls operation and display of the Override view. 

Adjustment mode. If this selection is set to “Override” any overrides entered will replace the 
corresponding baseline forecasts (or overrides entered on a preceding row). If this switch is set to 
“Incremental” overrides you enter will be added as incremental adjustments to the baseline forecast 
rather than replacing it, and the final forecast will equal the sum of the statistical forecast and all 
overrides entered. If you attempt to change this setting when overrides exist for the current project, you 
will receive a warning and all overrides will be erased. 

Number of adjustment rows. This setting controls the default number of adjustment rows displayed in 
the Override view.  

Allow disaggregation. If this switch is on, the Override window will include a “Disaggregate to” drop-
down box, allowing you to disaggregate (i.e., push down) any overrides made at a group level to lower 
levels of the hierarchy. The disaggregation is based on a proportional allocation. 

Number of live history periods. This setting controls the number of historic periods shown on the 
override grid when the history display option is set to Time Series. Including many historic periods may 
have an impact on performance (speed) when working with large projects. 

Show Forecast History in year-over-year display. If this switch is checked, the override grid will show 
forecast history instead of observed history in the year-over-year display. If it is not checked, the 
override grid will display the observed history from the Historic Data source(s). Note that if no mapping 
history exists, the forecast history is the same as the observed history. 

Time Fence: Number of periods. This option allows you to set the default length for the time fence. This 
setting can be overridden on an item-by-item basis using the \TIMEFENCE= modifier. 
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The Command Line Tab 

 
 

Forecast Pro supports command-line operation allowing you to create forecasts in a “hands-off” mode. 
For a complete description of how to run the product from the command line, consult Command Line 
Operation. 

The Command Line tab allows you to set the options to apply if the current project is run via the 
command line. 

Project Components to Apply: 

Modifiers. This drop-down is used to control which modifiers to use when running from the command 
line. There are four options available: None, Project (default), Data Source and Project and Data Source. 
If None is selected, expert selection will be used for all items. If Project is selected, Forecast Pro will 
apply modifiers as specified in the Project’s Navigator. If Data Source is selected, Forecast Pro will 
consider only modifiers specified in the Data Manager. If Project and Data Source is specified, Forecast 
Pro will apply modifiers specified in the Navigator for items that do not have a modifier in the Data 
Source and apply Data Source modifiers to items included in the Modifiers file in the Data Manager. 
Thus, the Data Source will take precedence over the Project for all modifiers. 

Overrides. This drop-down is used to control which overrides to apply when running from the command 
line. There are four options available: None, Project (default), Data Source and Project and Data Source. 
If None is selected, all overrides in the project and Data Manager override files will be ignored. If Project 
is selected, Forecast Pro will apply any matching overrides/comments in the project to the statistical 
forecasts. If Data Source is selected, Forecast Pro will apply only overrides specified in the Data 
Manager. If Project and Data Source is specified, Forecast Pro will first load overrides from the Project 
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and then from the Data Source. Thus, the Data Source will take precedence over the Project for all 
override cell values.  

Settings. If this option is selected, the command-line run will use all settings associated with the project 
(e.g., all settings in the Settings dialog box, numeric output formatting, etc.). If this option is not 
selected, the default settings (i.e., the settings that have been saved as the defaults for use with new 
projects) will be used when running from the command line. You can change the default settings for 
new projects by pressing the Set as Default button on any tab of the Options. 

Output Files: 

Numeric output. If this option is selected, the command-line run will save the numeric output. You have 
the option of saving this file for all items forecasted or (if you select Hot List only) just for the items listed 
on the Hot List. 

Forecast Report. If this option is selected, the command-line run will save a formatted forecast report 
file to Excel. You have the option of saving this file for all items forecasted or (if you select Hot List only) 
just for the items listed on the Hot List. Keep in mind that these files can potentially be very large, which 
is why the default behavior is to only output items listed in the Hot List. 

Tracking Report. If this option is selected, the command-line run will save a forecast tracking report file 
to Excel. You have the option of saving this file for all items forecasted or (if you select Hot List only) just 
for the items listed on the Hot List. Keep in mind that these files can potentially be very large, which is 
why the default behavior is to only output items listed in the Hot List. 

Item report, Outlier report, and Override report. If any of these options are selected, the command-line 
run will save the specified report(s). The format and contents (including current display vs. all items vs. 
Hot List only) will match the current settings in the project. Note, the contents of the reports can be 
altered using the default scoping (see Performance tab), export tab, or in the context and hamburger 
menus. 

Exception reports. This drop-down is used to select which, if any, exception reports should be saved. The 
format and contents (including current display vs. all items vs. Hot List only) will match the current 
settings in the project. Note, the contents of the reports can be altered using the default scoping (see 
Performance tab), export tab, or in the context and hamburger menus. 

Project. If this option is selected, the command-line run will update and save a new project file. 

Archive forecasts. If this option is selected, the command-line run will update and save the TRAC 
database file. You should select this option if you are archiving forecasts for tracking purposes. 
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The Pareto Tab 

 
The Pareto tab allows you to specify how the ABC codes should be assigned.  

Weighting Basis:  

History and Forecasts. These settings allow you to indicate whether the ranking should be performed 
using the historic demand or the current forecasts. The Period spinner(s) allows you to set the span for 
your selection.  

Hierarchy level. The ABC codes are assigned to a single level of the hierarchy. The Hierarchy level drop-
down allows you to pick the level to use. 

Units. If you have defined conversion factors, this option allows you to select the unit of measure on 
which to base the ABC code assignments. Default refers to the unit of measure used for the historic 
demand data you read into Forecast Pro. 

Ranking Basis:  

Volume (%). This option allows you to set the codes based upon the cumulative volume of each group. 
For example, if A is set to 80%, B is set to 15% and C is set to 5%, Forecast Pro will first rank all of the 
items from highest volume to lowest volume and then sequentially place the top ranked items into the A 
group until their cumulative volume equals or exceeds 80% of the total volume. It will then sequentially 
place items into the B group until the cumulative volume of the A and B items equals or exceeds 95% 
(80% + 15%). The remaining items (5% or less of the cumulative volume) are assigned type C. 

Series Count (#). This option allows you to assign specific numbers of items to each group. For example, 
if you had 1,000 items and you set the A group to 100, the B group to 200 and the C group to 700—the 
100 highest volume items would be assigned to group A, the next highest 200 items would be assigned 
to group B and the remaining 700 would be assigned to group C. 
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Series Count (%). This option allows you to assign a specified percentage of the total number of items 
you have to each group. For example if A is set to 20%, B is set to 50% and C is set to 30%, Forecast Pro 
will first rank all of the items from highest volume to lowest volume and then sequentially place the top 
ranked items into the A group until the number of A group items equals 20% of the total number of 
items. It will then sequentially place items into the B group until the number of B group items equals 
50% of the total number of items. The remaining items (30% of the total number of series) are assigned 
type C. 

Group zero volume. Weighting Basis: If this option is on, any items having zero volume are placed into 
group D. 

Total series. This displays the total number of series in the selected hierarchy level. 

The Performance Tab 

 
The Performance tab allows you to set expert selection options, select manual recalculation modes and 
set project operations. Adjusting these settings can improve processing speed and decrease time 
waiting for project operations and calculations. 

Expert Selection: 

Exclude ARIMA. If this switch is on, Forecast Pro’s expert selection mode will not consider Box-Jenkins 
models. This will speed the forecast generation process considerably. 

Exclude seasonal simplification. If this switch is on, Forecast Pro’s expert selection mode will not 
consider seasonally simplified forms of exponential smoothing models. Since seasonal simplification is 
only considered if the periods per cycle is 13 or greater, excluding seasonal simplification will speed up 
the forecast generation only if you have 13 or more periods per cycle. 
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Exclude NA-constant level. If this switch is on Forecast Pro’s expert selection mode and automatic 
exponential smoothing mode will not consider the NA-constant level model. This will speed the forecast 
generation process considerably. 

Exclude machine learning. If this switch is on, Forecast Pro’s expert selection will not consider machine 
learning. Given that machine learning models are far more computationally intensive than other 
forecasting models, selecting this will speed up the forecast generation process dramatically. Please 
note that when this option is selected, you may still include machine learning in expert selection for 
select items using the \MLES modifier. 

 

Recalculations: 

Manual override mode. If this switch is on, the override window will include a Retain button as well as a 
Commit button. The Retain button is used to apply and save overrides without reconciling the hierarchy. 
This is useful when working with large complex hierarchies where the reconciliation process takes some 
time. In manual reconciliation mode, you would typically enter and retain all of the overrides you wish 
to make (i.e., for multiple items) and then click the Commit button or the Recalculate icon (on the Home 
tab and Operations tabs or optionally on the Quick Access Toolbar) to perform the reconciliation once, 
rather than having to wait for the program to reconcile each time a new item is selected. 

Manual forecast mode. If this option is not selected, Forecast Pro will automatically recalculate the 
forecast and re-reconcile the hierarchy every time you apply a forecast modifier. For large hierarchies, 
this can be time consuming. If you turn this option on, when you specify a forecast modifier, the 
forecasts will not be updated until you click the Recalculate icon (on the Home tab and Operations tabs 
or optionally on the Quick Access Toolbar). This allows you to specify multiple forecast modifiers 
without having to wait for the program to recalculate the forecasts after each specification.  

Operations: 

Load archives with project. If this option is selected, Forecast Pro will cache the forecast archive 
information in memory when you open a project. For very large projects this can take some time. If this 
option is deselected, the forecast archive information will not be cached until the first time you execute 
an action that requires access to the forecast archive (e.g., opening the forecast tracking report or 
opening an exception report which uses the archive). Deselecting this option will speed up opening 
projects and decrease memory usage for individuals who do not need access to the information in the 
forecast archive. 

Periods to retain in archive. This option allows you to limit the number of previous-origin forecasts (i.e., 
forecasts you generated in prior forecasting periods) to save in the forecast archive. Reducing the 
number of archived forecasts will reduce the size of the project’s database and speed up program 
operations. 

Global Reports:  

Default Scoping. When you are working with a very large project, loading reports for all end-items and 
group levels may take considerable time. The Default scoping drop-down allows you to specify if you 
want reports to show hot list items, the item selected on the navigator or all items. Selecting Hot List or 
Selected Item instead of All Items can speed up report loading time considerably. 
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The Advanced Tab 

 
The Advanced tab allows you to set Integer Forecast settings, Date Control features and adjust how 
frequently Forecast Pro checks for program updates.  

Date Controls: 

Display dates generically. If this option is selected. then monthly labels will be displayed using period 
numbers rather than the names of the months. For example, “2019-01” will be used rather than “2019-
Jan”. This option is often used when working with a fiscal calendar where displaying the names of the 
months could be confusing. 

Import date labels. If enabled, Forecast Pro will import date labels from either the helper or historic data 
source (in the header row or column). If using a helper file, create a helper variable called _Date for the 
date labels. Date labels may be either text or numeric. If the labels are numeric and regularly spaced 
(time between adjacent periods is always the same), the labels will be extrapolated into future forecast 
periods. Numeric labels will also be formatted according to the User’s locale settings, as specified in 
Microsoft Windows settings. For ODBC data inputs, date labels must be provided in a helper file. 
Forecast Pro will prioritize labels in a helper file over those provided in the historic data source. These 
imported labels will be used in all views instead of the Forecast Pro’s standard dates. If Import data 
labels is not checked and a helper file includes a helper variable called _Date, Forecast Pro will treat 
_Date like any other helper variable and not use it for date labels. 

Forecast Pro Software Assurance: 

Check for product updates automatically. If this option is selected, Forecast Pro will periodically check 
online for product updates and alert you if they are available. If a newer version is available, clicking OK 
on the pop-up message should generate an email with your current version and the serial number you 
are using. If your support and maintenance contract is up to date, product updates are free.  
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Integer Forecasts: 

Integer Forecasts use a special form of rounding that keeps track of the “remainder” (rounded amount) 
and applies it to the next period’s forecast value. This is particularly useful for low-volume forecasts or 
when there are large minimum order quantities, where traditional rounding can result in biased 
forecasts. 

Consider a flat forecast of 0.4 units per month for the next 12 months. If you were to use the ROUND() 
function to round the forecast to the nearest integer the forecast would become, “0, 0, 0, 0, 0, 0, 0, 0, 0, 
0, 0, 0”. An integer forecast row for the same forecast would be, “0, 1, 0, 1, 0, 0, 1, 0, 1, 0, 0, 1”.  

Default rounding quantity. Specifies the integer rounding quantity (the basis to round to the nearest 
multiple of) for Integer forecasts. 

Rounding method. This drop-down allows you to choose round, round up or round down to the nearest 
multiple of the default rounding quantity. 

Accumulate during history. Selecting this option instructs Forecast Pro to start tracking the remainder 
during the history rather than starting with the first forecast—this is generally desirable.  

Archive. Saves Integer Forecasts to the project’s database. Archived Integer forecasts can be accessed 
through database queries.  

 

Dynamic Regression: 

Auto extend. If this option is selected, Forecast Pro will generate forecasts for explanatory variables that 
do not have input values for the forecast horizon. Forecast Pro will use any provided explanatory 
variable values and only forecast missing values. If this option is not selected, a dynamic regression 
model is selected for a given item and explanatory variable values are not provided for the entire 
forecast horizon, Forecast Pro will use expert selection instead of the specified regression model for that 
item. 

Product Mapping: 

Product Mappings may be assigned in one of two modes: End-items only and All levels. Please see 
Product Mapping Modes for more details. 

End-items only. In End-items only mode, mapped history can only be assigned at an end-item level. The 
mapped history is used to create a forecast history (= mapped history + actual history) at the end-item 
level. Those end-item forecast histories are then aggregated to group levels. That is, the group level 
forecast histories will be the sum of forecast histories across all items that are included in the group. 

All levels. In All levels mode, you may assign mapped history to both end-items and groups, but forecast 
histories will not be aggregated to higher level groups or disaggregated to lower. All groups and items 
must be explicitly assigned mapped histories. 
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The Forecast Pro Views 
The Forecast Report View 
The Forecast Report view is a scrollable text display containing information about the forecasts and how 
they were generated. It provides a convenient way to view information while using Forecast Pro. The 
Forecast Report can be exported, but it can potentially be a very large file. For this reason, you should 
consider using another report designed for exporting (e.g. Numeric Output Report), or only export a 
subset of items in the Forecast Report. 

The Forecast Report is opened and closed with the Forecast Report icon on the Home tab or the 
Reports tab. 

The Forecast Report Settings dialog box allows you to customize the Forecast Report view. This dialog 
box is invoked by selecting Settings on the Forecast Report icon drop-down on the Reports tab, by 
selecting Settings from the Forecast Report view’s context menu, or by selecting Settings on the 
hamburger menu in the upper left corner of the view window. 

 
You can either select one of the four standardized report styles or define a custom report. Include graph 
in output can be used in conjunction with any style report and specifies whether to include or omit a 
graph when saving a Formatted Forecast Report to Excel. The settings for the saved graph may be 
specified in the Graph view, as described below. A description of each report style appears below. 

Forecast Only is a minimal display consisting solely of the forecasts. 

Basic displays a listing of the forecasting model used, a set of the commonly used within-sample 
statistics and a forecast display including confidence limits and summary statistics. 
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Standard is the default display. It includes the expert selection logic (if applicable), the model details 
including model coefficients, a full set of within-sample statistics, a safety stock display, a listing of 
detected/corrected outliers (if outlier detection is active), a listing of any overrides and the same 
forecast display found in the Basic style. 

Complete displays everything found in the Standard display as well as a numeric listing of the historic 
values, fitted values, converted forecasts and an expanded forecast display. 

Custom gives you complete control over what is included in the display. The Historic Data, Forecast 
Data, Within-Sample, Out-of-Sample and Regression tabs on the Forecast Report Settings may be used 
to specify details about the components to include when Custom is selected. Your selections under the 
Custom option are automatically retained for the project allowing you to switch between the Custom 
style and one or more of the standard styles without having to reset your custom settings. 

Important note: The Within-sample and Out-of-sample Stats tabs allow you to set the numeric precision 
for the within-sample and out-of-sample statistics. You also may set precision for regression model 
details on the Regression tab. These precision settings are used for all report styles. 

The Graph Views 
The graph views are used to display variables and forecasts graphically. You can include up to five graph 
views. In addition to providing a convenient way to view the forecasts while using Forecast Pro, a graph 
can also be included in the formatted forecast reports that you save to Excel. The format and content of 
the formatted forecast report’s graph will match the current settings for the Graph 1 view.  

 
The Graph Settings dialog box allows you to customize the Graph view. This dialog box is invoked by 
selecting Settings on the view window’s hamburger menu or by selecting Settings from the Graph view’s 
context menu. 

The Settings dialog box contains three pages or tabs. We will discuss each in turn. 



The Graph Views | 76 
 

 

 
The Layout tab allows you to the select which components to display and format those components as 
you choose. The History, Fitted Values, Forecast and Confidence Limits components are always available 
in the Layout tab, and you can use the Display checkboxes to hide/unhide them from the Graph view. 
You can also use the context menu/hamburger menu to choose what is being displayed in the Graph 
view. When you first start a project, the default graph displays the History and Forecast components. 
The Forecast History line will automatically appear when you define your first Forecast History (see the 
Working with Product Mapping and Mapped History section for more details).  

Other graph components may be added to or removed from the Layout tab using the Add or Remove 
button. Clicking the Add or Remove button brings up the Add or Remove dialog box shown below. The 
checkboxes are used to select which components should be included in the Layout tab. The Filter drop-
down is useful for selecting components by variable type. 
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Clicking OK exits the Add or Remove dialog box and updates the list of components in the Layout tab. 

You can set specific formatting options for each component. 

 
Most of these options are self-explanatory. The Style drop-down provides four options: Scatter, Line, Bar 
or Area. Relative Scaling is only available for Converted Forecasts, Calculated Rows, External Data and 
item specific Explanatory Variables. Selecting Relative Scaling will display that component on its own 
scale. This is useful when graphing multiple components with dramatically different values. The Shared 
option allows you to coordinate color and numeric displays with the Override view. Checking Shared 
applies your Graph Setting selections to the Override grid, providing synchronized views. 
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The Components tab includes three sections. 

The Display section allows you to select the graph type. 

Time series displays a graph that includes both the historic and forecast periods. The All option will 
display the entire data set in a nonscrollable display. If the All option is not selected, the Periods option 
allows you to set how many periods should be included in a scrollable display. 

Year over year displays a graph where the x-axis is one year long and the data for each year are 
“stacked” on the display. The Years option allows you to specify the number of years to include in the 
display. 

The Grid Lines option displays grid lines on the graph. The Ancestry option displays the complete 
ancestry in the variable name (the variable name will appear preceded by any applicable parent group 
names). The Events option marks all historic or forecast points where an event code is being applied. 
The Outliers option marks all historic points where an outlier was detected and/or corrected. 

Selecting Zoom on the Graph context menu or hamburger will activate the scrollable display. You can 
also switch between displaying the Graph view as a Time Series or as Year over Year using the context 
menu and hamburger menu.  

The Labels section allows you to define labels for the X and Y axis and add titles to the graph. The Graph 
title appears within the Graph view, and the Title Bar label allows you to rename Graph 1 to a custom 
name. Include variable name will use the variable name followed by the description as the graph’s 
subtitle. The Clear button erases the current labels within the Graph view (the Title Bar name will 
remain). 

The Y-Axis Scale section controls the scaling for the selected item. Please note that these are item-level 
settings. 

Automatic allows Forecast Pro to select the Y-axis scale. 

Custom lets you set the minimum and maximum for the Y-axis scale. 

Include zero begins the y-axis at zero or at the minimum negative value. If you select Apply to all items, 
the Include zero option will be applied globally to all items.  

The Labels and Y-axis Scale settings are shared by the Year over Year and Time Series graphs. If you 
prefer to use different settings for the different graph types, using multiple graph views or layouts is a 
good way to do so.  
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The Items tab allows you to graph multiple items and/or helper variables on a single graph. Simply select 
the items you want to display and then click the OK or Apply button. 

 Include history and Include forecasts indicate if the graph should include both the historic values and 
forecasts.  

Relative scaling indicates if each graphed item should be displayed on its own scale.  

The Stacked bars and Stacked area options are useful if you want to understand the contribution of the 
graphed items to a total. If you use a stacked option, the height of the graph for a given period is sum of 
the graphed items.  

You may enter a title for the graph in the Title text field.  

The Filter options can be used to limit which items are displayed for selection, to sort the items or to 
specify if ancestry should be included for items displayed for selection. 

The Exit Multi-item button returns the graph view back to the default, single item settings. 

The Override Forecasts View 
The override view is used for several different purposes. It can be used (1) to enter overrides to the 
statistically generated forecasts (or specified baseline forecasts), (2) to display imported data and 
calculated rows and (3) to specify the baseline forecasts. We will examine each of these operations in 
turn. 

Working with overrides 
The override view is used to enter overrides to the statistically generated forecasts. Changes made at 
any level of the forecasting hierarchy will automatically reconcile all levels unless manual override mode 
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has been selected on the Performance tab of the Options dialog box. Refer to Understanding How 
Forecast Overrides are Allocated for a discussion on how the reconciliation is accomplished. 

To open the override view, click the Override icon on the Home tab or the Reports tab on the ribbon 
menu. 

Up to ten override rows can be used, and you can adjust the forecasts using percentages, increments, 
formulas or by typing in new values. You can also enter comments for any cell on the display. 

If you use Excel Collaboration, the Excel Collaboration row also becomes available and can be 
commented and adjusted like the other override rows.  

There is an Overrides tab on the Options dialog box that allows you to control the document-level 
options, including how overrides should be applied (replacement values vs. incremental adjustments) 
and the precision of the display. This tab is fully documented in The Overrides Tab. 

 
There are six rows in the example shown above.  

The top row (currently labeled Statistical) shows the Baseline forecast. By default, the Baseline forecast 
is the Statistical forecast (the statistically based forecasts generated by Forecast Pro) and is labeled as 
such. If the baseline forecast is changed, the row label will reflect that.  

The Inherited Overrides row is only present if your project has changed states (i.e., you have either 
switched units of measure or have rearranged the hierarchy). When you change states, it is often not 
possible to maintain the in-place overrides. For example, an item or group that had an in-place override 
may no longer exist after you change the hierarchy or changing the units results in a different forecast 
allocation across the hierarchy. 

To avoid these problems and to ensure that the final forecasts will remain consistent regardless of the 
hierarchy or units you are viewing, Forecast Pro will move the in-place overrides into the Inherited 
Overrides row prior to performing hierarchy changes and/or conversions.  

Override 1, Override 2 and Override 3 contain any overrides that you have entered for the current 
forecasts. Proposed overrides are displayed in red, committed overrides are displayed in black. The 
Commit button is used to convert proposed overrides to committed overrides. The Formula checkbox 
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allows you to enter overrides as either formulas or “hard numbers” when using the Increment and 
Percent buttons. If the Formula box is checked, using the Percent or Increment buttons will save a 
formula. Formulas may be entered directly into the Override grid rows whether the Formula option is 
selected or not. The override view’s context menu allows you to rename the override row labels and add 
or subtract rows on the fly. 

Forecast contains the current committed forecasts. These are the values that are displayed on the 
graph, and the values that will be written as “forecasts” in any output files that you save. The Forecast 
values may differ from the Statistical values if you have committed to overrides for the currently 
displayed forecasts or any other forecasts in the hierarchy that would impact the currently displayed 
forecasts. 

If there is mapped history for an item (see Working with Product Mapping and Mapped History), 
Forecast Pro will also include a Forecast History row under the Forecast row.  

There are three steps in the override process—selecting the point or points to override, entering the 
override(s) and committing to the override(s). 

Points can be selected in the override window or in the graph window. The sum of the values for the 
points selected will be displayed in the Value edit box. 

If you want to adjust the selected points by a certain percentage, enter the percentage in the Percent 
edit box and click the Percent button. If you want to adjust each selected point by a certain increment, 
enter the increment in the Increment edit box and click the Increment button. If you want to change the 
sum of the selected points to a defined value, enter the value in the Value edit box and click the Value 
button. Adjustments made using the edit boxes will appear in the target override row specified to the 
left of the Commit button. 

You can also enter overrides for a single point by typing a new value into an override row cell or by using 
the right mouse button to drag it to the desired new value on the graph. 

After you have entered the desired overrides and comments, click the Commit button to accept the 
changes and reconcile the hierarchy.  

For large, complex hierarchies the reconciliation can take a little time. To minimize the reconciliation 
time, Forecast Pro supports a manual override mode. When this mode is active, the override window 
will include a Retain button as well as a Commit button. The Retain button is used to accept overrides 
without reconciling the hierarchy. In this mode you would typically enter and retain all of the overrides 
you wish to make (i.e., for multiple items) and then click Commit to perform the reconciliation. The 
control to turn on manual override mode is found on the Performance tab of the Options dialog box. 
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Row types 

 
The override grid lets you view and work with different types of rows. The screenshot above displays the 
Overrides Settings dialog box which lists the currently available rows and lets you customize their 
appearance. Select Settings on the Override view context menu or select Settings on the view’s 
hamburger menu to bring up this dialog box. The current screenshot is taken from the project we 
created in Lesson 3 and includes a range of row types.  

History rows, the Baseline row, Override rows and the Forecast row are all standardized rows which 
always appear in a specific order at the top of the grid. These rows are always displayed on the grid and 
on the Row Format tab of the Override Settings dialog. The Row Format tab on the Override Settings 
dialog is also where you control the formatting. Let’s consider each in turn. 

History rows. If you select Year over Year on the History drop-down, the grid will display the demand 
history, by year, prior to the Baseline row. If Mapped History exists, Forecast Pro will display the 
Forecast History in the Year over Year view, by default. To display actual observed demand history 
instead, uncheck the Show Forecast History in year-over-year display checkbox on the Overrides tab of 
the Options dialog. If you select Time Series, the grid with display both History and Forecast in the 
current Forecast row and relabel it History/Forecast. Forecast History, if it exists, may be displayed in an 
additional row. 

Baseline row. The statistical forecast generated by Forecast Pro is used as the default baseline forecast. 
(Specifying alternative baseline forecasts is discussed later in this section.) Think of the baseline forecast 
as the starting point in establishing the final forecast displayed in the Forecast row. If no overrides are 
made, the final forecast displayed in the Forecast row will equal the Baseline forecast. If you enter 
overrides, the baseline is adjusted accordingly to establish the final forecast. 

Override rows. Operation of the override rows was discussed in detail in the preceding section. 

Forecast row. The Forecast Row displays the current forecast. If Time Series is selected on the History 
drop-down, this row will be labeled History/Forecast. 
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In addition to the standardized row types above, Forecast Pro allows you to add Converted rows, 
External rows and System rows to the grid. To add these rows, click on the Add or Remove button on 
the Row Format tab on the Override Settings dialog box to bring up the dialog box shown below. 

You can use the filter drop-down to select rows by type or display all rows that may be added to the 
grid. 

 
Converted rows. Converted rows display the current forecast in different units of measure. If you read in 
conversion factors in the Data Manager, corresponding converted rows will be available. 

External rows. External rows contain numeric information that you have imported using the Data 
Manager. Common examples of imported external rows are forecasts generated outside of Forecast Pro 
such as sales forecasts, or management forecasts and product information such as current orders or 
available inventory. 

System rows. The System rows include Inherited Overrides, Time Fence, Statistical and Integer forecasts.  

Inherited Overrides are described in detail in the beginning of this section.  

Time Fences are described in the Using a Time Fence section of the Forecast Pro Interface chapter. 

Statistical contains the statistically based forecast generated by Forecast Pro prior to any overrides 
being applied. 

The Integer forecast displays either the final or baseline forecasts using a special form of rounding that 
keeps track of the “remainder” (rounded amount) and applies it to the next period’s forecast value. This 
is particularly useful for low-volume forecasts or when there are large minimum order quantities, where 
traditional rounding can result in biased forecasts.  

Consider a flat forecast of 0.4 units per month for the next 12 months. If you were to use the ROUND() 
function to round the forecast to the nearest integer the forecast would become, “0, 0, 0, 0, 0, 0, 0, 0, 0, 
0, 0, 0”. An integer forecast row for the same forecast would be, “0, 1, 0, 1, 0, 0, 1, 0, 1, 0, 0, 1”. Integer 
forecast settings are defined in the Advanced Control tab of the Options dialog box. Details are 
described in the Menu Items and Dialog Boxes section of this Command Reference chapter. 
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Previous Forecasts. Previous forecasts, a specific type of system row that you can filter on in the Add or 
Remove dialog box, are simply forecasts that were generated in prior forecast cycles (i.e., that you 
created in the past and are stored in the Forecast Pro data base). Previous forecasts are useful for 
tracking how forecasts change from one forecast cycle to the next and measuring forecast accuracy. 
Forecast Pro archives final forecasts, statistical forecasts and baselined forecasts. These archived 
forecasts are named “Previous Forecast #”, “Previous Statistical #” and “Previous Baseline #”, where ‘#’ 
indicates when the forecast was archived. For example, “Previous Forecast 1” displays the final forecasts 
generated one period ago, while “Previous Statistical 2” displays the statistical forecasts generated 2 
months ago. Forecast Pro will display all archived periods available in the database in the Add or 
Remove dialog box. 

Forecasts at Lead Time. Another type of system row, Forecasts at lead time are useful for tracking 
forecast changes and accuracy for specific lead times. A lead time refers to the number of periods ahead 
of the forecast origin (the period when the forecast was established) the forecast was made for. Thus, a 
one-month-ahead forecast would have lead time equals 1, a two-month-ahead forecast would have lead 
time equals 2, etc.  

You can also create Calculated rows and Blank rows in the overrides grid. 

Calculated rows. Calculated rows allow you to enter formulas using other rows, arithmetic operators 
and predefined “tokens” (key words). Calculated rows are inserted into the grid by selecting the 
Forecast row (or any row underneath it), right clicking to invoke the context menu or using the 
Hamburger menu in the top left of the view and selecting Add row.  

Selecting Add row opens a dialog box where you name the calculated row and specify the scope of the 
calculated row. Calculated rows may be Global or Item-specific. A Global calculated row applies the 
same row entries and formulas to all items in the hierarchy or all items in a designated level of the 
hierarchy. The hierarchy level is determined by the item that is selected in the Navigator when the 
Global calculated row is created. You can also define the hierarchy level for a Global calculated row 
when you define row properties. An item-specific calculated row only applies to the selected item. If you 
enter a formula in an item-specific row, that formula will not be shown for any other item. 

Once added, a calculated row can be added or removed from the Row Format tab on the Overrides 
Settings dialog box using the Add or Remove button, as described above. The next section discusses 
how to enter the formulas and details the supported operators and tokens. 

Blank rows. Blank rows can be added to the grid to enhance readability. They are inserted in a similar 
fashion to calculated rows. To insert a blank row, select the Forecast row (or any row underneath it) and 
select Add row on the context menu or hamburger menu. A dialog box will appear allowing you to name 
the row. If you enter a name and click OK, the row will be inserted as a calculated row, but if you erase 
the default name and click OK (i.e., process a blank input field) the row will be inserted as a blank row.  

Defining calculated rows 
You enter formulas by clicking on the cell you wish to modify and typing in the formula. You may enter 
an override cell reference by selecting a cell on the override grid while typing the formula, much like you 
can in Excel. If you wish to edit a previously entered formula, select the cell and press the F2 key. You 
can copy and paste formulas from cell to cell. 

Item-specific calculated rows will be calculated only for the item for which calculations were entered 
and cannot be aggregated or disaggregated. 
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By default, the formulas in a specific Global calculated row will be calculated at the single level of the 
hierarchy on which they were entered. You can change the hierarchy level using the Row Properties tab 
on the Overrides Settings. Any values you elect to display at other levels will be either aggregations or 
disaggregations of the calculated values when calculating at a single level. Depending upon your 
formulas, this may or may not be equivalent to applying the defined formula at the group level. 

If you wish to change the default behavior for a row and calculate the formulas at all levels you can do 
so using the Row Properties tab. Be aware that this option may slow down certain operations, including 
applying overrides. 

Formulas are not case sensitive. Formulas are entered in the format: 

 = expression 

The expression can involve any of the following components. 
 
Numbers 

 
Any real number 

Operations +  -  *  /  ^ 
Parenthesis () 
Comparison operators  =  <  >  <=  >= 
Functions Listed below 
Tokens Listed below 
Rows {RowName} 
Conversion factors {#ConversionFactorName} 

Note that when a row name is used as part of a definition it must appear in braces (curly brackets). 

The conversion factors are a special token that returns the value of the specified conversion factor. The 
token must appear in braces and have the # symbol prior to the conversion factor name. For example, if 
Dollars is a defined conversion factor, then {#Dollars} would be the corresponding token referring to an 
item’s price in dollars. In this example, {Dollars} would refer to the converted final forecast value. 

Token and row references can also include an offset by appending a [-n] to the token or row name. For 
example: 

 
{rowname} 

 
Returns the value of rowname for the current period. 

{rowname}[-1] Returns the value of rowname for the previous period. 
{rowname}[1] Returns the value of rowname for the next period. 

Forecast Pro supports the following functions: 
 
ABS(n) 

 
Returns the absolute value of n 

EXP(n) Returns e raised to the nth  
LOG(n) Returns the natural logarithm of n  
LOG10(n) Returns the base-10 logarithm of n 
SIGN(n) Determines the sign of n. Returns 1 if n is positive, 0 if n is zero and 

-1 if n is negative. 
SQR(n) Returns n squared 
SQRT(n) Returns the square root of n  
IF(condition, value1, 
value2) 

Returns value1 if condition is true or value2 if condition is false 

INT(n) Rounds n down to the nearest integer 
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TRUNC(n) Truncates n to an integer 
EVEN(n) Rounds n up to the nearest even integer 
ODD(n) Rounds n up to the nearest odd integer 
ROUND(n, decimal places) Rounds n to the specified number of decimal places 
MROUND(n, basis) Rounds n to the nearest multiple of basis 
ROUNDUP(n, decimal 
places) 

Rounds n up to the specified number of decimal places 

ROUNDDOWN(n, decimal 
places) 

Rounds n down to the specified number of decimal places 

MIN(x, y, …) Returns the smallest value in the specified set of values 
MAX(x, y, …) Returns the largest value in the specified set of values 
AVERAGE(x, y, …) Returns the average of the specified set of values 
STDEV(x, y, …) Returns the standard deviation of the specified set of values 
SUM(x, y, …) Returns the sum of the specified set of values 
MEDIAN(x, y, …) Returns the median of the specified set of values 
MODE(n) Returns the mode (most frequently occurring value) of the specified 

set of values 
NVL(n, alternative) Null value function. If n is blank returns alternative. If n is not blank 

returns n. 
ISNUMBER(n) Returns 1 if n is a number, 0 if n is blank. 
ISNULL(n) Returns 1 if is blank, 0 if n is a number. 
  

If you use Excel, you may be familiar with these functions. Forecast Pro implements these functions in 
the same way as Excel with one exception—cell ranges are not yet supported. For example, the 
following formula will return the sum of the statistical forecast for last period, this period and next 
period: 
 
    =SUM(STAT[-1],STAT,STAT[1]) 
 
The following, however, is not supported: =SUM(STAT[-1]:STAT[1]) 

Forecast Pro supports the following tokens: 
 
FORECAST 

 
Forecast row 

PFC# Forecast from ‘#’ periods prior 
PST# Statistical forecast from ‘#’ periods prior 
PBL# Baseline forecast from ‘#’ periods prior 
FCLT# Forecast at lead time ‘#’ 
STLT# Statistical forecast at lead time ‘#’ 
BLLT# Baseline forecast at lead time ‘#’ 
YTD Returns the calendar year-to-date using the history and forecast 

values as applicable. 
QTD Returns the calendar quarter-to-date using the history and forecast 

values as applicable. 
STAT Statistical forecast row 
BASE Baseline forecast row 
INTFC Integer Forecast. Only available if the Integer Forecast is added to 

the grid in the Override Settings dialog. 
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INTSTATFC Integer Statistical Forecast. Only available if the Integer Forecast is 
added to the grid in the Override Settings dialog. 

OVR1 The first override row 
OVR# Override row “#” 
HIST1 The most recent historic row 
HIST# The historic row “#” years prior 
HISTBL[-n] Returns either the history value or the baseline forecast value at -n. 

Intended for use in formulas where it may point to either a forecast 
or a historic period. 

HISTFC[-n] Returns either the history value or the forecast value at -n. 
Intended for use in formulas where it may point to either a forecast 
or a historic period. 

HISTST[-n] Returns either the history value or the statistical forecast value at -
n. Intended for use in formulas where it may point to either a 
forecast or a historic period. 

INHER Inherited override row. 
LOWER Lower confidence limit  
UPPER Upper confidence limit 
LEADTIME The item’s specified lead time 
SAFETY The safety stock at the item’s specified lead time 
SAFETY_ALL The safety stock corresponding to the lead time of the current cell 
DDLT The demand during the item’s specified lead time 
DDLT_ALL The demand corresponding to the lead time of the current cell 
REORDER The reorder point at the item’s specified lead time 
REORDER_ALL The reorder point corresponding to the lead time of the current cell 
MEAN The mean of the historic data 
SDEV The standard deviation of the historic data 
MAD The within-sample mean absolute deviation 
MAPE The within-sample mean average percent error 
SMAPE The within-sample symmetric mean average percent error 
BIC The Bayesian Information Criterion 
{#Conversion} Returns the conversion factor for “Conversion”. 

Important notes: 

1. All functions require that the referenced system row is added to the override grid, though it 
does not necessarily need to be displayed. For example, the integer system row needs to be in 
the grid for INTFC to return a value. Referenced system rows can be added using the Add or 
Remove button in override settings. You can uncheck the Display checkbox in the Overrides 
Settings meaning the row will not be displayed in the Override grid, but it’s values will be read 
into memory so it can be referenced in a calculated row. 

2. Tokens that reference baseline or final forecasts are only available in calculated rows. 
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Formatting rows 

 
The Row Format tab on the Overrides Settings dialog box allows you to control the order in which the 
rows appear and how they are formatted. Most of the options are self-explanatory, however, we will 
comment on a few of them. 

Only items that have Display checked will be shown on the grid. The core grid rows (Baseline, Overrides, 
Time Fence and Forecast) are always displayed and do not have checkboxes. If you want to add 
something to the grid and it is not shown on the Row Format tab, add it by using the Add or Remove 
button, as described above. 

Checking Shared applies your Override settings for that row to the Graph view, allowing for 
synchronized views. 

To change the order of the rows, you select a row you wish to move by clicking on its name and then use 
the Move Up and Move Down buttons to reposition it. 

Clicking the Apply button will immediately apply any changes you have made to the Override View 
without leaving the Overrides Settings dialog box. This is very useful when formatting the display. 
Clicking the OK button will apply any changes you have made, and close the settings dialog box. 

The Format option allows you to display the row’s values formatted as a number, a percentage, or a 
currency. If you select Currency, Forecast Pro will default to the currency symbol associated with your 
operating system’s language selection. If you wish to use an alternative symbol, the Currency Symbol 
drop-down can be used to select it. Forecast Pro supports a wide variety of currency symbols, however, 
if the symbol you’d like to use is not supported; please send an enhancement request to 
support@forecastpro.com.  
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Defining row properties 

 
The Row Properties tab on the Overrides Settings dialog box allows you to control how certain grid 
values are calculated and displayed. 

The Hier. level column displays the level at which the data are defined. For Converted rows this will 
always be the lowest level since the conversion factors can only be defined at the lowest level. For 
External rows, this column displays the level at which the data were imported. For Global Calculated 
rows, this column is a drop-down which allows to specify the level to calculate the formulas or to specify 
that the formulas should be calculated independently (as opposed to using aggregation/disaggregation) 
at all levels. For Item-specific Calculated rows, the drop-down will show All and cannot be changed, 
since entries for item-specific calculated rows may be entered for any item in the hierarchy. 

The Forecast row column allows you to indicate whether the row should be treated as a forecast row. 
This is important, since only forecast rows can be assigned as baseline forecasts. 

The Convert column allows you to indicate whether the row should convert to different units when you 
change the Units displayed in Forecast Pro. 

The Aggregate column allows you to indicate whether External rows and Calculated rows should display 
aggregated group totals for levels above the Hier. Level. 

The Disaggregate column allows you to indicate whether External rows and Calculated rows should 
display disaggregated values for levels below the Hier. Level.  

The Archive column is used to indicate whether the row should be archived in the Forecast Pro database 
for every forecast origin. This is only recommended if you have a specific need for this information to be 
stored within your Forecast Pro project. 

The Pin to column is used to control where a formula will appear after you update your historic data and 
generate a new forecast from a different forecast origin. If you select Date the formula will be tied to 
the specific date for which it was originally entered. If you select Column the formula will be tied to the 
column position for which it was originally entered and it’s position will not change when the historic 
data is updated.  
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For example, suppose you originally generate a 12-month forecast and the first forecast period is July 
2021, so the grid displays 12 columns for the forecasts covering the span of July 2021 through June 
2022. You create a calculated row and enter a formula in the 12th column (which corresponds to June 
2022). Next month, you update your historic demand, re-forecast the project and the grid now displays 
12 new forecasts covering the span from August 2021 through July 2021. Where does the formula you 
entered last month appear in the updated override grid? If you selected Pin to Date, the formula 
appears in the 11th column of the display (which now corresponds to June 2022) and the 12th column 
(which now corresponds to July 2022) will be blank. If you selected Pin to Column, the formula appears 
in the 12th column of the display (which now corresponds to July 2022).  

Specifying the baseline forecast 
By default, Forecast Pro generates a statistical forecast and then allows you to add overrides to this 
“baseline” forecast to create the final forecast. There may be times where you wish to use an alternative 
forecast generated outside of Forecast Pro as the baseline forecast rather than the statistical forecast 
generated by Forecast Pro. 

You can set the baseline forecast to use at the end-item level (i.e., the lowest-level on the Navigator) on 
an item-by-item basis. The baseline forecasts displayed at group levels are always aggregations of the 
end-item values. If all of the end-items for a given group are using the statistical forecast as the baseline 
(the default), the group label for the baseline row will read “Statistical.” If any end-items for a given 
group are set to a baseline other than the statistical forecast the group label for the baseline row will 
read “Baseline.” If all of the end-items for a given group have the same alternate baseline applied, then 
the group label for the baseline row will match the baseline assignment. 

You can specify the baseline for an individual end-item using the override grid’s context menu. Select 
the forecast row you’d like to use by clicking the row label, invoke the context menu by right clicking the 
mouse and select Set as Baseline. 

 
You can use the Baseline Forecasts tab of the Overrides Settings dialog box to specify baseline forecasts 
for groups of end-items. 
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The baseline selection drop-down box (selected as Default in the above image) allows you to define the 
baseline from any available system rows or any row that has the Forecast Row checkbox selected in the 
Row Properties tab. Below this dropdown is a list of all end items with a check mark to indicate whether 
the baseline matches the current baseline selected. You use the checkboxes and the Apply button to 
assign the baselines. 

The Filter field can also be used to winnow down the displayed list of items. Combining filtering with the 
use of the Select All button provides an efficient mechanism for assigning the baselines when working 
with large numbers of end-items. 

The Missing baseline setting controls what is displayed if the assigned baseline is partially missing (i.e., 
the assigned baseline contains values for some but not all of the forecast periods for a given item) or 
fully missing (i.e., the assigned baseline does not contain any values for a given item). In the latter case, 
Forecast Pro will display a warning message when you process the request. 

The Default source drop-down (on the bottom right of the dialog box) allows you to specify the forecast 
to use as a baseline if no alternative baseline has been specified. Most users will want to leave this 
selection set to Statistical. 

The Diagnostics View 
The diagnostics view provides a variety of statistical displays to assist you in building and diagnosing 
custom models. To open the diagnostics view, click the Diagnostics icon in the Data Tools group on the 
Forecasting tab or select Diagnostics from the drop-down on the Graph icon on the Home tab or 
Reports tab. 

 
The default view is the Fitted Errors graph. Use this display to identify outliers or other problem areas of 
your data. The dashed horizontal lines mark the 2.5 and 97.5 percentiles. About one error in twenty 
extends beyond these limits.  



The Tracking Report and Tracking Report Graph Views | 92 
 

 

You can right click on the Fitted Errors graph to bring up the Advanced Diagnostics context menu or use 
the hamburger menu in the top left of the view and select one of the other available diagnostic graphs. 

Error ACF displays a graph of the error autocorrelation function. Use the error ACF to make quick 
assessments of correlational models like Box-Jenkins and dynamic regression. If your statistical model is 
well specified, then about one autocorrelation in twenty falls outside the limits marked by dashed lines, 
and the autocorrelations are not patterned. The computation of the error autocorrelation function is 
covered in the Forecast Pro Statistical Reference Manual. 

ACF and PACF are provided to help you manually identify ARIMA models. The autocorrelation function 
(ACF) is used to identify differencing, and to identify the number of simple and seasonal MA terms. To 
identify differencing, select Advanced Diagnostics Settings on the context menu.  

 
Use the Automatic button to display the differencing values selected by Forecast Pro’s automatic Box-
Jenkins algorithm. Use the partial autocorrelation functions (PACF) to identify the number of simple and 
seasonal AR terms. Refer to the Forecast Pro Statistical Reference Manual for further information about 
manual identification of ARIMA models. The ACF and PACF may also be helpful for manually identifying 
the dynamic terms in a dynamic regression model. 

Cumulative displays a cumulative graph of the currently selected item. This is especially useful when 
examining a Bass Diffusion model. 

The Tracking Report and Tracking Report Graph 
Views 
The Tracking Report and its associated Tracking Report Graph view allow you to compare previously 
generated forecasts with what actually happened. To view the Tracking Report, your Forecast Pro 
database must contain archived forecasts. 

To open the Tracking Report, click the Forecast Tracking icon on the Home tab or the Reports tab.  
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Due to its cascading-like appearance, the tracking report is sometimes referred to as a waterfall report. 
The report compares what we forecasted to what actually happened. Therefore, it is based on two key 
elements—the actual demand history and archived forecasts for the periods being analyzed. 

In the example above, the actual demand history for the most current six months is shown in the first 
row with the green shading.  

The next row down, Component Weight, displays the percentage that the demand represents of its 
parent group. In our example, in January 2020 Total>Cakes>Food-King composed 38.81 percent of the 
demand for its parent group, Total> Cakes. This row is only displayed if Include component weights is 
selected in the Layout section of the Tracking Report Settings, as described shortly. 

The next 6 rows display the forecasts generated for these periods from different forecast origins. The 
row labeled 2019-Dec displays the forecast when the forecast origin was December 2019, and the first 
forecast period was January 2020. The row labeled 2020-May displays the forecast generated the prior 
month when the forecast origin was May 2020, and the first forecast period was June 2020. 

The waterfall report allows you to color code lead times. A lead time refers to the number of periods 
ahead of the forecast origin the forecast was made for. Thus, a one-month-ahead forecast would have 
lead time equals 1, a two-month-ahead forecast would have lead time equals 2, etc.  

In our example, the forecasts for lead time equals 1 are all shaded in blue, the forecasts for lead time 
equals 3 are all shaded in magenta, the forecasts for lead time equals 6 are all shaded in yellow. The 
color coding is used on both the tracking report and the tracking report graph. You can control the lead 
times to color code using the Tracking Report Settings dialog box. 

The bottom portion of the report displays cumulative statistics for different lead times.  

The cumulative statistics for different lead times portion of the report can include up to three sections—
Series Analysis, End-item Analysis and Component Analysis. End-item Analysis and Component Analysis 
are only relevant to group-level data and are not displayed if an end-item is selected. By default, only 
Series Analysis is shown. Use the Tracking Report settings to turn on End-item and/or Component 
Analysis. 
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Series Analysis displays statistics for the currently selected time series. If the selection is a group, the 
statistics are based on the archived group-level forecasts. The CMAPE statistic found in this section is the 
Component MAPE. This is a weighted MAPE where the weighting factors are the component weights 
(see discussion above).  

End-item Analysis displays statistics based on the archived forecasts for all end-items belonging to the 
currently selected group. The WMAPE statistic found in this section is a weighted MAPE where the 
weighting factors reflect the end item’s volume. The weights are calculated by dividing each end item’s 
volume by the group’s volume. 

Component Analysis displays statistics based on the archived forecasts for all component children (i.e., 
groups and/or end items one level lower in the hierarchy that are components of the currently selected 
group). The WMAPE statistic found in this section is a weighted MAPE where the weighting factors 
reflect the component children’s volume. The weights are calculated by dividing each component child’s 
volume by the group’s volume. 

The content and format of the Tracking Report is controlled using the Tracking Report Settings dialog 
box. This dialog box is invoked by selecting Settings on the Forecast Tracking icon drop-down on the 
Home tab or Report tab, by selecting Tracking Report Settings from the Tracking Report view’s context 
menu or by selecting Settings on the view’s hamburger menu. 

 
The Forecasts dropdown allows you to display either the statistical or adjusted forecasts.  

The Report type section allows you to display the forecasts, the forecast error or the percent forecast 
error. 

The Analysis Mode section allows you to specify which cumulative lead time statistic displays to include. 

Most of the items in the Layout section are self-explanatory, however, we will comment on a couple of 
them. “Periods to display” controls the number of lead times to include in the report. The “Include 
preceding forecasts” option displays all archived forecasts that go into the cumulative statistics rather 
than just the subset in the triangular display. 

The Lead time(s) box allows you to specify up to four lead times to color code. The selected lead times 
are used on both the numeric and graphical displays. 
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You can open the Tracking Report Graph by selecting Graph on the Forecast Tracking icon drop-down on 
the Home tab or Reports tab. 

 
For each historic period, the graph displays the actual historic value and the archived forecasts for the 
lead times selected in the Tracking Report Settings dialog box. 

The Forecast Value Add (FVA) Report View 
The Forecast Value Add (FVA) view is designed to show the accuracy and value-add of each step in your 
forecasting process for the prior forecasting period. The FVA will not be available until you have 
established archived forecasts (usually by going through at least one forecasting cycle). 

The first step in your process is generating your baseline forecast. Typically, the baseline forecast is the 
statistical forecast. This baseline forecast may then be updated with overrides. The FVA report shows if 
those overrides were more or less accurate than the baseline forecast. It also shows if the net impact of 
those overrides, as reflected in the final forecast, was positive or negative. If your final forecast was 
more accurate than the baseline forecast, your process added value. If not, you may want to understand 
how to adjust your process so that it is improving baseline forecasts instead of making the forecast less 
accurate. 

To open the FVA report, click the FVA Report icon on the Reports tab. This is an item-specific view. The 
FVA Report has a global equivalent (FVA Global Report in the Exception Reports section of the Reports 
tab), but the following information refers to the item-specific view. 
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The selected item (Total>Muffins>Food-King>APP-12-11 in this case) is shown beneath the report, along 
with the comparison date and the lead time you want to review. 

The Value column shows the observed historical value for the Actual row and forecasted values for all 
other rows. The Forecast Error column shows the absolute error, either as a unit deviation or a 
percentage, for each process step. The remaining columns show the relative impact on forecast 
accuracy of each process step throughout the forecasting process. 

In the example above, the statistical forecast had a forecast error of 47% while the Demand Planning 
override of 3,251 had a forecast error of 20%. The Demand Planning override was 27% (=47%-20%) 
more accurate than the statistical. That is, the Demand Planning override added value. The 
Management override had a forecast error of only 2%, adding 45% (=47% - 2%) of value relative to the 
statistical forecast and 18% (=20% - 2%) relative to the Demand Planning forecast. In this example, each 
step of the forecasting process added value. 

The FVA report can be customized by selecting Settings on the hamburger or context menu. 
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The leftmost column of the display lists the available process steps. Note that the Naïve forecast is the 
previous periods actual (same as last period). You may display which process steps you want to include 
as rows in the FVA report and which process steps you want to compare against in columns. Checking 
the Statistical columns checkbox tells Forecast Pro to include a “FVA versus Statistical” column. 

The Error radio button allows you to select unit or percent forecast errors. The default display is Percent, 
but you may want to use unit errors for low volume items. 

The Lead time spinner specifies the forecast lead time. In the example above, we had a lead time of 1 
and a June 2020 comparison period. The FVA report uses the June 2020 forecasts that were generated 
with data through May 2020 when June was “one step ahead.”  If we changed the lead time to 3, the 
FVA report would show the June 2020 forecasts generated with data through March 2020, when June 
was “three steps ahead.” 

Unchecking the Show values checkbox removes the Value column from the display. 

One of the goals of FVA analysis is to understand which items and process steps are improving forecast 
accuracy and which are decreasing accuracy. The FVA Global exception report allows you to view FVA 
statistics and filter across all items so that you can easily identify which items add value (improve 
accuracy) and which do not. 

The Exception Report Views 
The Exception Report views enable you to quickly find cases where your forecast error or some other 
performance metric has fallen outside of an acceptable range. Exception reporting reduces the need for 
manual review of your forecasts and allows you to focus on the items where human attention is most 
needed. 

Forecast Pro provides a wide array of exception reports, some of which monitor the current forecasts 
and others which monitor your archived forecasts. The available Exception Report views are shown on 
the Reports tab. 
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Overview 

 
All exception reports are displayed in a format similar to the example shown above. A row is included for 
every item in the hierarchy. The items can be filtered to show only items that need further examination, 
as described below. Select Filters on the hamburger menu in the upper left-hand corner of the view or 
on the view’s context menu to activate the filtering capability. 

The initial columns identify the item. This is followed by a Date column identifying the exception period. 
The next two columns display the value being monitored and what it is being monitored against. This is 
followed by a Deviation column showing the difference and the %Deviation column showing the 
difference as a percent. 

Double-clicking an item on an exception report will cause the Navigator to jump directly to that item. 
Thus, you can use the exception report as the equivalent of a Hot List to navigate through the listed 
items. All of the global report views support this kind of navigation.  

Right clicking on the Exception Report view brings up the Exception Report context menu, or 
alternatively you can use the Hamburger menu in the top left corner of the view. 
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Hover over Display and you can select All Items, Hot List or Selected Item to quickly adjust which items 
should be included in the report. You can also remove Discontinued items from the report. 

Exception reports are best used in conjunction with Filters and Layouts. Please refer to the Exception 
Reporting lesson in Forecast Pro TRAC Tutorials or the View Window section in this manual for an 
overview of how to use Filters and Layouts with Exception reports. 

The content and format of the Exception Report is controlled using the Exception Report Settings dialog 
box. This dialog box is invoked by selecting Settings on the hamburger menu or from the Exception 
Report view’s context menu. You may also use the Settings drop-down icon on the Reports tab for one 
of the six exception reports to open settings for the selected exceptions report.
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Forecast vs. History 
Click on the Forecast vs. History icon on the Reports tab to open the Forecast vs. History report. The 
Forecast vs. History report compares forecast values to prior historical values.  

 
The Comparison section at the top of the dialog box is where you define the type of Forecast(s) you 
want to use (Baseline, Forecast, Statistical) and the number of periods prior you want to compare to. By 
default, the report shows the current forecast versus the same period last year for all periods in the 
forecast horizon. Unchecking the “Current forecast vs. same period last year” checkbox allows you to 
customize the comparison periods. 

The Forecast periods to consider section allows you to set the number of forecast periods to monitor 
and to specify if you want to look at each individual period or at the cumulative total across the specified 
forecast periods. The default setting (“Cumulative” is not checked) monitors all forecast periods 
individually.  

The Include section allows you to specify which statistics you want to show in the report. By default, the 
report shows Deviation and % Deviation. If you have included filters in the project (see Custom Filter 
Fields in Setting Up Your Optional Data), you may add those to the report using the Filter drop-down. 
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Forecasts vs. Archive 
Click on the Forecast vs. Archive icon on the Reports tab to open the Forecast vs. Archive report. The 
Forecasts vs. Archive report compares the current forecast to previously generated forecasts.  

 
The above report compares the current forecast against the forecast we made last month (Previous 
Forecast 1). In the Comparison section, the left drop-down allows you to select which of the current 
forecasts to consider (Forecast, Baseline or Statistical) and the right drop-down allows you to select 
which previous forecast(s) you want to compare to. Note that you may choose multiple previous 
forecasts for comparison. 

The Forecast periods to consider section allows you to set the number of forecast periods to monitor 
and to specify if you want to look at each individual period or at the cumulative total across the specified 
forecast periods. The default setting (cumulative is not checked) monitors all forecast periods 
individually.  

The Include section allows you to specify which statistics you want to show in the report. By default, the 
report shows Deviation and Percent deviation. If you have included filters in the project (see Custom 
Filter Fields in Setting Up Your Optional Data), you may add those to the report using the Filter drop-
down. 
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Forecast Accuracy 
Click on the Forecast Accuracy icon on the Reports tab to open the Forecast Accuracy report. The 
Forecast Accuracy report looks at previously generated forecasts vs. what actually happened.  

 
The Comparison section at the top of the dialog box is where you define the type of Forecast(s) you 
want to use (Baseline, Forecast, Statistical) and the lead time you want to compare to. A lead time refers 
to the number of periods ahead of the forecast origin (the period when the forecast is generated) the 
forecast was made for. Thus, a one-month-ahead forecast would have lead time equals 1, a two-month-
ahead forecast would have lead time equals 2, etc. By default, the report compares the forecast we 
made last period (Forecast(L1)) to what actually happened for the current month only. 
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Custom 
Click on the Custom icon on the Reports tab to open the Custom report. The Custom report compares 
the current forecast or history to any row(s) available in the override grid. 

 
The report shown above (taken from the project Lesson 10) compares the current forecast to the Sales 
Forecast (an external row). The comparison drop-down menus allow you to select if you want to 
compare history or a forecast (forecast, baseline or statistical) and the comparison series. 

The Periods to consider section allows you to select how many time periods to monitor). Select User-
defined to activate the spinners below the date range. Use the spinners to select the starting and ending 
historic periods. Selecting “1” or “0” will select the most recent historic period, “-1” will select the 
previous historic period and so on. As you change the spinners, the date above will update to reflect the 
actual starting and ending periods selected. Check Cumulative if you want to look at the total across the 
specified historical periods.  

The Include section allows you to specify which statistics you want to show in the report. By default, the 
report shows Deviation and Percent deviation. If you have included filters in the project (see Custom 
Filter Fields in Setting Up Your Optional Data r), you may add those to the report using the Filter drop-
down. 
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Waterfall 
Click on the Waterfall icon on the Reports tab to open the Waterfall report. 

The Waterfall report provides a complete summary of forecast accuracy across a specified lead time. It 
doesn’t compare items and calculate deviations like the other exception reports. It simply allows you to 
list statistics from the waterfall reports in a global report that can be sorted and filtered to aid in your 
review process.  

 
The Display section is used to define what to show in the report. The top drop-down (currently showing 
Forecast) is used to select which forecasts (Forecast, Baseline and/or Statistical) to include in the report. 
The drop-down below that is used to select which statistics (Avg. Error, Avg. Forecast and Avg. Perc. 
Error) to include as additional columns in the report. The Lead time spinner is used to select the lead 
time for the report. The bottom drop-down in the Display section lets you choose the analysis type 
(Series, End Item-level or Component). Please see The Tracking Report and Tracking Report Graph Views 
in this chapter for more details on lead times and analysis types. 

The Include section allows you to specify additional columns to show in the report. If you have included 
filters in the project (see Custom Filter Fields in Setting Up Your Optional Data), you may add those to 
the report using the Filter drop-down. 

FVA Global 
Forecast Value Add (FVA) reports display the accuracy and value-add of each step in your forecasting 
process for the prior forecasting period. For each process step, you can compare the forecast accuracy 
to the forecast accuracy for an earlier stage or step in your forecasting process. For example, you can 
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compare the accuracy of an override made in the review stage to the baseline forecast accuracy. Please 
see The Forecast Value Add (FVA) View for more details on FVA analysis. 

Click on the FVA Global icon on the Reports tab to open the FVA Global report. Select Settings from the 
hamburger or context menu to customize your view. 

 

 
The Comparison section is used to define what to show in the report. If the checkbox Last period’s 
forecast versus statistical is checked, the report will include only the final forecast compared to the 
statistical forecast. This is checked by default. If checked, the Lead Time spinner, Process Steps and 
Versus drop-downs are not available. 

Process Steps: Use this drop-down to select which process steps you want to include as rows in your 
report. 

Versus: Use this drop-down to select which process steps/forecasts you want to include as comparison 
columns. For example, you would select Statistical to include a “FVA vs. Statistical” column.  

Lead time. Use this spinner to select which lead time you want to use. A lead time refers to the number 
of periods ahead of the forecast origin (the period when the forecast is generated) the forecast was 
made for. Thus, a one-month-ahead forecast would have lead time equals 1, a two-month-ahead 
forecast would have lead time equals 2, etc.  

Units/Percent: Use this radio button to specify how you want to measure Forecast Error. 

Include:  

Description: If selected, include the item description read in from the historic data. 

Pareto statistics: If selected, include all Pareto statistic columns. 
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Select filter attributes to display: If you have included filters in the project (see Custom Filter Fields in the 
Setting Up Your Optional Data section of this chapter), you may add those to the report using the Filter 
drop-down. 

 

 

The Override Report View 
The Override Report view lists items where overrides and/or comments have been made. The display is 
useful when reviewing the current overrides and when loading archived override sets. 

To open the Override Report view, click the Override Report icon on the Reports tab.  

If you double-click an item on the Override Report the Navigator will jump directly to that item, so you 
can use the Override Report as the equivalent of a Hot List to navigate through the listed items. All 
global report views support this kind of navigation.  

The content and format of the report is controlled using the Override Report Settings dialog box. This 
dialog box is invoked by selecting Settings on the Override Report icon drop-down, or by selecting 
Settings on the view’s hamburger menu or context menu.  

 
The Display section allows you to control the override sets that will be displayed, to include columns for 
the Pareto output and to include columns for custom filters (if there are any defined). 

In-place only restricts the display to the current in-place override set only. Thus, override sets made in 
previous states (e.g., in other units and/or hierarchies) will be omitted, as will override sets made for 
other origins (e.g., previous forecast periods) and override sets associated with other linked projects. 

Current origin displays all override sets for the current origin (forecast period). Thus, override sets made 
in other states (e.g., in other units and/or hierarchies) will be included, but override sets associated with 
different forecast origins (e.g., previous forecast periods) will be omitted. 
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Last origin & current origin displays all override sets for the current and immediately previous origin 
(forecast period). This is often a useful display to view when you have updated the statistical forecasts 
and are loading override sets from the last forecast period via the Archived Overrides icon on the 
Imports tab. 

Custom provides complete control over the override sets displayed. Once Custom is selected, the 
Components section of the dialog box is activated. Compatible series restricts the display to override sets 
where the state (i.e., units of measure and hierarchy) match the current state. Headers only displays the 
one-line header for each override set, omitting the item-level override information. The Forecast origin 
option allows you to specify the range of origins to display. Once you check Forecast origin, you may use 
the spinners to set the date range. 

The Outlier Report View 
The outlier report lists items where outliers have been detected and/or corrected. To open the outlier 
report view, click the Outliers icon on the Reports tab or in the Tools group on the Forecasting tab.  

The content and format of the report is controlled using the outlier report’s context menu or hamburger 
menu. The context menu also allows you to print the currently displayed report and save it to Excel. 

The Outliers tab of the Options dialog box includes an Include iteration statistics in reports option. If this 
option is active the outlier report will include detailed statistics describing the outlier detection. The 
Outlier Options are accessible by clicking Settings on the Outlier Report icon drop-down on the Reports 
tab and Forecasting tab, or on the view’s context menu or hamburger menu. Consult Outliers in 
Customizing Your Forecasts for more details. The Forecast Pro Statistical Reference Manual also provides 
additional details on Forecast Pro’s outlier detection methodology. 

 

The Numeric Output View 
The Numeric Output view displays the contents and format of the currently specified Numeric Output 
file. When designing the Numeric Output file, it is useful (though not necessary) to have the Numeric 
Output view open. To open the Numeric Output Report, click the Numeric Output icon on the Reports 
tab or select Show from the Numeric Output icon drop-down on the Home tab. 

The Numeric Output Settings dialog box is used to specify the format and content of the Numeric 
Output Report and file. To open the Numeric Output Settings dialog box, select Settings from the drop-
down on the Numeric Output icon on the Home tab or the Reports tab. You may also select Settings on 
the view’s hamburger menu or the view’s context menu to open the Numeric Output Settings dialog 
box. 

The Numeric Output Settings dialog box contains both a Set as Default button and an OK button. 
Clicking the OK button will save your current settings for use with the current project and close the 
dialog box. Clicking the Apply button will also save your current settings for use with the current project, 
but the dialog box will remain open so you can continue changing the settings. Clicking the Set as 
Default button will save your current settings as the default settings for all new projects.  

The Numeric Output Settings dialog box contains three pages or tabs. We will discuss each tab in turn. 
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The Output Format tab is used to specify the basic layout for the Numeric Output file. 

The Output Section 

Forecast file prefix. Specify the character(s) to use as the default prefix when naming the Numeric 
Output file. If the Single Output file option is selected in the Layout section, the default Numeric 
Output filename will be the prefix followed by the project name followed by “Numeric Output”. If 
the Single Output file option is not selected, each output filename will be the prefix followed by the 
corresponding input filename. 

Default units only. If this option is selected, the Numeric Output file will save the forecasts and other 
components using the default units (i.e., the units defined in the input data source). If this option is 
not selected, the Numeric Output file save the forecasts and other components using the units of 
measure currently selected in Forecast Pro. The current units being displayed are listed in the Status 
bar in the lower right. 

Default hierarchy only. If this option is selected, the Numeric Output file will save the forecasts and 
other components using the default hierarchy (i.e., the hierarchy defined in the input data source). If 
this option is not selected, the Numeric Output file will save the forecasts and other components 
using the hierarchy currently selected in Forecast Pro. The current hierarchy order being used is 
listed in the Status bar in the lower right. 

Include items without forecasts. If this option is selected, the Numeric Output file will include entries 
for any discontinued items that appear on the Navigator. 

Include row totals. If this option is selected, the Numeric Output file with include a column on the far 
right of the report, called Total, that contains the totals for all entries in each row.  

 Include column totals. If this option is selected, the Numeric Output file with include a row on the 
bottom of the report, called Total, that contains the totals for all entries in each numeric column. 

Include yearly totals. If this option is selected, the Numeric Output file with include columns that 
contains the totals for each year. Each year column will be inserted to the right of the last period in 
each year. 
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If you have included filters in the project (see Custom Filter Fields in the Setting Up Your Optional 
Data), you may add those to the Numeric Output using the Select filter fields to display drop-down. 

The Layout Section 

The Layout section of this tab allows you to specify the default data mode, the orientation (row vs. 
column), the option to include group level output and the option to include item-level data.  

Single output file. If Single output file is selected, a single Numeric Output file containing information 
for all forecasted items will be written. If Single output file is not selected, then a separate Numeric 
Output file will be written for each input file. 

Break record up into lines. If selected, each Numeric Output component specified on the Time Series 
Data tab (see below) will appear on a separate line of the Numeric Output file. 

Transactions. If selected, the data will be output using a transaction style layout (see Transactions 
Format). Transactional reports can only include time series data. 

The Text Format section of this tab allows you to specify the conventions to use when outputting a text 
file. You will only be able to edit these settings when the data mode is set to Txt (text) or Mlt (text input 
file format). 

The Pareto section allows you to include the Pareto codes and associated Pareto statistics in the 
Numeric Output view and output. 

 
The Time Series Data tab is used to define the data label fields, to select the forecast components to 
include and to set their precision.  

The Data Labels Section lets you specify what information you want to include for each item in the 
report. 

Attributes. Include separate attribute fields for each level of the hierarchy. If you used attribute 
fields in your input data files to define groups, you will most likely want to select this option so that 
your output file will match your input file. Consult Using Attribute Fields to Define a Hierarchy in 
Setting Up Your Historic Data for a discussion of attribute fields.  
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Include record type. Include a record type field that identifies which forecast component is being 
output. This is useful if you use the Break record up into lines option and are outputting more than 
one numeric output component. 

Item Name. Include a field listing the “name” of the variable as it appears on the Navigator. If the 
Include ancestry option is active, the ancestry will be shown as part of the item name. If Include 
record type is not active, then the variable names used for all numeric output components other 
than “Forecasts” will include a suffix indicating the record type. 

Description, Units, First historic date, First forecast date and Last historic date. Include fields for the 
selected options. 

The Numeric Output Section lists the different types of data series you can include in the report.  

History and Forecast Components. Check the boxes next to the information you want to include. Use 
the radio buttons under Seasonal Indexes to indicate if you want to include indexes for historic 
periods and/or the forecast horizon. The spinners next to the items are used to specify the numeric 
precision of the selected series. If the precision is set to 0, the numbers will not include a decimal.  

External rows. To include external rows in your Numeric Output, select from the External rows drop-
down. Use the spinner to the right to specify numeric precision for the external rows.  

Custom Date range. By default, the Numeric Output Report will include all forecast periods if a 
forecast is selected and all history periods if history is selected. If you want to change the periods 
shown in the report, select Custom date range and use the spinners to define the beginning and 
ending dates. 

If you are outputting a fixed width text file, you may set the column widths instead of the numeric 
precision by selecting Width in the Adjust radio buttons. 

 
The Model and Statistics tab is used to define the within-sample statistics and model details that you 
wish to include and to set their precision. If you are outputting a fixed width text file, you may set the 
column widths instead by selecting the Width radio button instead on Precision. The spinners next to the 
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Within-Sample Statistics selections and the Safety Stock Basis selections will apply to column width or 
numeric precision accordingly. 

Most of the options are self-explanatory. However, we have noted some details below. 

Model Properties. The Model Properties drop-down contains fields that describe the forecasting model 
selected. ModelSpec is a concise description of the model used. The notation that is used here is also 
used in the Forecast Report. Consult the Forecast Pro Statistical Reference Manual for further details.  

Transform. The Box-Cox transformation power. 1 indicates no transform, .5 the square root and 0 the 
natural log. 

The Item Report View 
The Item Report contains essentially the same information as the Numeric Output. The Item Report can 
contain Pareto information, statistical output such as the forecasting model specification and summary 
statistics as well as time series output such as history, forecasts, fitted values and confidence limits. The 
purpose of the Item Report is to provide a way to look at custom views that may use different settings 
than those required for the Numeric Output. The Numeric Output settings are typically defined for how 
the data needs to be exported within a forecasting process, while the Item Report is intended to be used 
interactively. 

To open the Item Report view, click the Item Report icon on the Reports tab. 

If you double-click an item on the Item Report, the Navigator will jump directly to that item. Thus, you 
can use the Item Report as the equivalent of a Hot List to navigate through the listed items. All global 
report views support this kind of navigation.  

The content and format of the report is controlled using the Item Report Settings dialog box. This dialog 
box is invoked by selecting Settings from the Item Report icon’s drop-down, or by selecting Settings on 
the view’s hamburger menu or from the Item Report view’s context menu. The Item Report Settings 
dialog box functionality is a subset of the Numeric Output Settings dialog box. Please consult The 
Numeric Output View section of this chapter for details. 

The Mapping Report View 
The Mapping Report includes a record of how, when and by whom every mapped history in your project 
was created. Please consult Working with Product Mapping and Mapped History for more details. 

To open the Mapping Report, click the Mapping Report icon on the Reports tab. 
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By default, the Mapping Report includes the columns shown above.  

In the example shown, the first four columns show the attributes for the Map to items. The number of 
columns will depend on the number of attributes you have in your hierarchy.  

The column labeled Map from shows the Map from item if the mapped history was created with 
product mapping or the name of the mapped history file if the mapped history was created by importing 
a mapped history file. If the forecast history has been set to zero, the field will read “Forecast History set 
to zero”. 

The remaining two columns show the user who created the mapped history and when the mapped 
history was created. 

To customize the display, open the Settings dialog from the hamburger menu or the context menu. 

 
 

The Settings dialog lists the optional columns you may include in the Mapping Report. User Name and 
Last Updated are included by default. The remaining optional columns are: 
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Description: Displays the Description included for the Map to item in the historic data file. 

Pareto: Includes four additional columns: Pareto, % of Total, Ranking and Cumulative %. Consult The 
Pareto Tab for more information. 

Date Range: Includes the Start Date, End Date and Periods (total number of mapped periods) for the 
mapped history defined in the Map from column. 

Volume: Displays the total unit volume for the mapped history across all mapped periods. 

% Allocation: Displays the percentage of the Map From item’s history used to create the mapped 
history. 
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Saving Your Work 
Forecast Pro Forecast Projects allow you to save your forecasting session so that you can return later and pick up 
where you left off or share the session with others. The Forecast Project saves the data, forecasts, overrides, Hot 
List, modifiers and all other information associated with the project as it exists when you save it. This data can 
also be exported to file. 

Additionally, Forecast Pro can export various types of output data including the fifteen following reports, which 
can be reviewed and customized on the Reports tab and exported from the Export tab.  

Numeric Output Files can contain time series output such as history, forecasts, fitted values and 
confidence limits as well as statistical output such as the forecasting model specification and summary 
statistics. These files can be saved in text, spreadsheet, ODBC or XML formats. You can include output 
for either all items forecasted, for the currently displayed items including any filters applied or just for 
the Hot List. If you will be importing forecasts into another application, these are typically the files you 
will want to use. 

Formatted Forecast Reports can be saved to Excel. You can save these reports for the currently displayed 
item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate 
worksheet for each item containing a graph (optional) and the on-screen Forecast Report. These reports 
are convenient if you wish to present the forecasts and/or models used to colleagues. 

The Item Report can be saved to Excel. This report can contain Pareto information, statistical output 
such as the forecasting model specification and summary statistics as well as time series output such as 
history, forecasts, fitted values and confidence limits. You can include output for either all items 
forecasted, for the currently displayed items including any filters applied or just for the Hot List. 

The Outlier Report can be saved to Excel. This report lists items where outliers have been detected 
and/or corrected.  

The Override Report can be saved to Excel. This report lists items where overrides and/or comments 
have been made.  

Forecasts Tracking Reports can be saved to Excel. You can save these reports for the currently displayed 
item, all items on the Hot List or all items forecasted. The Excel workbook will include a separate 
worksheet for each item containing a graph (optional) and the on-screen Tracking Report. These reports 
are only available if the database includes at least one archived forecast for the given item. 

The Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, FVA Global, Waterfall and Custom 
reports are all types of Exception Reports that can be saved to Excel. Each of the reports is helpful for 
reviewing history, forecasts, overrides, archived forecasts, external data and identifying unusual items 
that may need more review and customization. 

The Mapping Report can be saved to Excel. This report lists all mapped history currently in your project. 

The Product Mapping File and Mapped History File can be saved to Excel. These files are exported in the 
required formats for Product Mapping Files and Mapped History Files, respectively. Exporting these files 
and importing through the Data Manager is a convenient way to update mapped histories each forecast 
period. 
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Each of the above reports may be exported for all items in the project, for items on the Hot List or for only items 
included in the Current Display (including filters). The following sections discuss forecast projects and the output 
files listed above in more detail. 

Forecast Projects 
Forecast Projects allow you to save your forecasting session so that you can return later and pick up where you 
left off or to share the session with others. The forecast project saves the data, forecasts, overrides, Hot List, 
modifiers etc. as they currently exist in memory. If you update your input data files after saving a project, when 
you reopen the project, you will have the option of either generating new forecasts using the updated data or 
restoring the conditions present when the project was saved (i.e., not recalculating the forecasts using the new 
data).  

Opening projects 
To save a forecast project you select the File tab and then select Save on the left bar, click the Save icon on the 
far left of the default Quick Access Toolbar or simply use Ctrl+S. To open a forecast project, you select the File 
tab and then select Open on the left bar or simply use Ctrl+O. 

If you open a project and data files have not changed (i.e., the time and date stamps match), the project will 
restore the conditions present when the project was saved allowing you to continue your work where you left 
off. 

If you open a project and the data files are not available, the project will restore the conditions present when 
the project was saved—thus you can review projects, make adjustments, etc. even if you do not have access to 
the data files. This will often be the case when sharing projects with colleagues.  

 
If you open a project and data files have changed, a dialog box will appear allowing you to either generate new 
forecasts using the updated data or restore the conditions present when the project was saved (i.e., do not 
recalculate the forecasts using the new data). 

Project files 
The project file is usually a single zipped file with the extension FPZip. The zipped file contains three separate 
data files.  

The Project Settings File (*.FPProj is an XML file containing the project settings and Data Manager definitions. 
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The TRAC Database File (*.db) is a SQLite database file that contains information pertaining to the current 
forecast period and all previously archived forecasts. 

The Project Snapshot File (*.fcb) is a binary file that saves the forecast components that are currently in memory 
(e.g., the forecasts, summary statistics, etc.) so that the session can be restored without having to read in the 
data, recalculate the forecasts, etc. This allows you to return to your session where you left off and to share the 
session with others. 

Zipped vs. unzipped projects 
Forecast Pro allows you to save projects in an unzipped form. This is usually not recommended unless there is a 
specific issue with your operating environment that makes the unzipped format preferable. 

In networked environments, working with zipped projects usually offers better performance. When you open a 
zipped project, Forecast Pro copies the zipped file from the network drive to a local workspace, unzips the 
project files and opens the project—allowing you to work on your project locally, even though it was saved to a 
network drive. When you resave your zipped project, Forecast Pro will zip the updated local project files and 
save the updated FPZip file to the network drive. 

Forecast Pro defaults to saving zipped projects. To save and open unzipped projects, select FPProj as the file 
type in the Save as and Open dialog boxes. 

Numeric Output Files 
Numeric Output Files can contain time series output such as history, forecasts, fitted values and confidence 
limits as well as statistical output such as the forecasting model specification and summary statistics. These files 
can be saved in text, spreadsheet, ODBC or XML formats. You can include output for all items forecasted, what is 
currently displayed (including filters), the currently selected item or the Hot List. If you will be importing the 
forecasts into another application these are the files you will likely want to use. 

You can specify the format and content of Numeric Output File in Numeric Output Settings. The operation of the 
Numeric Output Settings dialog box is described in The Numeric Output View. 

You can preview the contents of the current Numeric Output File by clicking the Numeric Output icon on the 
Reports tab or selecting Show from the Numeric Output icon drop-down on the Home tab.  

You can save a Numeric Output file on the Export tab. First, on the left of the tab, select if you want to export 
the report for All Items, the Hot List or the items Currently Displayed in the report. Then, click the Numeric 
Output icon to save the report. 

You may open Numeric Output settings without previewing the report by selecting Settings on the drop-down of 
the Numeric Output icon on the Reports tab or the Export tab. 

Forecast Reports 
Forecast Reports can be saved to Excel. You can save these reports for the currently displayed item, all items on 
the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each item. These 
reports are convenient if you wish to present the forecasts and/or models used to colleagues. 

Each report contains the information found in the current Forecast Report view and (optionally) the graph 
defined by the Graph 1 settings.  

You can specify the format and content of Forecast Report using Forecast Report Settings and Graph 1 Settings. 
You can open the settings dialog from the hamburger or context menu on the Forecast Report and Graph 1 
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views. The operation of the Forecast Report Settings and Graph Settings dialog boxes are described in The 
Forecast Report View and The Graph Views. 

You save a Forecast Report from the Export tab. First, select if you want to export the report for All Items, the 
Hot List or the items currently included in the report. Then click the small Forecast Report icon. 

Item Reports 
Item Reports can be viewed on-screen and saved to Excel. These reports can contain Pareto information, 
statistical output such as the forecasting model specification and summary statistics as well as time series 
output such as history, forecasts, fitted values and confidence limits. You can use the context menu or 
hamburger menu to control the items included in the report (e.g. all items, the currently selected item or only 
items in the current hot list). This is true for all global reports. 

To open an Item Report, you click the Item Report icon on the Reports tab. You save an Item Report from the 
Export tab. First, select if you want to export the report for All Items, the Hot List or the items Currently 
Displayed in the report. Then click the small Item Report icon. 

You can specify the format and content of the report using Item Report Settings. You can open the settings 
dialog from the hamburger or context menu on the Item Report. The operation of the Item Report Settings 
dialog box is described in The Item Report View. 

Outlier Reports 
Outlier Reports can be viewed on-screen and saved to Excel. These reports list the items where outliers have 
been detected and/or corrected. You can use the context menu or hamburger menu to control the items 
included in the report (e.g. all items, the currently selected item or only items in the current hot list). This is true 
for all global reports. 

To open an Outlier Report, click the Outlier Report icon on the Reports tab. You save an Outlier Report from the 
Export tab. First, select if you want to export the report for All Items, the Hot List or the items Currently 
Displayed in the report. Then, click the small Outlier Report icon. 

The content and format of the report is controlled using the Outlier Report’s context menu. Please see The 
Outlier Report View for details. 

Override Reports 
Override Reports can be viewed on-screen and saved to Excel. These reports list the items where overrides 
and/or comments have been made with a time stamp and the user who made the override/comment. You can 
use the context menu or hamburger menu to control the items included in the report (e.g. all items, the 
currently selected item or only items in the current hot list). This is true for all global reports. 

To open an Override Report, click the Override Report icon on the Reports tab. You save an Override Report 
from the Export tab. First, select if you want to export the report for All Items, the Hot List or the items 
Currently Displayed in the report. Then, click the small Override Report icon. 

You can specify the format and content of the report using Override Report Settings. You can open the settings 
dialog from the hamburger or context menu on the Override Report. The operation of the Override Report 
Settings dialog box is described in The Override Report View. 
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Tracking Reports 
Forecast Tracking Reports can be saved to Excel. You can save these reports for the currently displayed item, 
only items on the Hot List or all items forecasted. The Excel workbook will include a separate worksheet for each 
item. These reports are only available if the database includes at least one archived forecast for the given item. 

You can specify the format and content of Forecasts Tracking Reports using Tracking Report Settings. You can 
open the settings dialog from the hamburger or context menu on the Tracking Report. The operation of the 
Tracking Report Settings dialog box is described in The Tracking Report and Tracking Report Graph Views. 

You save a Forecasts Tracking Report from the Export tab. First, select if you want to export the report for All 
Items, the Hot List or only the item Currently Displayed in the report. Then click the small Forecast Tracking icon. 

You can print a tracking report for the currently selected item by clicking Print this Page from the Tracking 
Report view’s context menu. You can also save an Excel report for the currently displayed item using the Save 
this page to Excel option on the Tracking Report view’s context menu or hamburger menu. 

Exception Reports 
Exception reports list the items where your forecast error or some other performance metric has fallen outside 
of an acceptable range. Exception reporting reduces the need for manual review of your forecasts and allows 
you to focus on the items where human attention is most needed. 

There are six types of Exception Reports:  Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, FVA 
Global, Waterfall and Custom. Exception Reports can be viewed on-screen and saved to Excel. The details of 
each of the Exceptions Reports is described in The Exception Report Views. 

To open an Exception Report, click the Reports tab icon for the specific Exception Report you want to view. Note 
that you can have all six reports open at the same time.  

You save an Exception Repot from the Export tab. First, select if you want to export the report for All Items, the 
Hot List or the items currently included in the report. Then, click the small icon for the Exception report 
(Forecast vs. History, Forecast vs. Archive, Forecast Accuracy, FVA Global, Waterfall or Custom) you want to save. 

You can specify the format and content of the report by selecting Settings on the Exception Report’s hamburger 
or context menu. The operation of each Exception Report Settings dialog box is described in The Exception 
Report Views. 

Mapping Reports 
Mapping Reports include a record of how, when and by whom mapped history in your project was created. 
Please see  The Mapping Report for more details. 

You can save a Mapping Report from the Export tab. First, select if you want to export the report for All Items, 
the Hot List or the items currently included in the report. Then, click the small Mapping Reports icon. 
Alternatively, you may select Save this Page to Excel from the hamburger or context menu.  

Product Mapping Files 
Forecast Pro supports file-based product mapping, allowing you to map the history from one item in your 
historic data (the Map from item) to another (the Map to item). This can be useful when you are dealing with 
many items that need to be mapped. See Product Mapping Files for more details. 
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You are also able to create and export a product mapping file from Forecast Pro with the product mappings 
currently in your project. Creating a product mapping file from Forecast Pro allows you to easily refresh your 
current mappings as your data history is updated and allows you to share product mapping across projects.  

You can save a Product Mapping File from the Export tab. First, select if you want to export the report for All 
Items, the Hot List or the items currently included in the report. Then, click the small Product Mapping File icon.  

Mapped History Files 
You may use a mapped history file to import values that you want to map to an item in your historic data. Please 
see Mapped History Files for details. 

You can also export your mapped histories in the mapped history file format. Doing so takes a snapshot of your 
mapped history, creates a mapped history file template and allows you to read your mapped histories into other 
Forecast Pro projects. 

You can save a mapped history file from the Export tab. First, select if you want to export the report for All 
Items, the Hot List or the items currently included in the report. Then, click the small Mapped History File icon.  
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Customizing Your Forecasts 
By default, Forecast Pro will use expert selection, an Artificial Intelligence (AI) driven engine to 
automatically select a forecasting model for each item on the Navigator. The expert selection option 
works extremely well and is the method of choice for most Forecast Pro users. The expert selection 
algorithm is described in the Forecast Pro Statistical Reference Manual. 

Alternatively, you can select alternative models and/or forecasting options. The tools you need to 
customize forecast models are on the Forecasting tab. Forecast modifiers are added to items on the 
Navigator as you create custom models. These modifiers are used by Forecast Pro to document your 
customizations and generate models according to the customized specification. Note that the 
functionality available on the Forecasting tab can also be accessed from the Navigator’s context menu.  

This chapter documents the model options and tools available on the Forecasting tab, the associated 
forecast modifiers, and the operation of the model specification dialog boxes. Please note that in all 
cases, the described functionality is applied to the item selected in the Navigator.  

Expert Selection 

 
By default, Forecast Pro will use expert selection, an Artificial Intelligence (AI) engine, to automatically 
select the appropriate forecasting method. In this case, the item will not have a forecasting modifier. If 
an item on the Navigator does have a modifier that specifies a statistical model to be used instead of 
Expert Selection, when you click the Expert Selection icon on the Forecasting tab or select 
Forecasting>Expert Selection on the Navigator’s context menu, the forecasting modifier(s) will be 
removed, and Forecast Pro will use expert selection to automatically select the appropriate forecasting 
method. 

On The Performance Tab of the Options dialog, you can specify methodologies that expert selection 
should not consider. These methodologies include: ARIMA, (Box-Jenkins), seasonal simplification, the 
NA-CL model and machine learning.  
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Machine Learning 

 

Automatic Univariate Machine Learning 
 

Machine learning is available as an automatic univariate model, which may be included in expert 
selection, or as a custom model. Like exponential smoothing and Box-Jenkins, machine learning models 
leverage information inherent in the historic data (seasonality, trend) to create variables (features in 
machine learning). While the automatic machine learning models rely on only this information, custom 
machine models allow you to include additional explanatory variables and/or events.  

Click the Machine Learning icon to use an automatic univariate machine learning model. 

The modifier associated with Automatic Machine Learning is: 

\ML. Use automatic machine learning. 

Select Expert with ML from the Machine Learning icon drop-down to include machine learning in expert 
selection for the selected item. This is useful when you want to consider machine learning in expert 
selection for only a subset of items. This is only available when you exclude machine learning from 
Expert Selection globally via the Performance tab of the Options. 

\MLES. Include machine learning in expert selection and apply the model that is automatically selected. 

Custom Machine Learning Models 
To specify a custom machine learning model, Select Manage from the Machine Learning icon drop-
down to open the Machine Learning dialog.  
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Name: Forecast Pro names each of your custom machine learning model specifications and saves them 
in the project’s database. These named specification sets provide a convenient way to apply the same 
machine learning model specifications to multiple items on the Navigator. The Name drop-down allows 
you to select previously defined specification sets, create new ones, save the current set using a 
different name and delete the current set. 

Description: The description field allows you to enter a description for the current model selection. 

All custom machine learning models will include the same features used in the automatic univariate 
models (e.g. seasonality/interventions). The custom dialog allows you to include additional variables. 

Events: The Events display lists all available event schedules. Check the event schedules you want 
machine learning to consider as features in the model. Because the event codes have no natural order 
(that is event codes 1 and 2 are simply two different events), Forecast Pro creates a separate feature for 
each event code in an event schedule. The machine learning algorithm will determine which event 
schedules and event codes should be used in the model.  

Explanatory variables: The Explanatory variables field lists all global and item-specific  explanatory 
variables available in the project. Check the variables that you want Forecast Pro to consider as features 
in your machine learning model. Do not include variables that are categorical, or unordered. If you have 
an unordered or categorical variable, include it as an event schedule, not an explanatory variable. Note 
that the machine learning algorithm will consider all checked variables, but it will only use a variable if it 
improves the machine learning forecasts. 

Auto Extend: Check the Auto Extend checkbox if you want Forecast Pro to use expert selection to 
generate forecasts for any explanatory variable that does not have values provided for all periods in the 
forecast horizon. 
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Parameters: 

Automatic: Check the Automatic checkbox if you want Forecast Pro to automatically select the 
Maximum Tree Depth and Number of Trees. The parameters are described below, in the Machine 
Learning Methodology. 

If you uncheck the Automatic checkbox, the Maximum Tree Depth and Number of Trees spinners are 
operational. Consult Machine Learning Methodology for more details on the parameters described 
below. 

Maximum Tree Depth:  The tree depth is the length of the longest path to a leaf or forecast node. Use 
the spinner to select a maximum tree depth. Please note that as you increase the tree depth, the in-
sample model fit will improve, but the forecasts may be less accurate. You should consider using out-of-
sample statistics to choose an appropriate maximum tree depth. 

Number of Trees: Use this spinner to choose the number of trees to include in the ensemble model. As 
you increase the number of trees, the in-sample model fit will improve, but the forecasts may be less 
accurate. You should consider using out of sample statistics to choose an appropriate number of trees. 

\ML=name. Use a custom machine learning model with the specifications defined in name. 

Machine Learning Methodology 
Forecast Pro’s machine learning methodology uses extreme gradient boosted decision trees. A decision 
tree applies a set of logical rules to a set of features to “decide” an appropriate forecast value. Below is 
an example of a decision tree. 

 
In this case, there is only one feature (month), and tree depth is two. The tree depth is the length of the 
longest path to a terminal node. To generate a forecast, the model starts at the top of the tree and uses 
the feature values to move through the tree until a terminal (“leaf”) node is reached. Here, the leaf 
nodes are the “Demand” nodes. For example, suppose it is June, or month = 6.  
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The demand forecast for June is 200. 

Extreme gradient boosting is an ensemble approach. An ensemble model combines multiple models. 
Extreme gradient boosting generates multiple decision trees and then the forecast is equal to the 
average forecast across all trees. Boosting algorithms add models sequentially. In each iteration, the 
new tree improves on the weakness of the previous trees. Extreme gradient boosting finds the tree 
structure and parameters that optimize a specified objective function, typically Mean Square Error. 
Forecast Pro’s implementation uses XGBoost, an open-source library. Please consult XGBoost 
documentation for more details on how extreme gradient boosted trees work. 

XGBoost requires several key inputs, including features, maximum tree depth and the number of trees 
the ensemble model should include. These inputs are important determinants of forecast accuracy and 
manually selecting them can be difficult. When using automatic univariate machine learning models, 
Forecast Pro uses its own rule-based algorithm to decide which features to automatically build and then 
automatically determines the maximum tree depth and number of trees using a combination or rules 
and out-of-sample holdout testing. 

In addition to the Forecast Pro generated features used in the automatic univariate model, custom 
machine learning models may also include event schedules and explanatory variables as features in a 
boosted decision tree ensemble model. You can automatically train custom machine learning models 
using the same AI-driven logic that powers Forecast Pro’s automatic machine learning univariate 
models, or you can specify a specific boosted decision tree structure. 

Machine Learning Forecast Report 
Because ensemble models involve multiple models, it is difficult to summarize the impact of an 
individual feature on demand in the same way that you can with coefficients for dynamic regression or 
indexes for exponential smoothing. Instead of showing the size or direction of the impact of a feature on 
demand, Forecast Pro shows the relative importance of a feature in the ensemble model. 

https://xgboost.readthedocs.io/en/latest/tutorials/model.html
https://xgboost.readthedocs.io/en/latest/tutorials/model.html
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The above Model Details section of the Forecast Report is for a custom model with automatic parameter 
selection. Forecast Pro has used a maximum tree depth of 4 and 50 trees. The model includes 4 
explanatory variables (Price, Feature and Display, Feature, Display) and one Event Schedule 
(_Stock_outs) with 2 event codes (Stock Out and No Event). The remaining variables were automatically 
generated by Forecast Pro. 

There are three importance measures displayed for each feature: Gain, Coverage and Frequency. Gain 
measures the percentage of overall model improvement or accuracy that is attributable to a feature.  
Coverage shows the percentage of observations that are forecasted at a leaf node that are decided by a 
feature. Frequency is the percentage of tree splits associated with a feature. Gain is widely considered 
to be the most relevant feature importance measure for forecasting. For more details on feature 
importance computations, please consult the XGBoost documentation. 

Exponential Smoothing 

 

Automatic Exponential Smoothing 
Select Automatic from the Exponential Smoothing icon drop-down or simply click the icon for Forecast 
Pro to automatically select an exponential smoothing model.  

The modifier associated with Automatic Exponential Smoothing is: 

\EXSM. Use the automatic fitting exponential smoothing model. 

Simple Exponential Smoothing 
Select Simple on the Exponential Smooth icon drop-down to use a simple exponential smoothing model.  

The modifier associated with Simple Exponential Smoothing is: 

\SIMPLE. Use the simple exponential smoothing model. 

https://xgboost.readthedocs.io/en/latest/tutorials/model.html
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Holt Exponential Smoothing 
Select Holt on the Exponential Smoothing icon drop-down to use the Holt exponential smoothing 
model.  

The modifier associated with Holt Exponential Smoothing is: 

\HOLT. Use the Holt exponential smoothing model. 

Winters Exponential Smoothing 
Select Winters on the Exponential Smoothing icon drop-down to use the Winters exponential 
smoothing model.  

The modifier associated with Winters Exponential Smoothing is: 

\WINTERS. Use the Winters exponential smoothing model. 

NA-CL Exponential Smoothing 
Select NA-CL on the Exponential Smoothing icon drop-down or click the NA-CL icon in the Low Volume 
group to use a non-trended Additive Seasonality Constant Level exponential smoothing model. Note 
that NA-CL is included in the Low Volume group because it works well for items with seasonal, low 
volume demand. 

The modifier associated with NA-CL Exponential Smoothing is: 

\NA-CL. Use the non-trended Additive Seasonality Constant Level exponential smoothing model.  

Custom Exponential Smoothing 
Selecting Custom on the Exponential Smooth icon drop-down on the Forecasting tab or selecting 
Forecasting>Exponential Smoothing on the Navigator context menu invokes the Exponential Smoothing 
Model Settings dialog box shown below. 
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The Model Type section of the dialog box allows you to specify Automatic selection (i.e., Forecast Pro 
will automatically select the form of the exponential smoothing model to apply), one of the standard 
models or Custom. If you select Custom, you will need to specify the form of Trend and Seasonality to 
use.  

If you are forecasting data where the periods per cycle is greater than 13 (e.g., weekly data) you can use 
the Seasonal Simplification options to reduce the number of seasonal indices to use. None instructs 
Forecast Pro to not use seasonal simplification. Automatic allows Forecast Pro to automatically select 
the number of indices using out-of-sample testing. Custom allows you to specify the number of indices 
by specifying the “bucket size” (i.e., how many periods to combine into each seasonal index) or by 
setting the number of indices to use per year. Note that seasonal simplification cannot be used in 
conjunction with event models. 

The Event Indices section allows you to specify the form of the event indices (additive, multiplicative or 
let Forecast Pro decide). This section will only be available if you have specified an event schedule. 
When events are used in conjunction with a seasonal model, the form of both the event indices and 
seasonal indices must match—so the Event Indices section will also be greyed out if Seasonality is set to 
anything other than None. 

The Parameters section allows you to set the smoothing weights to specific values. In general, this is not 
a recommended practice (allowing Forecast Pro to optimize the smoothing weights is recommended). If 
you do wish to set the smoothing weights, you must specify a specific form for the trend and 
seasonality. 

When you click the OK button Forecast Pro will apply the appropriate modifier on the Navigator and 
build the specified model.  

The exponential smoothing modifiers include: 
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\EXSM=XY. Use a custom exponential smoothing model with trend type X (N=no trend, L=linear trend, 
D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, 
M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and optimized smoothing 
weights.  

\EXSM=XY(A,B,C,D). Use a custom exponential smoothing model with trend type X (N=no trend, 
L=linear trend, D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y 
(N=nonseasonal, M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and user 
defined smoothing weights (A=level, B=trend, C=damping/growth, D=seasonal). 

\SS. Use Forecast Pro’s automatic identification procedure to determine whether to use seasonal 
simplification and the appropriate bucket size. 

\SS=n. Use seasonal simplification with n periods for each seasonal index or “bucket”.  

Event Models  

 
Event models extend exponential smoothing by allowing you to adjust for events like sales promotions, 
strikes or simply for unexplained outliers. Multiple events are used to account for promotions of 
different types or sizes, different calendar effects like Easter and Independence Day weeks, or any other 
“out of the ordinary” occurrence. 

To build an event model, you must tell the program when events of each type occur. To do this, you 
must construct an event schedule which classifies each period by event code (0=no event, 1=event of 
type 1, 2=event of type 2, etc.). You can create event schedules interactively using the Event Manager or 
create them outside of Forecast Pro and import them using the Helpers row in the Data Manager. When 
you create an event schedule interactively, Forecast Pro will create a helper variable with this schedule.  

The Event Manager 
The Event Manager is used to create and modify event schedules. This section documents the options 
available on the Event Manager dialog boxes. 

You invoke the Event Manager by clicking the Events icon on the Forecasting tab or selecting Manage 
events on the Graph 1 view’s context menu. 
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The Event Manager works in conjunction with the Graph 1 view. If the Graph 1 view is not open, 
Forecast Pro will automatically open it when you click the Event icon on the Forecasting tab. 

The Manage Events dialog box is shown above. The Date drop-down at the top of the box is used to 
assign event codes to the current schedule. To specify the date to which you want to assign an event 
code, you select a historic point on Graph 1. You can then use the drop-down to the right of the date to 
associate the selected date with a specific event. Holding down the <Ctrl> key when selecting points on 
the graph allows you to select multiple points. 

The display grid in the middle of the dialog box shows the event code definitions on the current 
schedule along with their status. Pending status indicates that the changes are not yet reflected in the 
current forecast model. Clicking the Commit button will accept the current changes and build the 
specified event model. 

The Show all periods option will include all periods in the display grid, not just the dates with assigned 
events. You may select periods in the display grid and use the drop-down to assign event codes instead 
of selecting periods on the graph. 
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The Schedule drop-down is used for several purposes. When the drop-down is closed it displays the 
name of the event schedule associated with the current item. Opening the drop-down displays the 
currently available event schedules and allows you to select one. It also provides options to disassociate 
the currently selected schedule from the currently displayed item and create a new schedule (New), 
rename the current schedule (Save as), import events from other schedules into the current schedule so 
the two schedules are merged and delete the current schedule from the Forecast Pro database. 

 
Clicking the Edit button on the Event Manager or using the Event Codes option in the Events icon drop-
down will invoke the Manage Event Codes dialog box, which allows you to define new event codes and 
edit existing ones. You can select an event code using the spinners or by clicking on the event code in 
the display grid. After editing a description, you click the Add button to update the display grid. You can 
remove an event code by selecting it in the display grid and clicking the Remove button. You will be 
warned if the event code is being actively used, and given the option to save changes to the event 
codes. Any new event code defined will have a status of Pending until you accept them using the 
Commit button. The Exit button is used to close the Manage Event Codes dialog box and return to the 
event manager. 

Finally, the Events icon drop-down lists all event schedules associated with the project. Select a schedule 
from the drop-down to apply the modifier \EVENT=_X, where X is the selected schedule or helper, to the 
selected item on the Navigator.  

For examples of constructing event variables and building event models, consult the Building Event 
Models lesson in Forecast Pro TRAC Tutorials. For statistical details, consult the Forecast Pro Statistical 
Reference Manual. 

The following modifiers are used for Event Models: 

\EVENT=_X. Use an event model with helper _X. 

\EXSM=XYZ. Use an exponential smoothing model with trend type X (N=no trend, L=linear trend, 
D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, 
M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides) and event type Z 
(M=multiplicative, A=additive, *=Forecast Pro decides). This modifier can only be used in conjunction 
with \EVENT=. 
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\XYZ(A,B,C,D,E). Use an exponential smoothing model with trend type X (N=no trend, L=linear trend, 
D=damped trend, E=exponential, *=Forecast Pro decides), seasonality type Y (N=nonseasonal, 
M=multiplicative seasonal, A=additive seasonal, *=Forecast Pro decides), event type Z (M=multiplicative, 
A=additive, *=Forecast Pro decides) and user defined smoothing weights (A=level, B=trend, 
C=damping/growth, D=seasonal, E=event). This modifier can only be used in conjunction with \EVENT=. 

Custom Component Model 

 
The custom component model includes each of the components found in a custom exponential 
smoothing model: level, trend, seasonality and events. In a standard smoothing approach, final values of 
each component are estimated from the data and used to assemble the forecasts. In a custom 
component model, you can either let Forecast Pro estimate the final value for a given component or 
customize the values to be used. 

Custom component models are useful in a variety of situations including (1) customizing the trend for 
longer-term forecasts, (2) customizing the seasonal pattern for short data sets and (3) defining the 
impact of future events that have not occurred historically. Because custom component models are 
particularly useful for new products, Forecast Pro includes a Custom Component icon in the New 
Product group in addition to the primary icon on the Forecasting tab. 

Clicking either Custom Component icon or selecting Forecasting>Component Model > Manage on the 
Navigator context menu invokes the Component Model Settings box shown below. 

 
Name: Forecast Pro names each of your component model specifications and saves them in the 
project’s data base. These named specification sets provide a convenient way to apply the same 
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component model specifications to multiple items on the Navigator. The Name drop-down allows you to 
select previously defined specification sets, create new ones, save the current set using a different name 
and delete the current set. 

Description: The description field allows you to enter a description for the current specification set. 

Starting Point: The Starting Point drop-down allows you to set the starting point for the forecasts. 
Automatic instructs Forecast Pro to estimate an exponential smoothing model for the data and set the 
starting point to the final level. Custom allows you to enter a specific value to use as the starting point. 
Final Historic sets the starting point to the final historic observation. 

Trend (None and Linear): The trend drop-down allows you to specify the form of the trend you wish to 
forecast. All trends will begin at the starting point. None will yield a flat-line trend. Linear automatic 
instructs Forecast Pro to estimate an exponential smoothing model for the data and set the trend to the 
final trend estimated for the model (this will either be linear or flat line). Linear custom will default to 
the linear automatic value, but the slope can then be modified using the radio buttons (discussed 
below).  

Trend (Bent): You can modify a linear trend by “bending” it up or down. When you bend a trend 
downward you decrease the per-period-slope increment resulting in a trend that dampens out as you 
forecast forward. When you bend a trend upward you increase the per-period-slope increment resulting 
in a trend that accelerates as you forecast forward. Bent automatic will use the linear automatic trend as 
the baseline which can then be bent using the radio buttons (discussed below). Bent custom will default 
to using the linear automatic trend as the baseline but allows you to change the slope for the baseline 
trend (using the Slope radio button) as well as allowing you to bend the baseline trend using the radio 
buttons (discussed below).  

Trend (radio buttons): The Trend radio buttons are used to customize the slope. When the Component 
Model Settings dialog box is open, the graph includes the current committed trend. The Slope allows you 
to modify the slope (per-period change) directly. The End Point allows you to set the value of the trend 
at the last forecast point. The difference between the trend’s starting point and ending point can be 
thought of as the “vertical rise.” Percent allows you to specify the ending point of a bent trend model as 
a percentage of the vertical rise. Total Forecast allows you to set a value for the sum of the total 
forecast. Current Year allows you to set a value for the sum of the current year’s historic + forecast 
values. 

Seasonal Indexes: The Seasonal Indexes drop-down allows you to specify the multiplicative indexes you 
wish to use to forecast the seasonality. None will yield a nonseasonal forecast. Automatic instructs 
Forecast Pro to estimate an exponential smoothing model for the data and set the seasonal indexes to 
the final seasonal indexes estimated for the model. Custom allows you to edit the currently displayed 
values. Helpers allow you to import the indexes from a helper variable. If the helper variable contains 
more than one year’s worth of indexes, Forecast Pro will import the final year’s values. 

Schedule: Schedule allows you to specify an event schedule to use. 

Event Indexes: Event Indexes allows you to specify the form and values for the event indexes. None will 
not apply event indexes to the forecast. Automatic instructs Forecast Pro to estimate an exponential 
smoothing model for the data and set the event indexes to the final event indexes estimated for the 
model. Custom additive allows you to edit the currently displayed values and apply them as additive 
indexes. Please note that the displayed values may correspond to a multiplicative model and, if so, 
should be changed to values that reflect incremental units driven by each event code. Custom 
multiplicative allows you to edit the currently displayed values and apply them as multiplicative indexes. 
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Click OK or Apply on the Component Model Settings dialog box to apply the model shown in the name 
drop-down to the item selected on the Navigator. Alternatively, you may open the drop-down on the 
large Custom Component icon on the Forecasting tab and select a model name. 

The following modifier is associated with the custom component model. 

\COMP=name. Use a custom component model with the specifications defined in name.  

Dynamic Regression 

 
Dynamic regression produces a forecast based on the forecasted item’s history (like univariate methods) 
and that of the explanatory variables (e.g., product promotion, advertising, demographic variables, 
macroeconomic indicators, etc.).  

Clicking the Dynamic Regression icon on the Forecasting tab or selecting Forecasting>Dynamic 
Regression>Manage on the Navigator context menu invokes the Dynamic Regression dialog box shown 
below. 

 
Name: Forecast Pro names each of your dynamic regression model specifications and saves them in the 
project’s database. These named specification sets provide a convenient way to apply the same dynamic 
regression model specifications to multiple items on the Navigator. The Name drop-down allows you to 
select previously defined specification sets, create new ones, save the current set using a different name 
and delete the current set. 

Description: The description field allows you to enter a description for the current model selection. 
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Explanatory variables: Explanatory variables allow you to capture how the dependent variable changes 
in response to external variables. The Explanatory variables field lists all explanatory variables (both 
global and item-specific) read in through the Data Manager. Please see the Explanatory Variables section 
of “Setting up your Optional Data” for details on the differences between global and item-specific 
explanatory variables. 

System variables: There are two type of terms that can be included in a dynamic regression models—
explanatory variables and dynamic terms. Explanatory variables are defined above. Dynamic terms 
capture how the dependent variable changes in time and can help forecast trends and seasonal patterns 
in a similar fashion to extrapolation methods such as Box-Jenkins and exponential smoothing. 

The System variables field lists dynamic terms as well as well as system terms for defining additional 
explanatory variables in Forecast Pro. 

Each of these system terms starts with an underbar to identify it as a Forecast Pro defined variable. 
These terms include the following:  

_PERIOD(n) creates a dummy variable for period n. The dummy variable will have a value of 1 for 
the nth period in the seasonal cycle and a value of 0 for all periods. For example, if you are using 
monthly data, Period(3) will have a value of 1 for every March and a value of 0 for all other time 
periods. 

_SPIKE(year, period) is used to create a dummy variable for a single period. For example, for a 
monthly data set, _SPIKE(2021,7) has a value of 1 for July 2021 and a value of 0 for all other periods. 
This function can be useful when modeling outliers. 

_STEP(year, period) is used to create a variable that consists of all zeroes prior to a specified time 
period and all ones thereafter. For example, for a monthly data set, _STEP(2021,7) will have a value 
of 0 prior to July 2021 and a value of one for July and thereafter. This function can be useful when 
modeling level shifts. 

The Systems variables list box may also include the following dynamic terms: 

_CONST is used to include a constant term in the model. A constant term has a value of 1 for all time 
periods. 

_TREND is used to include a linear trend term in the model. 

_DEPENDENT[-n] is used to include a lagged dependent variable in the model. For example, if you 
are modeling the item Sales, DEPENDENT[-1] is Sales for the prior period.  

_AUTO[-n] is used to create a Cochrane-Orcutt model which includes a variable equal to the fitted 
model error from n periods earlier. For example, when you add _AUTO[-1] to the model, the 
program uses the fitting error from time t-1 to help predict the fitting error for time t. 

Forecast Pro offers an Automatic dynamics mode. In this mode, you select the explanatory variables to 
include, and the program automatically determines the dynamic terms to include. When you use 
Automatic dynamics, the dynamic terms are not visible in the Dynamic Regression dialog box. 

When you double click on an item in either the System Variables or Explanatory Variables list box, it is 
added to the Model box. When you add _STEP or _SPIKE, you will be asked to specify a date to use 
before it is added. Once you have added a variable to the Model box, it can be edited using the context 
menu as described in the Model section below. 

Model: The Model box lists all terms that you have added to the model. To the left of each item is a 
checkbox to indicate if the item should be included in the regression. If this box is checked, the term will 
be included in the model. If the box is not checked, the term will be tested in the dynamic regression 



The Event Manager | 135 
 

 

test batteries but will not be included in the model. If Automatic dynamics is selected, the dynamic 
terms will not appear in the Terms and Model boxes, but an optimized set of dynamics terms will be 
included in the model. 

Each term in the Model box can be adjusted using the Model box’s context menu. Right click on the item 
in the Model box to activate the Model box’s context menu.  

Clear will remove all terms from the dialog box. 

Remove will remove just the selected item from the Model box.  

Lag allows you to adjust the specified lag. You can use the lag selection to create lagged explanatory 
variables or to adjust the lags for the _AUTO and _DEPENDENT terms.  

Transform allows you to use a logarithm, square root or inverse transform on the selected variable. 
Transform is not available for dummy variables or if the transform cannot be applied to the selected 
variable (e.g. logarithm for items with zero values). 

Edit allows you to change the specified period for the dummy variables (_PERIOD, _STEP and 
_SPIKE). 

Optimize Dynamics (button): This button will replace any existing dynamic terms in the model with a set 
of dynamic terms selected by Forecast Pro. Note that the optimal model dynamics are selected for the 
item currently selected on the Navigator and the specified non-dynamic terms in the Model box. Once 
the optimal dynamics are added—they are simply part of the specified model—they will not be 
automatically updated if you subsequently change the model. 

Automatic Dynamics (check box): If this option is selected, the program automatically determines the 
dynamic terms to include. The user still needs to specify the explanatory variables to include. 
Automatics dynamics is selected by default. 

There are important (but subtle) differences between a model specification that uses the Automatic 
Dynamics option and a model specification that used the Optimize Dynamics button to determine the 
dynamics. 

1. If you apply the same model specification to multiple items on the Navigator, the model 
specification that uses Automatic Dynamics will select the dynamic terms independently for 
each item. The model specification built using the Optimized Dynamics button will simply apply 
the specified terms to each item.  

2. If you update your project with new data and reforecast, the model specification that uses 
automatic dynamics will re-select the dynamic terms using the new data (potentially changing 
the selected terms). The model specification built using the Optimized Dynamics button will 
simply apply the previously specified terms to each item. 

Note that the dynamic regression model specification can also be edited with the context menu in the 
Forecast Report view. Right click on a term in the model details section of the report to activate the 
context menu and remove or edit the specified term from the model. The Variable Test Specification 
battery and Dynamics Test Battery sections of the report list explanatory variable and dynamic to 
consider adding to the model. To add a term to the model, right click on the term you wish to add and 
select Add term from the Forecast Report context menu. 

In order to generate forecasts, Forecast Pro needs values for each explanatory variable for all periods in 
the forecast horizon. These values may be provided in the explanatory variables file, or you may use 
Auto Extend if you want Forecast Pro to use expert selection to generate forecasts for any explanatory 
variable that does not have values provided for all periods in the forecast horizon. Forecast Pro will 



By Analogy | 136 
 

 

provide values only for those periods where none was provided. By default, Auto Extend is not selected. 
To select Auto Extend, open the Options dialog box by clicking the Options icon on the Home ribbon tab 
and then go to the Advanced tab on the Options dialog box. 

Click OK or Apply on the Dynamic Regression dialog box to apply the model shown in the name drop-
down to the item selected on the Navigator. Alternatively, you may open the drop-down on the 
Dynamic Regression icon on the Forecasting tab and select a model name. 

The following modifier is associated with the dynamic regression model. 

\DR=name. Use a dynamic regression model with the specifications defined in name. 

Product Mapping 

 
The Product Mapping icon opens the Product Mapping dialog box. From this dialog box, you may 
interactively create product mappings from items on the Navigator.  

Product Mapping is used to assign the history from one or more items (the Map from items) to another 
(the Map To item). The history from the Map from items is the Mapped History. If there is a single Map 
from item, the Map to item’s forecast history is equal to the Map from items’ history plus the Map to 
item’s history. 

Map to Forecast History = Map from history + Map to history 

Forecast Pro will use then use the defined forecast history to generate forecasts for the Map to item. 

Please see Working with Product Mapping and Mapped History for a more detailed description of how 
product mapping works and Interactive Product Mapping for an overview of the Product Mapping 
dialog’s functionality. 

New Product Models 

 

By Analogy 
The concept behind the Forecast by Analogy model is very simple. The approach is sometimes referred 
to as a “looks like” analysis. The model assumes that the initial sales over the first few time periods for a 
new product will follow the same pattern as the initial sales of an existing, similar product as it launched. 
To use this method, you must supply the launch profile or “analog series” in the form of a helper 
variable. This launch profile is simply sales for the analog product, starting with the launch period and 
extending for as many time periods as deemed relevant. 

If the product has not yet launched (i.e., there are no historic data available), then you must also supply 
an estimate of the initial sales over a specific period of time (the launch total over the launch horizon). 
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Forecast Pro will then create the forecast by proportionally allocating the launch total over the launch 
horizon using the analog series to define the proportions. 

If any historic demand for the new product is available, you may either supply the launch total and 
launch horizon or allow Forecast Pro to calculate the forecasts by fitting the existing data to the analog 
series. 

Clicking the By Analogy icon on the Forecasting tab or selecting Forecasting>New Products>By Analogy 
on the Navigator context menu invokes the Forecast by Analogy Model Settings dialog box shown 
below. 

 
The Select the analog variable box displays the currently available helper variables and allows you to 
select the one you’d like to use as the analog series. If historic demand exists, the Estimated launch total 
displays the launch total calculated using the current analog variable and the historic demand. The 
Specified launch total allows you to input a specific launch total to use. The Launch horizon allows you to 
specify the length of the launch horizon. The default launch horizon equals the length of the history, if 
any, plus the current forecast horizon. 

The Launch date option is only available if the product has not yet launched (i.e., there is no historic 
demand for the product). It allows you to specify when the product will launch, allowing you to set up 
the forecasting model in advance of the launch date.  

The Automatically extend option will automatically forecast the analog variable if it does not cover the 
full launch horizon. The Align seasonality option will (if necessary) adjust the beginning period of the 
analog series so that it aligns with the launch date’s period. For example, if the analog series started in 
January and the launch date corresponded to March, then selecting this option would result in using the 
analog series’ first March observation as the first analog series data point (thus aligning the seasonal 
patterns of the analog series and the new product). 

Expert selection after is used to specify a date where Forecast Pro should stop using the Forecast by 
Analogy method and switch to using expert selection. For example, if you set Expert selection after to 
June 2021, Forecast Pro would use the Forecast by analogy approach until your historic data included 
July 2021. 

Click OK or Apply on the Forecast by Analogy Model Settings dialog box to apply the by analogy model.  

The modifiers associated with Forecast by Analogy are: 

\ANALOG=_X. Use the by analogy model with automatic calculation of the launch total. _X is the name 
of the time series containing the analogy series. 

\ANALOG=_X(A,B). Use the by analogy model with a specified launch total of A and a specified launch 
horizon of B. 
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\ANALOG=_X(A,B,C,D). Use the by analogy model with a specified launch total of A, a specified launch 
horizon of B and a specified launch date with a starting year of C and starting period of D. This option is 
only available when the series being forecasted has no historic data. 

\ANALOGEX, \ANALOGAL, \ANALOGD. There are three suffixes that may appear after the keyword 
ANALOG. EX appears if the Automatically extend option is selected. AL appears if the Align seasonality 
option is selected. D appears if the Expert selection after option is selected. If all three options are 
selected, all 3 suffixes will appear after the keyword ANALOG. 

Bass Diffusion  
The Bass model is most often used to forecast first time purchases of new-to-world products. 

The model tries to capture the adoption rates of two types of users—innovators and imitators. 
Innovators are early adopters of new products and are driven by their desire to try new technology. 
Imitators are more wary of new technology—they tend to adopt only after receiving feedback from 
others. 

The Bass model uses two coefficients to quantify the adoption rates. The Coefficient of Innovation, 
referred to in the literature as “p”, controls the adoption rate for the innovators. The Coefficient of 
Imitation, referred to in the literature as “q” controls the adoption rate for the imitators. 

If you have 5 or more historic data points, these coefficients can be fit to the data. To build a Bass model 
with fewer than 5 data points you must set the values for these coefficients along with the total number 
of potential adopters. Typically, “p” is between 0 and 0.1, while “q” is between 0.3 and 0.5. 

Clicking the Bass Diffusion icon or selecting Forecasting>New Products>Bass Diffusion on the Navigator 
context menu invokes the Bass Diffusion Model Settings dialog box shown below. 

 
If you have five or more data points, the Generate coefficients automatically option allows you to 
instruct Forecast Pro to automatically fit the model parameters to the data. If you do not select 
Generate coefficients automatically, you’ll need to supply the model coefficients and potential market 
size. 

The modifiers associated with the Bass diffusion model are: 

\BASS. Use the Bass diffusion model with automatically generated coefficients and potential market 
size. 

\BASS(p,q,m). Use the Bass diffusion model with user defined parameters p, q and m. 
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Custom Component Model 
Click the Custom Component icon to invoke the Component Model Settings dialog box. See Custom 
Component Model for a detailed description of the dialog box. 

The following modifier is associated with the custom component model. 

\COMP=name. Use a custom component model with the specifications defined in name.  

Low Volume Models 

 

Intermittent Data 
Click the Croston icon or the Forecasting tab or select Forecasting>Low Volume>Croston on the 
Navigator context menu to use Croston’s intermittent demand model. 

The following modifier is associated with the Croston’s intermittent demand model: 

\INTER. Use the Croston’s intermittent demand model. The Croston’s model is designed for data sets 
where the demand for any given period is often zero and the exact timing of the next order is not 
known. 

Discrete Data 
Click the Discrete icon or the Forecasting tab or select Forecasting>Low Volume>Discrete on the 
Navigator context menu to use simple exponential smoothing model and base confidence limits on one 
of the discrete distributions (Poisson or negative binomial).  

The following modifier specifies a discrete model: 

\DISCRETE. Use a simple exponential smoothing model and base confidence limits on one of the 
discrete distributions (Poisson or negative binomial). This option is used to obtain better estimates of 
the confidence limits for low volume integer series (typically with many zeros). 

NA-CL Exponential Smoothing 
Click the NA-CL icon to use a Non-trended Additive Seasonality Constant Level exponential smoothing 
model. This model was designed for data with a selling season. 

\NA-CL is the modifier for NA-CL exponential smoothing. 
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Other Forecasting Options 

 

Box-Jenkins (ARIMA) 
Clicking the Box-Jenkins icon in the Other group instructs Forecast Pro to automatically select a Box-
Jenkins (ARIMA) based on out-of-sample fit combined with some Artificial Intelligence expert system 
rules. 

\BJ is the modifier for automatic Box-Jenkins model. 

Selecting Custom from the drop-down on the Box-Jenkins icon on the Forecasting tab or selecting 
Forecasting>Box-Jenkins on the Navigator’s context menu will open the dialog box shown below. 

 
The Model Type section of the dialog box allows you to specify Automatic (i.e. Forecast Pro will 
automatically determine the ARIMA model orders) or Custom (i.e. you will explicitly select the model 
orders to use). In addition, there are options to include a constant term in the model and to apply a 
power transformation. 

When you click the OK button, Forecast Pro will apply the appropriate modifier on the Navigator and 
build the specified model.  

The custom Box-Jenkins modifiers are: 

\ARIMA(p,d,q). Use a non seasonal Box-Jenkins model with model orders p, d and q. 

\ARIMA(p,d,q)*(P,D,Q). Use a seasonal Box-Jenkins model with model orders p, d, q, P, D and Q. 

\CONST. Include a constant intercept in the Box-Jenkins model. 

Same as Last Year 
Click the Same as Last Year icon on the Forecasting tab to set each forecasted value to equal the value 
for the same period last year (either history or forecast as the case may be). 
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Selecting Plus Percent or Plus increment from the drop-down on the Same as Last Year icon will open 
the dialog box shown below. 

 
Same as last year (selected by default when opened from drop-down) sets each forecasted value to 
equal the value for the same period last year (either history or forecast as the case may be). The Percent 
option (selected by default when Plus percent is selected from the drop-down) sets each forecasted 
value to equal the value for the same period last year plus the specified percentage. The Increment 
option (selected by default when Plus increment is selected from the drop-down) sets each forecasted 
value to equal the value for the same period last year plus the specified increment. 

Selecting Plus delta percent from the drop-down on the Same as Last Year icon will set each forecasted 
value to equal the value for the same period last year adjusted by the percentage change between the 
value for the same period last year and the same period two years ago. That is, the model assumes that 
sales will grow at the same percentage rate as last year. 

Selecting Plus delta increment from the drop-down on the Same as Last Year icon will set each 
forecasted value to equal the value for the same period last year adjusted by the unit change between 
the value for the same period last year and the same period two years ago. That is, the model assumes 
that sales will grow by the same number of units as last year. 

The modifiers associated with Same as Last Year models are: 

\SALY. Set each forecasted value to equal the value for the same period last year (either history or 
forecast as the case may be). 

\SALYP=n. Set each forecasted value to equal the value for the same period last year plus the specified 
percentage (n). 

\SALYI=n. Set each forecasted value to equal the value for the same period last year plus the specified 
increment (n). 

\SALYDP. Set each forecasted value to equal the value for the same period last year adjusted by the 
percentage change between the value for the same period last year and the same period two years ago. 
That is, the model assumes that sales will grow at the same percentage rate as last year. 

\SALYDI. Set each forecasted value to equal the value for the same period last year adjusted by the unit 
change between the value for the same period last year and the same period two years ago. That is, the 
model assumes that sales will grow by the same number of units as last year. 
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Discontinue 
Click on the Discontinue icon in the Other group on the Forecasting tab to discontinue the item selected 
on the Navigator. When an item is discontinued, Forecast Pro no longer generates a forecast for that 
item. This means that you cannot override the forecast in the override grid, and the item will not be 
included in the Numeric Output, by default (though this can be changed in the Numeric Output Settings 
or in the Numeric Output context menu). 

Select Discontinue after on the Discontinue icon drop-down to open a dialog box where you can specify 
the date after which the selected item should be discontinued. 

Select Set to zero on the Discontinue icon drop-down to set an item’s forecast to zero for the entire 
forecast horizon. When you set the forecast to zero, Forecast Pro is generating a forecast. This means 
that you can still override the forecast in the override grid and the item will be included in the Numeric 
Output. 

Select Set to zero after on the Discontinue icon drop-down to open a dialog box where you can specify 
the date after which the forecast for the selected item should be set to zero. 

Select Set Forecast History to Zero on the Discontinue icon drop-down to force the Forecast History to 
equal zero. The actual history for the item will essentially be ignored for the purposes of generating the 
forecast. 

The discontinue modifiers are: 

\DISCONT. Treat the specified item as discontinued. Discontinued items are not forecasted but their 
historic demand does go into group-level aggregates. 

\DISCONTAFT(Year, Period). Treat the specified item as discontinued after the specified date. 

\FIXED=0. Set the item’s forecast for the entire forecast horizon. 

\ZEROAFT(Year, Period). Set the item’s forecast to zero after the specified date. 

\SET_FH_TO_ZERO. The Forecast History will be zero so the actual history will be essentially ignored. 

Best-fit Line 
Select Best-fit Line icon on the More icon drop-down on the Forecasting tab or select Forecasting>Curve 
Fit>Straight Line on the Navigator’s context menu to fit a straight line to the data. 

\CFIT=LINE is the modifier to fit a straight line to the data set. 

Moving Average 
Select Moving Average on the More icon drop-down to open the dialog box shown below. 
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Specify the number of terms used or check Automatic to have Forecast Pro automatically select the 
number of terms. Click OK or Apply to apply the moving average model. 

The modifiers associated with moving averages are: 

\SMA=n. Use an n-term simple moving average. 

\SMA. Use a simple moving average where Forecast Pro automatically selects the number of terms to 
use.  

Curve Fitting 
Forecast Pro offers the following curve fitting approaches: Best-fit line, Quadratic, Exponential and 
Growth. Each of these methods can be selected from the Curve fitting drop-down on the More icon 
drop-down or from Forecasting>Curve Fit on the Navigator’s context menu. 

Select Auto from the Curve fitting drop-down on the More icon drop-down or select Forecasting>Curve 
Fit>Auto on the Navigator’s context menu to use the curve fitting routine that best fits the historic data.  

The modifiers for moving average models are: 

\CFIT. Use the curve fitting routine that best fits the historic data. 

\CFIT=LINE. Fit a best-fit straight line to the data set. 

\CFIT=QUAD. Fit a quadratic curve to the data set. 

\CFIT=EXPO. Fit an exponential curve to the data set. 

\CFIT=GROW. Fit a growth curve (S-curve) to the data set. 

Weight (Weighting Transformations) 
A weighting transformation is commonly used to de-seasonalize your demand using externally supplied 
seasonal weights, or to normalize the data for trading day effects (e.g., 4-4-5 calendars, number of 
working days per month, etc.). 

To use a weighting transformation, you must create a helper variable containing the weights. Helper 
variables are not forecasted, and their values are not included in group totals. Helper variables are used 
in conjunction with event models, by analogy models and weighting transformations. 
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To apply a weight transformation, select Weights on the More icon drop-down on the Forecasting tab or 
select Forecasting>Weights>Select on the Navigator’s context menu to open the dialog box shown 
below. 

 
Select the helper variable with the weights you want to apply and click OK to apply the forecast 
modifier.  

The following modifier is used to specify the weighting transformation: 

\WGT=_X. Use a weighting transformation. _X is the name of the helper variable time series containing 
the weights. 

The procedure divides each value of the specified time series by the corresponding value (weight) in _X. 
It then forecasts the de-weighted variable and multiplies the forecasts by their corresponding weights. 
The weighting variable _X must span the entire history and forecast period for each variable to be 
forecasted. 

Fixed Value 
Fixed forecast value sets the forecast to the specified value. 

Select Fixed Value on the More icon drop-down on the Forecasting tab to open the Very Simple Models 
dialog box with Set forecasts to selected. 
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Enter the desired forecast value, specify a date, and click OK or Apply to apply the model. By default, the 
date spinner is set to the first period of the forecast horizon. 

The modifiers associated with fixed value forecasts are: 

\FIXED=n. Set each forecasted value to n. This modifier is used if the “after” date on the spinner is the 
first forecast period. 

\FIXEDAFT=(Year, Period, n). Set each forecasted value which falls after the year and period specified to 
n. 

Custom Modifiers 
Select Custom on the More icon drop-down on the Forecasting tab or select Custom Modifier on the 
Navigator’s context menu to enter modifiers explicitly. 

 
All modifiers may be entered using the Custom Modifier dialog box. There are also some modifiers that 
must be entered using the Custom Modifier box, including: 

\LOWER=l. Set the lower confidence limit equal to the value l. l must be between 0.1 and 50.0 inclusive. 

\UPPER=u. Set the upper confidence limit equal to the value u. u must be between 50.0 and 99.9 
inclusive. 

\CONF(l,u). Set the lower confidence limit equal to the value l and the upper confidence limit equal to u. 
l must be between 0.1 and 50.0 inclusive and u must be between 50.0 and 99.9 inclusive. 

\LEADTIME=n. Set the lead time for the safety stock to n. The specified lead time appears highlighted in 
the Safety Stock section of the Forecast Report and determines the values written to the Numeric 
Output file. Fractional entries (e.g., 1.5) are permitted. 

\TIMEFENCE=n. Set the length of the time fence for the specified item to n. Be aware that if you use the 
\TIMEFENCE modifier to create a time fence shorter than the global time fence, it will shorten the time 
fence for all associated parent groups of the item. 

\POW=key. Use a Box-Cox power transformation. Key may equal LOG, SQRT, INVERSE or any decimal 
number from -1.0 to 1.0. If you enter \POW=AUTO, Forecast Pro will test your data and implement an 
appropriate Box-Cox transformation (or none at all). Consult the Forecast Pro Statistical Reference 
Manual for a discussion of the Box-Cox power transformations. 
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Group Level (Reconciliation Modifiers)  

 
If no group-level reconciliation modifiers have been specified, a bottom-up approach will be used to 
reconcile the forecasts. The procedure operates as follows. 

First, Forecast Pro prepares forecasts for all groups and items. 

Then, Forecast Pro recomputes the group-level forecasts by aggregating the constituent forecast 
(bottom up). The original group level forecasts are replaced, but their confidence limits are retained and 
proportionately adjusted. 

Three group-level modifiers can be used to specify alternative reconciliation approaches or leverage 
group data structure. These modifiers can only be used on group-level data. 

Top-down 
To apply top-down reconciliation, click the Top Down icon in the Group Level group on the Forecasting 
tab or select Forecasting>Group Level>Top-down from the Navigator’s context menu.  

This procedure begins by preparing forecasts for all groups and items. Then it proportionally adjusts the 
nested lower level item and group forecasts to sum to the selected group’s forecast. Please consult 
Reconciling the Hierarchy for more details. 

Top-down reconciliation uses the following modifier: 

\TOPDOWN. Directs Forecast Pro to perform top-down reconciliation for all members of the indicated 
group. 

Custom Allocation 
To apply custom allocation, click the Custom Allocation icon in the Group Level group on the 
Forecasting tab or select Forecasting > Group Level > Custom Allocation from the Navigator’s context 
menu.  

Note that Custom Allocation is only available when you have defined the proportions in a file, table or 
query and read it into Forecast Pro using the Definitions row in the Data Manager, and it is only available 
for the group(s) one hierarchy level above the level at which the proportions are defined. Consult 
Definitions: Custom Allocations in Setting up Your Optional Data for details. 

The procedure begins by creating forecasts for the specified group and then using the user-defined 
proportional factors to allocate the group forecast down one level. Any additional lower levels are 
adjusted via a top-down procedure unless they too are using Custom Allocation. Please see Custom 
Allocation for more details. 

Custom Allocation uses the following modifier: 

\CALL. Directs Forecast Pro to use user-defined proportionalities to allocate the group-level forecast 
down to the next level. 
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Indexes 
Click the Indexes icon in the Group Level group on the Forecasting tab or select Indexes from the 
Navigator’s context menu to use a group level seasonal index for all items within the group. Please see 
Indexes in Working with Hierarchies for more details. 

Indexes uses the following modifier: 

\INDEXES. Directs Forecast Pro to calculate the seasonal indexes at the indicated group level and use 
them to de-seasonalize the histories for the nested items and groups. The de-seasonalized series are 
then forecasted and as a final step re-seasonalized. This approach works well when the items share the 
same seasonality. It allows one to deal with items whose histories are too short to extract seasonality 
directly. You cannot use \INDEXES if the group level includes zeros or negative numbers. You cannot 
nest \INDEXES groups within each other. Model parameters are re-estimated for each item of the 
\INDEXES group. 

 

Data Tools 

Diagnostics 
Click the Diagnostics icon in the Data Tools group on the Forecasting tab or select Diagnostics from the 
drop-down on the Graph icon on the Home tab or Reports tab to open the Diagnostics View. 

!

 
Consult The Diagnostics View for details on available functionality. 
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Create Helper 
Helper variables are required for event modeling, forecast by analogy and the weighting 
transformations. Helper variables may also be used in Custom Component, Dynamic Regression, and 
Machine Learning models.  

Event schedules are created interactively using the Event Manager, or you can create helper variables 
containing the event schedules in Excel or in a database and import them into your project using the 
Data Manager. Event Schedules are not created with the Create Helper icon. 

Forecast by analogy requires a helper variable containing the analogy series. Using a weighting 
transformation requires a helper variable containing the weights. Depending on your needs, you can 
either create forecast by analogy and weighting transformation helper variables using the Create Helper 
icon or you can create them in Excel or in a database and import them into your project using the Data 
Manager (see Helper Files in the Setting Up Your Optional Data section of this Command Reference 
chapter). 

To create a helper variable within Forecast Pro, use the Navigator to select the item which you want to 
base the helper variable upon, and then click on the Create Helper icon in the Data Tools group on the 
Forecasting tab or select Helper variable>Create on the Navigator’s context menu to open the Create 
Helper Variable dialog box.  

 
To create the helper variable, select the desired contents, adjust the date range (if necessary) and click 
OK. Forecast Pro will then create the helper variable and save it in your project.  

By default, the helper variable will be named “_selection” where selection is the name of your current 
Navigator selection. You may rename the helper variable via the Name field prior to clicking OK. 

The Seasonal component option is designed for use with the custom component model. The custom 
component model allows you to import seasonal indexes from a helper file. The Seasonal component 
option on the Create Helper Variable dialog box estimates a set of seasonal indexes which can then be 
imported into a custom component model. For example, say you want to build a custom component 
model for a given SKU that uses the seasonal indexes calculated from the SKU’s corresponding category-
level group. You would select the category-level group, create the helper variable and then import the 
indexes from the helper when you build a custom component model for the SKU. See the section on 
Custom Component Models for more details. 
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If you wish to delete a helper variable select the helper variable on the Navigator, then right click to 
invoke the Navigator’s context menu and then select Helper variable>Delete. Please note that once you 
delete a helper variable, it cannot be restored. 

Outliers  
Click on the Outliers icon in the Data Tools group on the Forecasting tab to open the Outliers Options 
dialog box. This is identical to the Outliers tab in the Options. 

When you generate forecasts, Forecast Pro uses the current settings in the Outliers tab on the Options 
dialog box to determine the default behavior for detection and correction of outliers. There are three 
choices: 

None. Do not detect or correct for outliers. 

Detection only. Detect and report outliers but do not correct for them (i.e., base the forecasts on the 
uncorrected values). 

Detection and correction. Detect and correct outliers (i.e., base the forecasts on the corrected values). 

Please consult The Outliers Tab in Forecast Pro Options for more details on these settings.  

You may override project level-settings for an end-item selected on the Navigator by selecting Off, 
Detect or Correct from the drop-down on the Outliers icon. You can also revert back to the global 
default settings by selecting Default from this drop-down. Forecast Pro only detects outliers for end-
items (i.e., non-group level data), so the selections are not available if a group level is selected on the 
Navigator. 

Outliers are associated with the following modifiers: 

(no modifier). Revert back to the default project-level setting (specified on the Outliers tab on the 
Options dialog box) for the specified item. This option is used to remove any of the outlier modifiers 
(listed below) from the Navigator. 

\OUTLIER=OFF. Do not detect or correct outliers for the specified item. 

\OUTLIER=DETECT. Detect and report outliers for the specified end-item, but do not correct for them 
(i.e., base the forecasts on the uncorrected values). 

\OUTLIER=CORRECT. Detect and correct outliers for the specified end-item (i.e., base the forecasts on 
the corrected values). 

Start Dates 
Click on the Start Dates icon in the Data Tools group on the Forecasting tab or select Forecasting>Set 
Start Dates on the Navigator context menu to open the Set Start Dates dialog. 
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To only use history after a specified date to generate a forecast, select Start history on and use the 
spinner to set a start date.  

To start forecasting an item starting with a specified date, check Start forecasts on and use the spinner 
to set the launch date. 

Start Dates are associated with the following modifiers: 

\START(Year, Period). Only use historic data after (and including) the specified date to estimate the 
specified item’s forecast model.  

\LAUNCH(Year, Period). Start forecasting an item on the specified date. 

  

Remove Modifiers 
Click on the Remove Modifiers icon in the Data Tools group on the Forecasting tab or select Remove 
Modifier(s) on the Navigator context menu to remove all modifiers from the selected item.
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Working with Hierarchies 
This chapter discusses the strategies that Forecast Pro uses to produce consistent forecasts for 
hierarchical data. 

Defining the Hierarchy 
Demand data can almost always be organized into several levels of aggregation. Suppose that the 
lowest-level forecasts you need to generate represent SKUs (Stock Keeping Units). SKU-level forecasts 
are often needed to support production planning and inventory control. The corporation might 
aggregate these SKUs first into products and then into product lines for marketing and sales. These 
might be aggregated further into geographical regions for the benefit of top management. 

For the purposes of this discussion, we will be referring to end-items and groups. End-items are the 
lowest-level data in your hierarchy. In the above example, each SKU would be an end-item. Groups are 
aggregations of end-items. In the above example, products, product lines and geographical territories 
would all be examples of groups. 

Forecast Pro allows you to define product hierarchies and create one set of self-consistent forecasts. It 
allows top-down, bottom-up or user-defined reconciliation, seasonal adjustment based upon aggregate 
data and model selection at the aggregate level. 

It is not necessary that the end-item histories begin and end at the same time. Thus group-level data 
may consist of end-items that have been retired or replaced by new end-items. Obsolete end-items will 
contribute to the group-level history but will not themselves be forecasted. You will notice that the 
starting and ending dates for the overall historic data consist of the starting date for the oldest end-item 
and the ending date for the newest. Forecasts will be prepared for all end-items and groups that are 
“alive” at the end of the data set. Those whose histories terminate before that time are considered 
“dead”—they contribute to the historic aggregates (and therefore influence aggregate forecasts), but 
they are not themselves forecasted. 

How to organize your data into hierarchies was discussed in Setting Up Your Historic Data. 

Reconciling the Hierarchy 
If no group-level reconciliation modifiers have been specified, a bottom-up approach will be used to 
reconcile the forecasts. The procedure operates as follows. 

First Forecast Pro prepares forecasts for all groups and end-items. 

Forecast Pro then recomputes the group-level forecasts by aggregating the constituent forecasts 
(bottom up). The original group-level forecasts are replaced, but the widths of their confidence limits 
are retained and re-centered on the new forecasts. 

There are two alternative reconciliation approaches-- top-down and custom allocation. Both approaches 
are only available for group-level items. 

Top-down Reconciliation 
Top-down reconciliation directs Forecast Pro to perform top-down reconciliation for all members of the 
indicated group. First, Forecast Pro prepares forecasts for all groups and end-items. Then, it 
proportionally adjusts the nested lower-level end-item and group forecasts to sum to the group 
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forecast. If the top-down group is itself nested within larger groups, the forecasts for the larger groups 
are computed by the bottom-up approach.  

You may select top-down reconciliation by selecting on the Navigator the group item at which you want 
to apply top-down and then selecting the Top Down icon in the Group Level group on the Forecasting 
tab. Alternatively, you may right click on the group level item on the Navigator and select Top Down 
from the context menu. In either case, you will see a \TOPDOWN modifier appear on the group level 
item which you selected. 

 
In the example above, \TOPDOWN directs Forecast Pro to compute forecasts and confidence limits for 
the groups Commercial and Retail at the group level. The end-item forecasts and confidence limits are 
multiplicatively adjusted so that the end-item forecasts sum correctly to the group level forecasts. 
Forecasts for the group Brand are obtained by bottom-up aggregation of the groups Retail and 
Commercial. 

Note the assumptions behind this approach. We have assumed that the nested end-items are 
statistically similar, so that we can obtain better forecasts of the groups Retail and Commercial by 
forecasting them as a unit. However, Retail and Commercial show distinctly different patterns. Thus, the 
best forecasts of Brand are obtained by direct aggregation of the two member groups. 

Using Top-down reconciliation for Brand rather than Retail and Commercial would direct Forecast Pro to 
reconcile the entire hierarchy using a top-down approach. Usually, in a hierarchy involving three or 
more levels of aggregation, you will want to place the \TOPDOWN modifiers somewhere near the 
middle. 

Two things happen as we move from item-level data upwards through the hierarchy. First, the effects of 
irregularity decrease through aggregation. Aggregate data series are typically more stable and reliably 
forecastable than disaggregate data. Second, statistical models become more complex and distinct from 
each other.  

Custom Allocation 
Custom allocation uses user-defined proportionalities to allocate the group-level forecast down to the 
next level. You must define the proportions in a file, table, or query and read it into Forecast Pro using 
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the Definitions row in the Data Manager. Consult Definitions: Custom Allocations in Setting Up Your 
Optional Data for details. Note that Custom Allocation can only be applied to the group level directly 
above the level at which you defined the proportions. 

The procedure begins by creating forecasts for the specified group and then using the user-defined 
proportional factors to allocate the group forecast down one level. Any additional lower levels are 
adjusted via a top-down procedure unless they too are using custom allocation. 

To apply custom allocation reconciliation, on the Navigator select a group item one level above the level 
at which the proportions are defined and then select the Custom Allocation icon in the Group Level 
group on the Forecasting tab. Alternatively, you may right click on the group level item on the Navigator 
and select Forecasting > Group Level > Custom Allocation from the context menu. In either case, you will 
see a \CALL modifier appear on the group level item which you selected. 

Indexes 
The third icon that appears in the Group Level group on the Forecasting tab is Indexes. Clicking the 
Indexes icon applies an \INDEXES modifier to the selected group level item on the Navigator. Using 
Indexes directs Forecast Pro to calculate multiplicative seasonal indexes at the selected group level and 
then use those indexes to de-seasonalize the histories for the nested end-items and groups. The de-
seasonalized series are then forecasted and subsequently re-seasonalized.  

The Indexes approach works well when the end-items share the same seasonality. It allows one to deal 
with items whose histories are too short to calculate seasonality. 

Indexes can be used if the selected group level series does not include zeros or negative numbers. You 
cannot nest \INDEXES groups within each other. Model parameters are re-estimated for each end-item 
and nested group of the \INDEXES group. 

Now consider the case where both the \TOPDOWN and \INDEXES keywords are used for Retail and 
Commercial. In this case, Forecast Pro extracts seasonal indexes for these groups at the group level. It 
then de-seasonalizes each end-item’s history using the indexes from the parent group, forecasts the 
resulting nonseasonal data, and then re-seasonalizes the forecasts. The forecasts are then reconciled 
using a top-down procedure as already described. 

A note about negative values 
In a multiple-level problem, it is assumed that the data are basically nonnegative—the aggregate level 
data must be non-negative, but the item level data can include a few negatives. 

Negative sales figures are relatively common since many companies register returns as negative sales. 
Furthermore, returns are often accumulated on the books and taken as occasional “hits” on sales. While 
this may make good accounting sense, it raises forecasting problems and will certainly decrease 
accuracy. Ideally, companies would either distribute returns to the months in which the products were 
shipped or maintain returns as an entirely different historic record. Nevertheless, listing sales as 
negative is common and must be dealt with in some way. 

Beyond an expected decrease in accuracy for forecasts from a product with negative sales, negatives 
pose a technical problem for product hierarchies. Multiplicative seasonal indexes cannot be extracted 
from a nonpositive series, and additive indexes cannot be disaggregated to nested products. Thus, if the 
group level data contain negatives, Forecast Pro will use an additive index model and seasonal 
disaggregation will not be allowed (i.e., the \INDEXES flag will be ignored). In the case of positive group 
level data with negative values in the constituent data, the multiplicative adjustment of negative values 
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may have a different effect than one expects—a seasonal index of 1.5 to a sales figure -100 yields the 
value -150. 

Top-down adjustment is also problematic when negative forecast values are involved. Therefore, 
Forecast Pro clips negative forecasts to zero if you have specified top-down disaggregation, regardless of 
how you have set Allow negative forecasts in the Basics Tab on the Options dialog box. 
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Working with Product Mapping and 
Mapped History  
There may be times when the history read in from the historic data file will not produce an appropriate 
forecast. For example, you may have a seasonal product that does not have enough data history for a 
seasonal forecast. Perhaps you need to forecast a new item that is replacing an existing item, or you are 
launching an existing item in a new location or warehouse. In these cases, you can use mapped history 
to generate a forecast history that Forecast Pro can use to generate a more suitable forecast.  

The forecast history is the history that Forecast Pro uses to generate the forecast. If you have not 
mapped any history, the forecast history is the history Forecast Pro read in from the historic data file. 
With mapped history, you map additional data (the mapped history) to the actual history to create a 
forecast history that is different from the actual history. To clarify, 

Forecast History = Mapped History + Observed History 

If mapped history is not defined, Forecast Pro simply uses the observed history to generate a forecast. 
That is, the forecast history is equal to the observed history. 

Product mapping is a good way to generate forecast history values. When you map a product’s history, 
the Map from item’s forecast history is the mapped history that is used to generate the Map to item’s 
forecast history. You may also define mapped history by reading in values, as described below. 

Product Mapping Modes 
There are two modes for product mapping and mapped history modes: End-item only and All Items. You 
can select your preferred Product Mapping mode on the The Advanced Tab of the Options dialog. 

 In End-items only mode, mapped history can only be assigned at an end item level. The mapped history 
is then used to create a forecast history at the end-item level. End-item forecast histories are aggregated 
to group levels. That is, the group level forecast history will be defined as the sum of forecast histories 
across all items that are included in the group. If you are working in End-items only mode, the Product 
Mapping icon will not be available on the Forecasting tab when a group level item is selected on the 
Navigator. 

In All levels mode, you may assign mapped history to both end-items and groups, but forecast histories 
will not be aggregated to higher level groups or disaggregated to lower levels of the hierarchy. All 
groups and items must be explicitly assigned mapped histories. 

If you plan on doing all product mappings at the lowest level, you should work in End-item only mode. 
Doing so will make sure you automatically aggregate forecast histories to the group level and generate 
group-level forecast histories.  

If you need to create product mappings at a higher level in your hierarchy, you will need to work in All 
levels mode. You should only create a product mapping for a group item if you plan on using a 
reconciliation modifier (\TOPDOWN, \CALL or \INDEXES) for that group. If you do not plan on using a 
reconciliation modifier, the group level forecast history is not used to generate your forecasts, so 



Product Mapping | 156 
 

 

assigning mapped history is not necessary. Please see Group Level (Reconciliation Modifiers) for more 
details.  

Creating Mapped History 
Mapped history can be defined using product mappings with existing items in your project or as time 
series values that are imported from a file. Each of these approaches is described below.  

Product Mapping  
Product Mapping is used to assign the history from one or more items (the Map from items) to another 
(the Map to item). If there is a single Map from item, the Map to item’s forecast history is equal to the 
Map from items’ history plus the Map to item’s history. 

Map to Forecast History = Map from history + Map to history 

In this case, the mapped history is the Map from history. If mapped history exists for any of the Map 
from items, Forecast Pro will map the forecast history for those items instead of the observed history. 

When you create a product mapping, Forecast Pro will use the Map from’s forecast history as it exists at 
that point in time. If the forecast history for the Map from item changes, the forecast history for the 
Map to item will not automatically reflect that change. If you want to update the Map to item’s forecast 
history to reflect that change, you will need to explicitly redefine your product mapping or mapped 
history.  

You may define product mappings interactively or by importing a product mapping file. Interactively 
creating product mappings will help you understand how product mapping works and is convenient if 
you don’t have many items to map. However, using product mapping files and importing them with the 
Data Manager is a more efficient way to assign product mappings and provides an easy way to refresh 
your product mappings with updated histories.  

Interactive Product Mapping 
To define product mappings interactively, click the Product Mapping icon to open the Product Mapping 
dialog box. When you open the Product Mapping dialog box, the primary Graph view will open as well, if 
it is not already open. 
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Map To: 

Item: This non-editable text box shows the item you are assigning mapped history to. The item is 
selected using the Navigator. Please note that you can change the item selected on the Navigator 
without closing the Product Mapping dialog box. 

Mapped history: This non-editable text box shows if mapped history currently exists for the selected 
item. If the Mapped History field states mapped history is “Present”, the forecast history is currently 
different from the observed history. If the Mapped History field states mapped history is “Not Present,” 
the actual history is currently being used as the forecast history. 

Clear Mapped History: This button removes any existing mapped history from the selected item. After 
clearing mapped history, the Mapped History field will show “Not Present”, and Forecast Pro will use the 
observed history for forecasting. 

Map From: 

The Map From section is used to select the items in the project whose forecast history you want to use 
as mapped history for the item selected on the Navigator (shown as the Map to item). You may select 
one or more items in the display. If mapped history does not exist for a Map from item, Forecast Pro will 
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use the actual history. Note that as you select items, the graph updates to include a yellow area to show 
the forecast history that will be used for the Map to item if you commit to the current selection.  

Filter: Use this text box to Filter the display to include only items that contain the entered text. 

Clear: This button clears the Filter. 

Level: Use this drop-down to only display items in the selected hierarchy level. 

Show ancestry: If checked, the display will include attribute values for all attribute levels when displaying 
an item. If unchecked, the display will only include the attribute value for the level at which the item is 
defined. 

Hot List only: If checked, the display will only include items that are present in the Hot List 

Allocation: The Allocation spinner is used to specify what percentage of the Map from items histories 
should be used. For example, if the Allocation is set to 50%  

Forecast History for Map to item = 

0.5 x Forecast History of Map from item + Actual History of Map to item 

Set Forecast History to zero: If checked, Forecast Pro will set the forecast history for the selected Map 
from items to zero. This will essentially ignore the observed history, and the forecast will be set to zero. 
This can also be achieved by discontinuing the item or selecting Set to zero on the Discontinue icon 
drop-down on the Forecasting tab.  

If you are working in End-item only mode, setting an item’s forecast history to zero can be used to avoid 
double counting in group level forecast histories. For example, suppose both the Map from and Map to 
items are members of the same group. When you map the Map from item to the Map to item without 
setting the Map from item’s forecast history to zero, the Map from item’s forecast history will be 
included in the aggregated group level forecast history twice- once when the Map from item’s forecast 
history is included in the aggregation and again when the Map to item’s forecast history is included. 
Using this option will apply a modifier \SET_FH_TO_ZERO to the Map from item, whose forecast history 
will become zero to avoid double counting in this way. 

Options: 

Date Range: If the Full history checkbox is checked, Forecast Pro will map the Map from item’s entire 
history to the Map to item. If the Full history checkbox is unchecked, you may use the date spinners to 
specify beginning and ending dates for the mapped history. 

Clear and Replace and Increment Existing Forecast History: If there is already mapped history for the 
Map to item, you will need to decide how you want to treat the existing mapped history. If you select 
Clear and Replace, Forecast Pro will delete any existing mapped history and replace it with the current 
selection. If you select Increment Existing, Forecast Pro will keep any existing mapped history and 
increment it with the mapped history for the current selection.  
 

To illustrate, suppose you have already mapped item B to item A and neither had existing mapped 
history, so  

Item A’s Forecast History = Item A’s history + Item B’s history 

If you are reading in a new product mapping that maps item X to item A, choosing Increment Existing 
instructs Forecast Pro to keep the mapped history from Item B in Item A’s forecast history, so 
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Item A’s Forecast History =  Item A’s history + Item B’s history+ Item X’s history 

If you select Clear and Replace, Forecast Pro will clear the existing mapping for Item B before applying 
the new one, so 

Item A’s Forecast History = Item A’s history + Item X’s history 

If there is no existing mapped history for the Map to item, both options will produce the same forecast 
history for the Map to item. 

Use TOPDOWN modeling for group forecast:  If checked, Forecast Pro will apply a \TOPDOWN modifier 
to the Map To item. This option is only available in All levels mode and when a group item is selected on 
the Navigator. If you are in All levels mode and assigning mapped history at a group level, it is likely that 
you are doing so because you want to be modeling at that level. The \TOPDPOWN modifier instructs 
Forecast Pro to use the forecast history for the selected group item to generate forecasts and then to 
disaggregate that group level forecast to the sub-groups and end-items that comprise the selected 
group item. Please see Group Level (Reconciliation Modifiers) for more details on Top-down modeling. 

Commit: When you click the Commit button, you will see the graph and override views update to display 
Forecast History. You will also see that the Navigator icon for the selected item is updated to . This 
icon indicates that there is mapped history for the item, so the forecast history is now different from the 
observed history. If you open the Item Report view, you will see that the Mapped History entry is “Yes.”  

You will also see that you have one or more new entries in the Mapping Report. The Mapping Report 
keeps track of all existing mapped histories in your project. A description of the Mapping Report is 
below.  

Product Mapping Files 
All the functionality available in the Product Mapping dialog is also available in product mapping files. 
Setting Up Your Optional Data: Product Mapping Files provides details on how to set up a product 
mapping file.  

You may export a product mapping file that includes all or selected product mappings in your project. 
When you define a product mapping, the data is not automatically updated each month with new data 
assigned to the Map from item. The mapped history is essentially a snapshot of the data currently 
available in the project. If you have created product mappings interactively and will need to refresh 
them with new data in the next forecast period, you can export the product mapping file and then 
import that file using the Data Manager in the next forecasting period. Exporting a product mapping file 
is also a good way to understand the required file formats.  

You can export a product mapping file by clicking the Product Mapping File icon on the Export tab. 

Mapped History Files 
At times, you may find that the item that you want to Map from is not in your historic data. For 
example, you may want to map from a discontinued item that has been removed from your historic data 
file. If so, you may use a mapped history file to import the values that you want to map to an item in 
your project.  

To read in mapped history as time series values, you must import a mapped history file. The forecast 
history for the Map to item will be the mapped values assigned to that item in the mapped history file 
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plus the Map to item’s history in the historic data file. The required formats are described in Setting Up 
Your Optional Data: Mapped History Files. 

You may also export a mapped history file for selected items.by clicking the Mapped History File icon on 
the Export tab. 

Importing Mapped History Files 
Product mapping files and mapped history files are both read in from the Mapping History row in the 
Data Manager. See Using the Data Manager for details. 
 
When reading mapping files, Forecast Pro may need direction about how to reconcile existing mapped 
histories with the new ones you are importing. If there is existing mapped history in your project, you 
will be prompted with a dialog asking if you want to retain or delete existing mapped histories. 

 

 
 
Deleting mapped histories will clear existing mapped histories for all items before reading in the 
mapped history and/or product mapping files.  
 
If you retain existing mapped histories, Forecast Pro will need further direction about how to handle 
conflicts and you will see an additional prompt. 
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Suppose you have already mapped item B to item A, so  

Item A’s Forecast History  = Item A’s history + Item B’s Forecast History 

If you are reading in a new product mapping that maps item X to item A, choosing Increment instructs 
Forecast Pro to keep existing mapped history in Item A’s forecast history, so 

Item A’s Forecast History  =   

Item A’s history + Item B’s Forecast History +Item X’s Forecast History 
 
If you select Replace, Forecast Pro will clear the existing mapped history from Item B before applying the 
new one, so 

Item A’s Forecast History  = Item A’s history +Item X’s history 
 
Note that your selection will apply to all items in your mapping files. 
 
Once you select the Refresh button on the Mapping Histories row of the Data Manager and respond to 
the prompts, you will be able to see the resulting forecast histories in the Mapping Report, the Item 
Report, the Graph and the Override view. You will also see that items with mapped histories now have 
the   icon on the Navigator. 
 

Setting Launch Dates 
Product mapping is often used to generate forecasts for products that have not yet launched. In this 
case, you may use product mapping to generate forecasts for your new product prior to launch and start 
forecasting at the launch period. To specify a launch date, click the Start Dates icon in the Data Tools 
group on the Forecasting tab. See Start Dates for more details. 

You may also want to stop forecasting an item that will be discontinued when the new product 
launches. To do this, you may select Discontinue after or Set forecast to zero after on the Discontinue 
icon drop-down menu in the Other group on the Forecasting tab. If you choose Discontinue after, the 
item will no longer be forecasted after the specified date. This means that you will be unable to make 
overrides after that date. If you choose Set forecast to zero after, the item will still be forecasted, but 
that forecast will be zero for all periods after the specified date. In this case, you can make overrides for 
all forecast periods. 

If the transition between the old and new products is more gradual, you may use Weighting 
Transformations to gradually phase out and phase in the old and new product. To do so, you would 
want to provide weights for the forecast periods that are impacted by the transition. For example, if the 
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transition is to occur over three periods with the old product sales in period 1 expected to be down 50%, 
sales in period 2 expected to be down by 75% and then a full transition expected in period 3, you would 
provide weights of 0.5 and 0.25 for periods 1 and 2, respectively, and then discontinue the old product 
starting in period 3. Similarly, you could ramp up the new product by launching in period 1 and then 
using weights of 0.5 and 0.75 in periods 1 and 2. See Weight (Weighting Transformations) for more 
details.  

The Mapping Report 
The Mapping Report includes a record of how, when and by whom every mapped history in your project 
was created. To open the Mapping Report, click the Mapping Report icon on the Reports tab. 

 
By default, the Mapping Report includes the columns shown above.  

In the example shown, the first four columns show the attributes for the Map to items. The number of 
columns will depend on the number of attributes you have in your hierarchy.  

The column labeled Map from shows the Map from item if the mapped history was created with product 
mapping or the name of the mapped history file if the mapped history was created by importing a 
mapped history file. If the forecast history has been set to zero, the field will read “Forecast History set 
to zero”. 

The remaining two columns show the user who created the mapped history and when the mapped 
history was created. 

To customize the display, open the Settings dialog from the hamburger menu or the context menu. 
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The Settings dialog lists all the optional columns you may include in the Mapping Report. User Name and 
Last Updated are included by default. The remaining optional columns are: 

Description: Displays the Description included for the Map to item from the historic data file. 

Pareto: Includes four additional columns: Pareto, % of Total, Ranking and Cumulative %. Consult The 
Pareto Tab for more information. 

Date Range: Includes the Start Date, End Date and Periods for the mapped history defined in the Map 
from column. 

Volume: Displays the total unit volume for the mapped history across all mapped periods. 

% Allocation: Displays the percentage of the Map From item’s history used to create the mapped 
history. If a percent allocation was not defined, the value in this column will be blank. 
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Collaboration 
Corporate forecasting often requires collaboration among colleagues. Perhaps your manager wishes to 
review your forecasts and make a few changes. Perhaps you want to run your forecasts past the sales 
force who may know about pending orders. Perhaps your business has distinctly different markets that 
require specific individuals to work on specific markets. Whatever the reason, it is often useful to be 
able to work with others to establish the final forecasts. 

There are three basic strategies for working with others to establish the final forecasts—(1) sharing a 
single stand-alone project, (2) using Forecast Pro’s Excel Collaboration facility to incorporate forecast 
adjustments made in Excel and (3) consolidating multiple projects into a “super project” using the Super 
Project Manager. There are pros and cons to each approach. 

Sharing a stand-alone project is a straightforward way to work with one or two other individuals to 
establish the final forecasts. Using this approach, the forecaster begins by creating forecasts for all items 
that need to be forecasted, enters any desired overrides and saves a forecast project—often to a 
network drive. The project can then be opened by anyone using Forecast Pro (Forecaster or Collaborator 
licenses) to review, make changes, etc. If there is a third individual who needs to review the project, that 
person would do so after the second individual has updated the project. Only one person at a time can 
access a  project, so the changes must be performed sequentially. 

Forecast Pro’s Excel Collaboration functionality allows you to create Forecast Pro Collaboration 
Spreadsheets which enable members of your team to view and modify your Forecast Pro forecasts in 
Excel. Any forecast overrides and comments created in Excel can then be imported back into your 
Forecast Pro project. This process allows multiple individuals to make changes simultaneously, allows 
you to define which items each person has access to and allows the individuals to work in Excel rather 
than Forecast Pro. The pre-formatted collaboration spreadsheets support numeric and graphical display 
of the history, forecasts and overrides, and include automated item-lookup capability. The Excel 
Collaboration Manager in Forecast Pro allows you to easily manage the collaborative forecasting process 
by providing the import/export capabilities and maintaining a record of all collaboration spreadsheets 
associated with your Forecast Pro project including their current status. 

Please note that the Forecast Pro Add-In is required for editing Collaboration Sheets. The Forecast Pro 
Add-In is included in all licensed product installs, meaning anyone with a Forecast Pro license can edit 
the Forecast Pro Collaboration Spreadsheets. 

Finally, the super project approach allows you to break large forecasting jobs into smaller Forecast Pro 
component projects that can be worked on separately within Forecast Pro and then consolidated into a 
“super project.” This process allows multiple individuals to make changes simultaneously to the 
separate component projects, allows you to define what items each person has access to and allows the 
individuals to work in Forecast Pro. To implement this approach you first create, forecast and save 
separate component projects and then use the Super Project Manager to combine the component 
projects into a super project that allows you to view and manipulate the consolidated forecast. A Super 
Project can only be created by someone with a Forecaster license, but it can be used by anyone using 
Forecast Pro (Forecaster or Collaborator licenses).  
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A forecasting process that shares a stand-alone project or uses the Excel Collaboration functionality is 
much simpler to implement and maintain than one that uses a super project. The primary difference 
between using a super project and using Excel collaboration is that when using the super project 
approach the collaborating individuals are working in Forecast Pro and when using the Excel 
collaboration approach, they are working in Excel.  

For more information, please consult the Collaborating with Colleagues lesson in Forecast Pro TRAC 
Tutorials. 

Excel Collaboration 

Creating Forecast Pro Collaboration 
Worksheets  
Clicking the Excel Collaboration icon on the Home tab opens the Excel Collaboration Manager. The Excel 
Collaboration Manager will open to the Export tab. 

 
All collaboration sheets associated with the project will be listed in the Select file(s) to update display. 
When you first start a project, this list will be blank, and you will probably want to create new sheets. To 
create and add a file to the list, click the Create New button to open the Create dialog box. 

 

 

https://www.forecastpro.com/Resource-Center/v7-Tutorials/?page=collaborating-with-colleagues.html
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Create a new file: 

Template drop-down: The first step is to select a Template. There are two available templates for 
creating Forecast Pro collaboration sheets- In Place and By Selection. The In Place template exports the 
forecasts for all exported items to a single sheet for editing. The By Selection template displays only one 
item at a time and includes a selection drop-downs for choosing the item. An example for each template 
is shown in the In Place Collaboration Sheets and By Selection Collaboration Sheets sections later in this 
chapter.  

Export to: This text field specifies where you want to save your collaboration sheet. By default, 
collaboration sheets are saved in “C:\Users\Public\Documents\Forecast Pro\Forecast Pro TRAC v7\Excel 
Collaboration”. 

Define Data 

Hierarchy Level: Forecast Pro allows you to make overrides at any level of the hierarchy, but all items 
exported to a given file must be at the same level of the hierarchy. By default, Forecast Pro selects the 
lowest hierarchy level in the Hierarchy drop-down. The collaboration sheet is associated with the 
hierarchy order as defined in the project when the file is created. The hierarchy in the drop-down will 
reflect the current project hierarchy as well. 

Override Row: The Override row drop-down lists all available override rows as well as a row that may 
not be shown in the override grid, Excel Collaboration. When working with override rows, the override 
value in the row closest to the final forecast row has the highest precedence over other rows which are 
closer to the top of the override grid. If there are multiple overrides for the same item and forecast 
period, the override row that is lowest in the grid is used in the final forecast. The Excel Collaboration 
row takes precedence over all other override rowsand will be created when the Forecast Pro 
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collaboration sheet is imported. If a sales representative uses the Excel Collaboration row, they are 
guaranteed that the final forecast will integrate their overrides. Excel Collaboration is the default 
selection.  

Date Range: The Date Range spinners are used to tell Forecast Pro how many historical and forecast 
periods you want included in the Collaboration Worksheet. Historical sales are helpful when 
determining if a forecast makes sense. If the left spinner shows “-12”, the collaboration worksheet will 
contain 12 periods of history. The corresponding date is shown directly above the spinner.  

External rows:  You are also able to export external data rows and calculated rows that you have defined 
in your project. Select which external rows you want to include in your Excel Collaboration sheet from 
the External rows drop-down. 

Select Items 

There are five options for defining the items you want to include in you Excel Collaboration file: 

All: Exports all items to the collaboration worksheet. 

Filtered – single file: If this option is selected, you must also specify a Filter in the drop-down to the 
right of Filtered – single file and then select one or more filter values in the Value(s) drop-down. The 
items with filter values corresponding to your selected value(s) will be exported to a single 
collaboration worksheet. The Filters drop-down is populated with all filters that you have read in 
using the Data Manager. You need to have read in at least one filter file to use this option. Please 
consult Custom Filter Fields in Setting Up Your Optional Data.  

Filtered – multiple file:  If this option is selected, you must also specify a Filter in the drop-down to 
the right of Filtered – multiple file and then select one or more filter values in the Value(s) drop-
down. The Select All button will select all values. The items with filter values corresponding to your 
selected value(s) will be exported to multiple collaboration worksheets. A separate collaboration 
worksheet will be created for each selected value using a default naming convention. The Filters 
drop-down is populated with all filters that you have read in using the Data Manager. You need to 
have read in at least one filters file to use this option. Please consult Custom Filter Fields in Setting 
Up Your Optional Data. 

Current hot list: Export items on the current hot list. This option is only available if you have a hot list 
currently defined. 

Saved hot list: When working with hot lists, you can save a hot list using the Hot list icon in the 
Other Group on the Export tab or by selecting Save Hot list on the Hot List context menu. These files 
will contain a list of the items on the hot list. You can select a saved hot list by clicking the browse 
button and selecting the file. 

Create: The Create button is used to generate the collaboration sheet(s) as specified. The collaboration 
sheet(s) will be created for the current hierarchy order and units. If you have reordered the hierarchy or 
changed the units after reading in a conversions file, the collaboration sheet(s) will be saved using the 
current project state, as shown in the details section. If you are using Filtered – multiple files, Forecast 
Pro will automatically save the files to the folder location defined in the Export to text area and display 
the exported worksheets in the Select file(s) to update display. In all other cases, you will be prompted 
to save the file. After you confirm the file save, the new sheet will be listed in the Select file(s) to update 
display. 

Details: 
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Total Items: This is a non-editable text field that displays the total number of items you have selected to 
export. If there are 0 items selected to export, the Create button will be greyed out. 

Units:  Forecast Pro will create the Excel Collaboration sheet in the units currently being used in the 
project. This is a non-editable text field that displays the units which the Excel Collaboration sheet uses. 

Hierarchy: Forecast Pro will create the Excel Collaboration sheet in the hierarchy order currently being 
used in the project. This is a non-editable text field that displays the hierarchy order which the Excel 
Collaboration sheet uses. 

Once you are done, click the Exit button to return to the Excel Collaboration Manager. 

Updating Collaboration Sheets  
Forecast Pro Collaboration is designed to work within an on-going forecasting process. Instead of 
creating new Collaboration Worksheets each forecast cycle, forecast project owner(s) may want to 
simply update the Forecast Pro Collaboration Worksheets from last month with the updated history and 
forecasts. 

When you update a collaboration sheet, Forecast Pro will use the settings used to originally create the 
collaboration sheet to update the sheet with the history and forecast values currently listed in the 
project. If you are exporting 12 months history and 12 months of forecasts, Forecast Pro will do so 
relative to the updated forecast origin (last period in the historic data). If the filter values or saved hot 
list have been updated, Forecast Pro will export items from the updated filter or hot list files. If the 
collaboration sheet was created in alternative units and/or hierarchy, the collaboration sheet will be 
updated using the units and/or hierarchy associated with the file. Note, if you have inserted additional 
worksheets into the collaboration sheet, those worksheets will be kept in the updated file. 

To update an Excel Collaboration sheet, click the Excel Collaboration icon on the Home tab to open the 
Excel Collaboration Manager. The Excel Collaboration Manager will open to the Export tab. 
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Select files(s) to update: 

Select files(s) to update: The Select files(s) to update display lists all collaboration worksheets associated 
with the current project. You may right click on any of the files and open the context menu to export the 
file, remove the file association, open in Excel or open the folder where the file is saved. 

Update: To update and export one or more of the existing file(s), select the files you want to update and 
then click the Update button.  

Select All: The Select All button selects all files on the list. This provides an easy way to update all 
associated files at once. 

Importing Forecast Pro Collaboration 
Worksheets 
To import an Excel Collaboration sheet, click the Excel Collaboration icon on the Home tab to open the 
Excel Collaboration Manager and then select the Import tab. 
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Select files(s) to import:  The Select files(s) to import display lists all collaboration worksheets associated 
with the current project. It displays the same files as the display on the Export tab. You may right click on 
any of the files and open the context menu to import the file, remove the file association, open in Excel 
or open the folder where the file is saved. 

Import: To import one or more of the existing file(s), select the files you want to import and then click 
the Import button. If a collaboration sheet was created using a unit measure and/or a hierarchy that is 
different from the current project’s units and/or hierarchy, Forecast Pro will change the current 
project’s units or re-order the hierarchy to match the collaboration file’s units and hierarchy before 
importing. 

Select All: The Select All button selects all files on the list. This provides an easy way to import all 
associated files at once. 

Import Other: You may sometimes want to import valid collaboration sheets that are not associated 
with the current project. To add a file to the Select file(s) to import display, click the Import Other 
button and select the file. Any collaboration sheets you add to your project must have the same 
hierarchy structure as your project. There may be items in the collaboration sheet that are not in your 
project, but overrides for those items will be ignored. 

At times, you may try to read in overrides that conflict with existing in-place overrides. In this case, you 
will be presented with the following dialog box. 
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The first option (checked by default) gives precedence to the collaboration sheet being imported, while 
the second option gives precedence to the existing project overrides. It will often be helpful to 
understand what overrides have been removed or which overrides have not been imported from the 
collaboration sheet. To save a report in Excel, check the Save conflicts report to Excel option. You will be 
prompted to save and open the report to review. Note that the report is saved in the format used for 
importing Overrides and can be read in through the Data Manager if the conflicting overrides currently 
in the project are resolved. 

Editing Collaboration Sheets in Excel 
The Forecast Pro Excel Add-in will not be accessible in Excel until you start Forecast Pro. Please start 
Forecast Pro to automatically activate the add-in. If you start the program with Excel open, you will need 
to close and re-open Excel for the add-in to be activated. If the add-in is not running, you will see 
instructions in the collaboration sheet for how to proceed. Please note that the Forecast Pro Add-In will 
not run if you do not have a licensed Forecaster or Collaborator edition of Forecast Pro installed. 

If the add-in is properly installed and running, the collaboration sheet is populated with your data when 
you open it in Excel. The two built-in templates, In Place and By Selection, are described below.  

In Place Collaboration Sheets  
The In place template will render a collaboration worksheet like the one shown below 
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The In Place collaboration worksheet includes all items selected for export in the Excel Collaboration 
dialog box. The columns on the left show the hierarchy attribute values for each item. You may use the 
Excel filters to display subsets of the hierarchy. The gray columns show the exported history. In this 
example, three months of history were exported by setting the left date spinner to -3. Finally, the 
columns to the right of the history columns show the forecast values. In this case, the right date spinner 
in the Excel Collaboration dialog box was set to 12, specifying that 12 forecast periods should be 
exported.  

The order of the attributes reflects the hierarchy associated with the collaboration file. The unit 
measure associated with the collaboration sheet is displayed in cell A1. Changes to the collaboration 
sheet shown above should use the “Default” units. These are both defined in Forecast Pro before the 
creation of the collaboration file. 

Please note that the attributes and historic data cells are not editable. Only the forecast values may be 
updated. You may also use the empty cells to the right of forecast values as well as the rows below the 
exported item rows. 

The graph displays the history and forecasts for the item associated with the selected row. Text to the 
right of the graph will display overrides and comments that existed in the project at the time of export 
for the selected cell. 

To edit a forecast value, simply enter the override value in the selected cell. When you change a value, 
the cell will turn orange to indicate that a change has been made. 

Collaboration sheets include a custom Forecast Pro ribbon tab. This tab includes the following 
functionality: 

Edit Forecasts: The functionality in this group is used to efficiently make changes over multiple cells. To 
start, select all the forecast cells that you want to edit. You may select cells across different forecast 
periods and items. If you want to adjust the selected cells by a certain percentage, enter the percentage 
in the Percent edit box and click the Percent button. If you want to adjust each selected point by a 
certain increment, enter the increment in the Increment edit box and click the Increment button. If you 
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want to change the sum of the selected points to a defined value, enter the value in the Value edit box 
and click the Value button.  

Comments: 

Insert/Edit Comment: Overrides should always be accompanied by a comment documenting why the 
override was made. To enter override comments that will be imported into a Forecast Pro project, select 
the cells to which the comment should apply and then click the Insert/Edit Comment button to open 
the following dialog box. 

 
The textbox shows the existing comment, if any. Enter or update the comment in the text field and click 
OK. Once a comment has been written, you will see a red triangle in the upper right-hand corner of each 
selected cell. If you hover over a commented cell, you will see the comment. 

Delete Comment: Click this button to remove the comment(s) from the selected cell(s). 

Restore: 

Restore Forecast: Click this button to restore the exported forecast value in the selected cell(s). 

View: 

Description: Check Description if you want to include the item description. 

Filters: Check Filters if you want to include filter columns in the display. 

Sort: Click this icon open the Sort dialog, where you can use Excel’s built in sort functionality to sort all 
exported items and columns. 

About Forecast Pro: Click this button to open a dialog box that displays information about the Forecast 
Pro Add-In you are running. 

The Forecast Pro Add-In also edits the cell context menu to disable certain functionality that is not 
available in the collaboration sheet (e.g. inserting rows or columns) and to include Add-In functionality. 
The cell context menu is opened by right clicking on a cell. You can add, edit and delete comments from 
the context menu as well. 

When you are done editing, simply save the Forecast Pro collaboration sheet. When the collaboration 
sheet is read into the Forecast Pro project, all overrides and comments will be imported into the project. 

By Selection Collaboration Sheets  
If you use a By Selection template, the collaboration sheet will look similar to the override grid view in 
Forecast Pro.  
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On the left hand side, there will be a drop-down for each attribute in your hierarchy. The attributes are 
ordered using the project hierarchy that was defined when the collaboration sheet was created. The 
drop-downs are used to select the item to display in the graph and grid. The currently selected item is 
displayed on the graph. Above the override grid, the collaboration sheet includes the unit measure that 
is associated with the collaboration sheet. All changes should be made in this unit measure. 

The override grid shows the Baseline Forecast, all override rows (with Forecast Pro comments now 
shown as comments) and the final forecast at the time of export. Below the exported forecast is an 
orange row for entering overrides. The orange overrides row is the only editable row in the grid. The 
row label includes the name of the override row that will be used when the collaboration sheet is read 
into the Forecast Pro project (“Excel Collaboration” in the example above). Below the overrides row, the 
Updated Forecast row shows the forecast with the overrides you have entered. 

To enter overrides, simply enter the override value into a cell in the orange override row. You may add, 
edit or delete a comment for the override using the cell context menu (right click on a cell to view the 
cell context menu) or the buttons on the custom Forecast Pro tab, as described above in the In Place 
Collaboration Sheets sub-section. You may also view the About Forecast Pro dialog box by clicking the 
About Forecast Pro button on the Forecast Pro tab. 

Working with Super Projects 
A super project approach allows you to break large forecasting jobs into smaller pieces that can be 
worked on separately and then consolidated. To implement this approach you first create, forecast and 
save separate component projects and then use the Super Project Manager to combine the component 
projects into a new super project allowing you to view and manipulate the consolidated forecast. 

Suppose a company sells their products in three countries—the United States, Canada and Mexico. They 
employ three different demand planners, each of whom is responsible for forecasting a specific country. 
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After the demand planners have completed their forecasts, they meet with management to review the 
forecasts and make any required adjustments. 

Accomplishing this using a single stand-alone project would require a sequential review process. For 
example, assume the demand planner for the United States goes first. He or she would create a forecast 
project which includes all three countries and then review and make adjustments to the United States 
data and save the project. Next, the planner for Canada would open the project, review and adjust the 
Canadian data and save the revised project. Next, the planner for Mexico would open the project, 
review and adjust the Mexican data and save the revised project. At this point, the demand planners’ 
forecasts are complete, and the project is ready for the management review meeting. 

Clearly, there are some downsides to the above procedure. One is that the demand planners cannot 
work on their country-level forecasts simultaneously—they have to wait until it is their turn to do so. 
Another problem is that even though they are working on a single country, the project contains data and 
forecasts for all three countries, which makes it harder for planners to make changes and more prone to 
error. 

The advantage of a forecasting process that uses a sequential review of a single stand-alone project is 
that is much simpler to implement and maintain than one that uses a super project. If it is not essential 
that your total hierarchy be broken out into smaller pieces, then sequential review of stand-alone 
projects is the preferred approach. 

Using the super project approach with our example, we would create a separate forecasting project for 
each country and then consolidate them into a new super project which includes all three countries. The 
advantage is that the three demand planners can work on their forecasts simultaneously using a project 
that only contains their country. When all three are done, the Super Project Manager is used to create a 
super project containing the consolidated forecast. This would require maintaining a total of four 
projects in this example. 

Creating a super project 
The steps to create a super project are: 

1. Create the data files for the component projects. 

The super project’s historic data definition will include all of the component projects’ data 
files. Therefore, you need to construct the data files for the component projects so that 
when they are combined, they create the consolidated hierarchy correctly.  

2. Select the number of override rows required and other settings. 

To import the component projects’ overrides into the super project the number of override 
rows needs to be consistent across the component projects. To ensure a consistency 
between the statistical forecasts in the component projects and the super project, you will 
want to decide on all options relating to the forecasts (e.g., forecast horizon, confidence 
limits settings, outlier correction settings, etc.) up front and keep them consistent across the 
component projects. 

3. Create the component projects 

4. Use the Super Project Manager to create the super project 
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Prior to creating your first super project the Collaborating With Colleagues lesson in Forecast Pro TRAC 
Tutorials. This lesson walks you through the process of using the Super Project Manager to create a 
super project. 

Updating a super project 
How you update your component projects and super project will depend on the details of your 
forecasting process. 

Many users do not modify the forecasts in the super project, but rather just use the super project as a 
way of viewing the consolidated forecast and saving output files. If this is the case, you may want to 
simply update the component projects and create a new super project every time new data becomes 
available. 

If you are entering modifications (e.g., overrides and modifiers) in the super project then then the 
updating process may be a bit more involved. If necessary, you can import overrides and modifiers from 
the super project into the component projects using the Data Manager. Once the component projects 
are updated the Super Project Manager allows you to either delete the super project’s overrides and/or 
modifiers prior to importing from the component projects or leave them intact. 

As you can see, setting up and maintaining super projects is reasonably complex. Keep in mind that 
Business Forecast Systems and Forecast Pro distributors also offer consulting services to help you 
establish your forecasting process. 
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Understanding How Forecast 
Overrides are Allocated 
The override facility in Forecast Pro allows you to adjust your forecasts. Changes made at any level of 
the forecasting hierarchy will automatically reconcile all levels. This chapter was written to clarify exactly 
how the reconciliation is performed and document cases where adjustments cannot be fully 
implemented due to conflicting overrides or program settings. 

The examples in this chapter assume that you are making adjustments to the statistical forecasts, 
however, if you have defined alternative baseline forecasts or generated an inherited forecast row, the 
overrides will be made to these forecasts use the same logic. 

Adjustments Made to a Single Level 
In this section we will describe how Forecast Pro reconciles the forecast hierarchy when overrides are 
made to a single level of the hierarchy. 

Important: If you restrict your overrides to a single level of the hierarchy, the reconciliation process is 
simple and intuitive. We strongly urge you to limit your overrides to a single level if at all possible. 

Figure 1 below depicts a simple forecast hierarchy prior to any overrides being entered. Notice that at 
this point the Statistical forecasts equal the committed Forecasts. 

 
Total 
S = 5 
F = 5 

    
    

GroupA 
S = 2 
F = 2 

GroupB 
S = 3 
F = 3 

        
        

ItemA1 
S = 1 
F = 1 

ItemA2 
S = 1 
F = 1 

ItemB1 
S = 1 
F = 1 

ItemB2 
S = 2 
F = 2 

Figure 1. 

Let’s now modify the above hierarchy by overriding the forecast for ItemA1 to equal 75. This results in 
the hierarchy shown in Figure 2 below. 

 
Total 
S = 5 

F = 79 
    
    

GroupA 
S = 2 

F = 76 

GroupB 
S = 3 
F = 3 

        
        

ItemA1 
S = 1 

O = 75 
F = 75 

ItemA2 
S = 1 
F = 1 

ItemB1 
S = 1 
F = 1 

ItemB2 
S = 2 
F = 2 
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Figure 2. 

Notice that at this point the committed Forecasts for GroupA and Total do not equal the Statistical 
forecasts. 
If we had started with the hierarchy depicted in Figure 1 and adjusted the GroupB forecast to 75 (rather 
than ItemA1) we would generate Figure 3. 
 

Total 
S = 5 

F = 77 
    
    

GroupA 
S = 2 
F = 2 

GroupB 
S = 3 

O = 75 
F = 75 

        
        

ItemA1 
S = 1 
F = 1 

ItemA2 
S = 1 
F = 1 

ItemB1 
S = 1 

F = 25 

ItemB2 
S = 2 

F = 50 

Figure 3. 

Notice that the committed Forecasts for ItemB1, ItemB2 and Total do not equal the Statistical forecasts. 
Notice also that Forecast Pro allocated the GroupB override to ItemB1 and ItemB2 based on the 
proportions established by their Statistical forecasts. 

Adjustments Made to More Than One 
Level 
In this section we will describe how Forecast Pro reconciles the forecast hierarchy when overrides are 
made to more than one level of the hierarchy.  

Important: There are many ways that this type of reconciliation could be performed—each one leading 
to different forecasts. If you plan to make overrides at more than one level of the hierarchy, it is essential 
that you understand how Forecast Pro performs the reconciliation. 

Figure 4 below depicts a forecast hierarchy where ItemA1 has been overridden to equal 75. (It is 
identical to Figure 2.) 

Total 
S = 5 

F = 79 
    
    

GroupA 
S = 2 

F = 76 

GroupB 
S = 3 
F = 3 

        
        

ItemA1 
S = 1 

O = 75 
F = 75 

ItemA2 
S = 1 
F = 1 

ItemB1 
S = 1 
F = 1 

ItemB2 
S = 2 
F = 2 

Figure 4. 
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Let’s now modify the above hierarchy by overriding the forecast for Total to equal 475. This results in 
the hierarchy shown in Figure 5 below. 

 
Total 
S=5 

O = 475 
F = 475  

Locked=75 
Unlocked=400 

    
    

GroupA 
S=2 

Unlocked S=1 
Unlocked Allocation from Total=100 

Locked=75 
F = 175 

Unlocked=100 

GroupB 
S=3 

Unlocked S=3 
Unlocked Allocation from Total=300 

Locked=0 
F = 300 

Unlocked=300 
        
        

ItemA1 
S=1 

O = 75 
F = 75 

ItemA2 
S=1 

Unlocked S=1 
F = 100 

ItemB1 
S=1 

Unlocked S=1 
F = 100 

ItemB2 
S=2 

Unlocked S=2 
F = 200 

Figure 5. 

Making adjustments at more than one level introduces the concept of locked and unlocked volume and 
forecasts. Proportional allocations of unlocked volume are made using unlocked forecasts. 

Notice that: 

1.) When we adjusted Total to 475, 75 units were locked due to the override on ItemA1 and 400 units 
were unlocked and needed to be allocated downward. 

2.) Forecast Pro used the Unlocked statistical forecasts for GroupA and GroupB to determine the 
allocation proportions for the 400 unlocked units from Total.  

3.) Forecast Pro did not alter the committed Forecast value for ItemA1 because it had been explicitly 
overridden (i.e., it was locked). Therefore, the 100 units of unlocked volume from GroupA was allocated 
exclusively to ItemA2 (the only unlocked item in GroupA). 

4) Forecast Pro used the Unlocked statistical forecasts for ItemB1 and ItemB2 to determine the 
allocation proportions for the 300 unlocked units from GroupB. 

Let’s now modify the above hierarchy by overriding the forecast for Item A2 to equal 75. This results in 
the hierarchy shown in Figure 6 below. 

 
Total 
S=5 

O = 475 
F = 475  

Locked=150 
Unlocked=325 

    
    

GroupA 
S=2 

Unlocked S=0 
Unlocked Allocation from Total=0 

Locked=150 
F = 150 

GroupB 
S=3 

Unlocked S=3 
Unlocked Allocation from Total=325 

Locked=0 
F = 325 
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Unlocked=0 Unlocked=325 
        
        

ItemA1 
S=1 

O = 75 
F = 75 

ItemA2 
S=1 

O = 75 
F = 75 

ItemB1 
S=1 

Unlocked S=1 
F = 108.33 

ItemB2 
S=2 

Unlocked S=2 
F = 216.67 

Figure 6. 

Notice that GroupA has no unlocked volume so the 325 units of unlocked volume from Total are 
allocated exclusively to GroupB. 

Examples Where Overrides Cannot be 
Allocated 
If you make forecast overrides to more than one level of the hierarchy, you can generate situations 
where the overrides cannot be allocated. In these instances, you will get an error message and the 
override may not applied. 

Figure 7 below depicts a forecast hierarchy where ItemA1 and ItemA2 have both been overridden to 
equal 75 and ItemB1 has been overridden to equal 150. 

 
Total 
S = 5 

F = 302 
    
    

GroupA 
S = 2 

F = 150 

GroupB 
S = 3 

F = 152 
        
        

ItemA1 
S = 1 

O = 75 
F = 75 

ItemA2 
S = 1 

O = 75 
F = 75 

ItemB1 
S = 1 

O = 150 
F = 150 

ItemB2 
S = 2 
F = 2 

Figure 7. 

Suppose you try to override the forecast for GroupA to equal 100. The override could not be applied 
because both ItemA1 and ItemA2 are “locked”. Forecast Pro will display an error message and reject the 
override. 

 Let’s now modify the above hierarchy by overriding the forecast for GroupB to equal 50. This results in 
the hierarchy shown in Figure 8 below. 

 
Total 
S = 5 

F = 200 
    
    

GroupA 
S = 2 

F = 150 

GroupB 
S = 3 

O = 50 
F = 50 

        
        

ItemA1 
S = 1 

O = 75 

ItemA2 
S = 1 

O = 75 

ItemB1 
S = 1 

O = 150 

ItemB2 
S = 2 

F = -100 



Summation | 181 
 

 

F = 75 F = 75 F = 150 

Figure 8. 

Notice that the override for GroupB resulted in a negative committed Forecast for ItemB2. This result 
assumes that the “Allow Negative Forecasts” setting in the Forecast Pro Options dialog box was 
selected. If this setting was not selected, the override could not be made and Forecast Pro would display 
an error message and reject the override. 

When reading in overrides from a simple flat file, the overrides in the file will be applied, and any 
existing conflicting overrides in the project will be removed. If you are using an Excel Collaboration file, 
you will be presented with a choice of which override(s) to maintain and which to remove. 

Summation 
It should be quite apparent that if you make adjustments to more than one level of a hierarchy the 
reconciliation becomes quite complex. Although several of the examples presented seemed involved, 
these examples had simple hierarchies consisting of only 3 levels and 4 end-items. Most users of 
Forecast Pro are working with thousands of items and much more complex hierarchies. 

Virtually all of the complexity disappears if you restrict yourself to making forecast adjustments to a 
single level of the hierarchy. Although we’ve stated this previously, it’s worth repeating:  

If you restrict your overrides to a single level of the hierarchy, the reconciliation process is simple and 
intuitive. We strongly urge you to limit your overrides to a single level if at all possible 
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Appendices 
Using a Time Fence 
Time fences are used to “lock” forecast values for a specific number of periods so that they can’t be 
changed via user overrides or by the generation of new statistical forecasts as new data become 
available. Time fences can be useful in environments where after forecasts have been finalized and 
acted upon (i.e., production has been scheduled, orders have been placed, etc.), there is a window of 
time where making changes is not feasible. 

 
The screen above shows the Forecast overrides view for an item with a 3-month time fence. Notice the 
second to last row of the grid is labeled Time Fence. The values displayed in this row are the 
unchangeable fenced values and the same values appear in the final Forecast row. 

Notice that the statistical forecast for August (303,178) does not equal the time fence value (294,192). 
This is because August’s time fenced value was established when last month’s forecasts were generated.  

Let’s now consider what happens next month. We update our data with August’s sales, open last 
month’s project and generate new statistical forecasts. Our 3-month time fence will now cover August 
through October. August’s and September’s time fenced values will be retained from last month’s time 
fenced values and November’s time fenced value will equal last month’s final forecast for November. 

Time Fence Settings and Options 
Turning on the time fence: When you first create a project, the time fence will be turned off. You turn 
the time fence on by selecting clicking the Enable icon in the Time Fence group on the Operations tab. 
Once you turn a project’s time fence on, it cannot be turned off! 
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Setting the length of the time fence: The default length for the time fence can be specified on the 
Overrides tab of the Options dialog box (shown above).  

You can override the global setting on an item-by-item basis using the custom modifier \TIMEFENCE=n 
where n is the number of periods you wish to use. Be aware that if you use the \TIMEFENCE modifier to 
create a time fence shorter than the global time fence, it will shorten the time fence for all associated 
parent groups of the item. 

Freezing the next period: Clicking the Freeze Next Period icon in the Time Fence Group on the 
Operations tab will increase the length of all time fences in the current project by one period for the 
current forecast origin. If you subsequently update your data with the next observation and create a 
new forecast (thus changing the forecast origin) the time fence lengths will revert back to their pre-
Freeze-Next-Period settings. This option provides a way of insuring that after the forecasts are finalized 
someone doesn’t inadvertently alter the frozen periods’ forecasts prior to the data being updated, new 
forecasts being generated and the frozen periods’ forecast becoming an officially fenced value. 

Command Line Operation 
You can run Forecast Pro noninteractively via Command Line. When the command line to execute the 
program includes a project filename (*.FPZip or .FPProj if the project is unzipped) and the /b parameter, 
Forecast Pro will read in the data, create the forecasts, save all output files and then exit. This feature is 
particularly useful when you are integrating forecasting with other software systems and need a “hands-
off” approach. 

To run Forecast Pro automatically, follow these two steps. 

1.) Prepare a valid project and place it in your project directory. The easiest way to prepare this file is to 
use Forecast Pro interactively to define all desired project settings, historic data, output formats and 
(optionally) forecast modifiers and overrides, and then save the project using use File>Save. 

Alternatively, you can generate the file externally, but this will require understanding the project file and 
the (optional) corresponding db file formats. 

2.) Run the command “ForecastProTRAC [Project Name] /b [options…]”. For example,  
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“C:\Program Files\ Forecast Pro \Forecast Pro v6\ForecastProTRAC.exe” Test.FPZip /b 

runs the program located in “C:\Program Files\Forecast Pro\Forecast Pro v6” for a project named 
Test.FPZip. The project should be in your current project directory. The “/b” parameter is used to 
indicate that you wish to run in command-line (batch) mode. 

You can issue the command in any number of ways, including: 

Select Run from the Start menu and issue the command from there. 

Set up a shortcut to issue the command. 

Issue the command from within a different application using a system call. 

The Command Line tab of the Settings>Options dialog box allows you to specify several key command 
line forecasting options and the output files to save in command-line mode. This tab’s functionality was 
fully described in the The Command Tab section of the Forecast Pro Options chapter. 
 

Command line options include the following: 

 

/BOOKMARK=[Bookmark name] causes the program to load the indicated bookmark prior to generating 
any output files. If the bookmark is not found, then the program continues using its current settings. 
Until build 5.1.1.4, this required a case-specific match; now it is case-independent. If the program 
cannot find the bookmark, processing continues normally to completion.  

 

/LAYOUT=[Layout name] has the same functionality as /BOOKMARK. 

 

/NOSAVE causes the program to forego re-saving the project at the end of command-line execution, 
regardless of the actual project setting (Settings > Options > Command Line > Project). The latter 
checkbox setting is respected if /NOSAVE is omitted. 

 

/NOFORECAST the program simply loads the project, assuming it’s in a forecast and reconciled state, 
and generates the output. 

 

/TITLE=[file title to use for output files] causes the program to replace the project name, e.g. 
“Project01”, with whatever is specified by the User here to build the output file names. For example 
/TITLE=Bookmark_1 would result in output files named accordingly, e.g., !Bookmark_1 Exceptions 
Report.xlsx. This setting is also applied to the ODBC output table, overriding any previous project setting. 
In the latter case, the User is advised to use a /TITLE value that complies with SQL naming conventions 
(e.g., no spaces). 

 

/PLOG and /ELOG will force the program to generate project and error log files, respectively. This 
overrides the corresponding settings in the INI file and in the project definition. If a file title is specified 
using /TITLE=[…], it will be applied to the log file(s). 
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The following options allow the User to force the program to output the corresponding outputs/reports, 
even if they are unchecked within the project settings. 

 

/OUTPUT – forces export of the Numeric Output regardless of the project setting. 

 

/ITEM – forces export of the Item Report regardless of the project setting. 

 

/EXCEPT – forces export of the Exception Report regardless of the project setting (TRAC-only). 

 

/EXCEPT# – forces export of the indicated Exception Report regardless of the project setting (TRAC-
only), corresponding to the (1) Forecast vs. History, (2) Forecast vs. Archive, (3) Forecast Accuracy, (4) 
Waterfall, (5) Custom and (6) Global FVA . For example, /EXCEPT3 outputs the Forecast Accuracy report.  

 

/OUTLIER – forces export of the Outlier Report regardless of the project setting. 

 

/QUERY – forces export of any previously checked Query Report(s) regardless of the project setting. 

 

/PWD=[project password] allows the command line execution of projects that contain a password (TRAC 
version 5.1.1.9 and later). 

 

/MODE=[XLSX or CSV or XLS] allows specifying a data mode other than XLSX for the Item, Exceptions, 
Outliers, and Overrides reports (TRAC version 5.1.1.11 and later).  

 

Important Notes 

1. If there are spaces in the pathname you must include quotation marks as illustrated in 
the example above. 

2. If you do not want the Forecast Pro menu to appear, run the program minimized.  

Speeding Up the Program 
If decreasing processing time is important for your application, you may wish to investigate some of the 
following options. 

1. Use the 64-bit Version 

Forecast Pro can be installed as either a 32-bit or 64-bit application. If you are currently running the 32-
bit version, migrating to the 64-bit version will speed up various operations such as opening and saving 
projects and will also allow you to work with larger data sets. 
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2. Work Locally 

Working with projects stored on a network drive can be substantially slower than working on a project 
stored locally. Reading input data over the network and saving output files to network drives can also be 
substantially slower than reading and writing from a local drive, as the network is often the performance 
bottleneck. 

If you are currently saving your projects to a network drive, saving them to a local drive will improve 
performance considerably. If you are currently reading your input data from a network drive and/or 
saving output files to a network drive, moving them to a local drive will speed up read/write operations 
considerably. 

3. Use Zipped Projects 

As we mentioned above, in some networked environments, working with projects stored on a network 
drive can be substantially slower than working on a project stored locally. To improve performance in 
these cases, Forecast Pro supports “zipped” projects to reduce the amount of data that needs to be 
passed through the network. When you save a zipped project, Forecast Pro zips the four standard 
project files described in a previous section of this manual into a single file with the extension .FPZip.  

When you open a zipped project, Forecast Pro copies the zipped file from the network drive to a local 
workspace, unzips the project files and opens the project—allowing you to work on your project locally, 
even though it was saved to a network drive. When you resave your zipped project, Forecast Pro will zip 
the updated local project files and save the updated .FPZip file to the network drive. 

To save and open zipped projects, you select FPZip as the file type in the File>Save as and File>Open 
dialog boxes. 

4. Upgrade Your Hardware 

Upgrading your hardware will improve performance dramatically. Forecast Pro will run on any Intel 
processor. Since this product deals with large amounts of floating point data, it makes sense to run it on 
as fast a machine as possible. 

As an illustration, using expert selection and four years of monthly history per item, a Core2/2.2GHz 
machine forecasted 10,000 items in 39 seconds. The same run took 4 minutes on a Pentium III/600MHz 
machine and 24 minutes on a Pentium/90MHz. 

Having enough RAM is also important—we recommend 2 Gigs if you are running a 32-bit operating 
system and as much RAM as your budget can afford if you are running a 64-bit operating system.  

As you use the program, Forecast Pro is storing and retrieving a great deal of information in memory. If 
you do not have an adequate amount of RAM Forecast Pro will resort to using virtual memory (i.e., 
caching to your hard drive). This is substantially slower than using RAM. Increasing the amount of RAM 
in your computer will improve performance of all of your applications. 

Use a Solid State hard drive, ideally with PCIe storage (virtualizing RAM with this type of hard drive is 
significantly faster). This will improve the read/write times which should make program performance for 
certain operations more efficient (e.g. opening and saving projects, as well as reading in/saving data 
files). 

5. Use Manual Override Mode 

If you make overrides to large complex hierarchies, the reconciliation can take a little time. To defer this 
time consuming reconciliation, Forecast Pro supports a manual override mode. When this mode is 
active, the override window will include a Retain button as well as a Commit Button. The Retain button 
is used to accept overrides without reconciling the hierarchy. In this mode you would typically enter and 
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retain all of the overrides you wish to make (i.e., for multiple items) and then click Commit or the 
Recalculate icon on the Home tab to perform the reconciliation. The control to turn on manual override 
mode is found on the Performance tab of the Options dialog box. 

6. Use Manual Forecast Mode 

By default, Forecast Pro will automatically recalculate the forecasts and re-reconcile the relevant nodes 
of the hierarchy every time you apply a forecast modifier. For large hierarchies this can be time 
consuming. Forecast Pro allows you turn on manual recalculation using an option of the Performance 
tab of the Settings>Options menu. If you turn this option off, when you specify a forecast modifier the 
forecasts will not be updated until you click the Recalculate icon on the Home tab. This allows you to 
specify multiple forecast modifiers without having to wait for the program to recalculate the forecasts in 
between each specification. The control to turn on manual forecast mode is found on the Performance 
tab of the Options dialog box. 

7. Reduce the Size of the Forecast Archive 

By default, Forecast Pro will archive all the forecasts you’ve created in the project’s database. Forecast 
Pro allows you to limit the number of periods archived using the Periods to retain in archive spinner on 
the Performance tab of the Options dialog box. Reducing the number of archived forecasts will result in 
a smaller project and better performance for many program operations (e.g., opening and saving 
projects, loading the tracking report, etc.). 

8. Optimize Outlier Detection and Correction for Speed 

The outlier detection and correction algorithm will slow down the processing. If you wish to use outlier 
detection and correction but speed is of concern, one option is to initially run the forecasts in the 
detection only mode to detect the outliers and then turn outlier detection off and use the 
\OUTLIER=CORRECT modifier to perform the corrections on the detected items. 

9. Don’t Use xlsx Files 

If you are using xlsx files you might consider switching to csv or xls files. Xlsx files are slower to read than 
csv and xls files and use over twice as much memory. Also, if you are using large spreadsheet files 
breaking them up into several smaller files or increasing the amount of RAM available will speed up 
processing. 

10. Optimize Model Selection for Speed 

Specifying “Exclude machine learning” on the Performance tab of the Options dialog box will speed up 
forecast generation considerably. This option will remove machine learning models from consideration 
when using expert selection.  

If you are forecasting data where the number of periods per cycle is greater than 13 (e.g., weekly data) 
you might consider turning on the “Exclude seasonal simplification” option in the Performance tab of 
the Options dialog box. If this switch is on (it is on by default), Forecast Pro’s expert selection mode will 
not consider seasonally simplified forms of exponential smoothing models. This will speed up forecast 
generation considerably. 

Specifying the models to use rather than using the expert selection will substantially improve 
performance. This will require some work to determine the best type of model to use for your data. The 
best way to determine the appropriate model for your data set is to experiment using the forecast 
evaluation procedures (see methodology chapter in the Forecast Pro Statistical Reference Manual for 
details). 

11. Use Year over Year view of the history in the Override grid instead of Time Series view 



End-User License Agreement | 188 
 

 

The Time Series view of the history in the Override grid allows you to enter formulas in Calculated Rows 
for historic periods. This may slow down override reconciliation, as the entire override grid must be 
recalculated each time an override is committed. Consider limiting the number and complexity of the 
formulas being used, or consider using Year over Year view of the history when committing overrides. 

End-User License Agreement 
This End-User License Agreement (“EULA”) is a legal agreement between Licensee (either an individual 
or a single entity) and Business Forecast Systems, Inc. (“BFS”) for the BFS software that accompanies this 
EULA.  

1. DEFINITIONS 

A. “BFS” means Business Forecast Systems, Inc., 465 Waverley Oaks Rd. Suite 318, Waltham, MA 02472 
USA, the author and owner of the copyright of this computer program product. 

B. “Computer” means the single computer, workstation, terminal or other digital electronic device on 
which You use this program. 

C. “Software” means the set of computer software programs in this package, regardless of the form in 
which You subsequently use it. 

D. “Licensee” means an individual or single entity exercising rights under and complying with all the 
terms of this EULA. In the remainder of this EULA, the Licensee is referred to as “You.” 

E. “Authorized User” means the Licensee in the case where the Licensee is an individual. In the case 
where the Licensee is an entity, “Authorized User” means (i) an employee of the Licensee, but only while 
such employee is acting within the scope of such employee’s employment by Licensee; and (ii) the 
primary user of the Computer on which the Software is installed. 

If You do not agree with the terms of this EULA, BFS does not grant any license to the Software and You 
should not download, install or use the Software. In such event that You do not agree with the terms of 
this EULA and have already installed or downloaded the Software, You must remove the Software from 
your Computer and return to BFS the complete software package, including disks and printed materials 
and destroy all copies (or, if You downloaded the Software, notify BFS in writing that You have removed 
the Software from your Computer and destroyed all copies). If You do not comply with these return and 
notification requirements within thirty days (30) of your receipt of the Software, You will not be entitled 
to a refund of any license fees You paid. 

2. OWNERSHIP 

BFS retains title, ownership and all rights and interests in and to the Software, documentation and all 
other materials supplied by BFS. BFS does not sell the Software or any copies thereof, but only grants 
limited licenses to use the Software in accordance with the terms of this EULA. 

3. GRANT OF LICENSE 

Upon acceptance of this EULA, BFS grants You a non-transferable, non-exclusive, limited right to use this 
copy of the Software. You may use the Software and the associated documentation only in connection 
with one Computer. You may physically move the Software from one Computer to another, provided 
that the Software is used on only one Computer at a time. You may not move the Software 
electronically from one Computer to another over a network. This license is granted for use by an 
individual Authorized User, and, in no event shall there be more than one Authorized User on the 
Computer where the Software is installed; e.g., there shall be no common sharing of a “Forecast Pro 
computer.” Each Authorized User must have a separate license to use the Software on his or her 
Computer. 
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4. LICENSE RESTRICTIONS 

You acknowledge that the Software and its structure, organization and source code constitute valuable 
trade secrets of BFS. You shall not, nor shall permit, assist or encourage any third party to: 

• copy, modify, adapt, alter, translate, reverse engineer, decompile, disassemble, or 
attempt to derive the source code for the Software. 

• merge the Software with other software and/or create derivative works from the 
Software. 

• sublicense, distribute, publish, sell, lease, rent, loan, or otherwise transfer or allow 
access to the Software to any third party. 

• use the Software in the operation of a service bureau.  

• defeat, disable or circumvent any security measures BFS may use to prevent 
unauthorized use or copying of the Software. 

5. TRANSFER OR REPRODUCTION 

You may not transfer or reproduce the Software with the exception of making a maximum of two (2) 
copies of the Software to be used for backup purposes only. When using a Computer with a hard disk, 
one copy of the Software may be installed on the hard disk provided that the copy is removed if the 
Software is used on another Computer.  

6. LIMITED WARRANTY 

THE SOFTWARE, THE DOCUMENTATION AND ANY OTHER MATERIALS THAT MAY BY BE PROVIDED BY 
BFS ARE PROVIDED "AS IS" WITHOUT ANY WARRANTY OF ANY KIND. BFS HEREBY EXPRESSLY DISCLAIMS 
ALL WARRANTIES WITH REGARD TO THE SOFTWARE, THE DOCUMENTATION AND ANY OTHER 
MATERIALS, WHETHER EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
AND ANY WARRANTIES ARISING OUT OF COURSE OF DEALING OR COURSE OF PERFORMANCE. BFS 
EXPLICITLY DOES NOT WARRANT THAT THE SOFTWARE WILL MEET ALL OF YOUR REQUIREMENTS OR 
THAT THE OPERATION OF THE SOFTWARE WILL BE ERROR-FREE. YOU ACKNOWLEDGE THAT YOU HAVE 
RELIED ON NO WARRANTIES AND NO WARRANTIES ARE MADE HEREIN BY BFS. 

7. LIMITATION OF LIABILITY 

BFS SHALL NOT BE LIABLE FOR ANY LOSS OR DAMAGE THAT MAY BE RELATED TO THE FURNISHING, 
PERFORMANCE, OR USE OF THE SOFTWARE, INCLUDING WITHOUT LIMITATION ANY INDIRECT, SPECIAL, 
INCIDENTAL, ECONOMIC, LOST PROFIT, OR CONSEQUENTIAL LOSS OR DAMAGE OF ANY KIND 
WHATSOEVER EVEN IF BFS HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES. IN NO EVENT 
SHALL BFS’S LIABILITY UNDER THIS EULA EXCEED THE AMOUNT PAID FOR THE SOFTWARE LICENSE, IF 
ANY. 

8. TERM AND TERMINATION 

This EULA is effective until terminated. Your rights under this EULA will terminate automatically without 
notice from BFS if You fail to comply with any provision of this EULA. Upon termination of this EULA, You 
must destroy all copies, full or partial, of the Software. You agree that upon termination of this EULA for 
any reason, BFS may take actions so that Software no longer operates. 

9. GENERAL TERMS AND CONDITIONS 

A. You acknowledge that You have read this EULA understand it and agree to be bound by its terms and 
conditions. This EULA supersedes all prior agreements, oral or written communications, proposals, 
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representations and warranties and prevails over any conflicting or additional terms of any quote, order, 
acknowledgment, or other communication between the parties relating to its subject matter during the 
term of this EULA. No modification of this EULA will be binding, unless made in writing and signed by an 
authorized representative of each party. 

B. In the event that any portion of this EULA is held unenforceable, the unenforceable portion shall be
construed in accordance with applicable law as nearly as possible to reflect the original intentions of the
parties, and the remainder of this EULA shall remain in full force and effect.

C. This EULA will be governed by and construed and enforced according to the laws of the
Commonwealth of Massachusetts, USA excluding its conflict of law provisions.

Suggested Reading 
The Forecast Pro Statistical Reference Manual is a pdf document that is copied to the program directory 
when you install Forecast Pro. It is also accessible via the Forecast Pro help menu and is the primary 
suggested reference for all of the forecasting techniques, statistics and algorithms found in Forecast Pro. 

The Forecast Pro Statistical Reference Manual includes an extensive bibliography. A few recommended 
textbooks include: 

J. S. Armstrong [2001] Principles of Forecasting: A Handbook for Researchers and Practitioners, 
Norwell MA: Kluwer Academic Publishers. 

K. Kahn [2006] New Product Forecasting: An Applied Approach, Armonk NY: M.E. Sharpe.

K. Ord and R. Fildes [2013] Principles of Business Forecasting, Cengage.

S. Makridakis, S. C. Wheelwright and R.J. Hyndman [1998] Forecasting Methods and Applications,
Third Edition, New York: Wiley.

P. Newbold and T. Bos [1990] Introductory Business Forecasting, Cincinnati: South-Western.
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